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About this guide 

This section includes these topics: 

 Documentation overview (page 10) 

 Conventions (page 11) 

 BD FACS Sortware Help system (page 12) 

 Technical assistance (page 14) 

 Limitations (page 15) 
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Documentation overview 

Introduction This guide provides an introduction to the instrument and basic operation 
information for new operators, as well as a reference for continued use by 
experienced operators. 

The guide contains a basic description of the BD Influx™ high-speed cell sorter 
and BD FACS™ Sortware sorter software, QC procedures, configuration, 
operating procedures, maintenance information, and troubleshooting. 

Using the guide A familiarity with basic flow cytometry concepts is assumed throughout this 
manual. You should have a working knowledge of basic Microsoft® Windows® 
operation. If you are not familiar with the Windows operating system, see the 
documentation provided with your computer. 

The information in this guide is organized into the following parts: 

 Part 1: System information. This part includes information about system 
hardware and components, basic system procedures, and system 
maintenance. Some system procedures require the use of BD FACS Sortware 
sorter software. 

 Part 2: Software information. This part includes information about BD FACS 
Sortware sorter software, general procedures for setting up and operating the 
instrument, and procedures for sorting samples. See Part 3: System workflow 
(page 221) for complete daily workflow procedures. 

 Part 3: System workflow. This part includes the essential workflows for the 
setup and operation of the BD Influx system. 

 Part 4: Reference. This part includes information about system options, 
system specifications, cytometer configurations, and troubleshooting. 

The BD Influx Task Navigator provides links to workflow tasks and support 
information to help you quickly find information for common BD Influx tasks. 

Other documentation See the BD Influx Safety and Limitations Guide for descriptions of safety and 
warning labels, general system hazards, specific risks, and laser, electrical, and 
biological hazards. 

More information � Conventions (page 11) 

� BD FACS Sortware Help system (page 12) 

� Technical assistance (page 14) 

� Limitations (page 15) 
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Conventions 

Introduction The following tables list the safety symbols and document and Help content tools 
used throughout this manual. 

Safety symbols These safety symbols are used in this guide to alert you to potential hazards. 

Symbol Meaning 

General warning. Risk of personal injury to operator. 

Dangerous. High voltage. Risk of electrical shock. 

Biohazard 

Laser radiation hazard 

For a complete description of all safety hazards, see the BD Influx Safety and 
Limitations Guide. 

Navigation and reference 
linkage tools Convention Use 

Part Parts identify different types of grouped information. For example, 
Part 1: Instrument information, Part 2: Software information, Part 
3: System workflow, or Part 4: Reference. 

Section menus Each section menu includes links to topics within the section. 

Introduction Provides a basic summary of the topic so that you can quickly 
decide if the topic answers your specific questions. 

More 
information 

Provides links to additional concepts or procedures related to this 
information. 

More information � Documentation overview (page 10) 

� BD FACS Sortware Help system (page 12) 
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BD FACS Sortware Help system 

Introduction BD FACS Sortware sorter software includes a comprehensive Help system that 
includes all content from this user’s guide. Internet access is not required to access 
this content. 

Navigating the Help 
system 

To access the BD FACS Sortware Help system: 

1. In the BD FACS Sortware window, select Help > Contents. 

The Help window opens. 

2. Use the table of contents, interactive links, related topics, or the search tool to 
locate topics of interest. 

– Search.  Type words or phrases into the search field. Search results are 
displayed in a familiar web search format to help you find information 
quickly. 
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– Print.  Use the print tools to print individual topics or to print entire 
sections as formatted PDF files. 

Print and PDF tools 

– Home.  Click the Home icon to return to the home page. 

– Tips.  Click the Help icon to view tips for using Help. 

– More Information. Click links in the More information box to view 
additional related topics. 

More information � Documentation overview (page 10) 

� Conventions (page 11) 

� Technical assistance (page 14) 



 

  
 

 

14 BD Influx User’s Guide 

Technical assistance 

Introduction This topic describes how to get technical assistance. 

Contacting technical 
support 

If you require assistance, contact your local BD Biosciences technical support 
representative or supplier. For current technical support phone and email contact 
information, go to bdbiosciences.com/support/technical. 

When contacting BD Biosciences, have the following information available: 

 Product name, part number, and serial number 

 Any error messages 

 Details of recent system performance 

More information � Documentation overview (page 10) 

� BD FACS Sortware Help system (page 12) 

� Limitations (page 15) 

http://bdbiosciences.com/support/technical
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Limitations 

Intended use This instrument is for Research Use Only (RUO). Not for use in diagnostic or 
therapeutic procedures. 

The BD Influx system is intended for use in laboratory research. Any clinical use 
of the device requires approval of appropriate authorities, such as the FDA. 
Approval for use beyond laboratory research is the responsibility of the study 
sponsor, not BD Biosciences. 

Warranty BD Biosciences is providing software without warranty of any kind on an as-is 
basis. The software and workstations are intended for running the systems 
supplied by BD Biosciences. It is the responsibility of the buyer/user to ensure that 
all added electronic files including software and transport media are virus-free. If 
the workstation is used for Internet access or purposes other than those specified 
by BD Biosciences, it is the buyer/user’s responsibility to install and maintain up-
to-date virus protection software. BD Biosciences does not make any warranty 
with respect to the workstation remaining virus-free after installation. 
BD Biosciences is not liable for any claims related to or resulting from the buyer/ 
user's failure to install and maintain virus protection. 

Safety All devices, such as lasers, used in conjunction with the instrument must be used 
as indicated by the original manufacturer. Follow the precautions described in the 
BD Influx Safety and Limitations Guide included with your instrument. 

More information � Documentation overview (page 10) 

� Technical assistance (page 14) 
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2 
BD Influx task navigator 

This section provides navigation to common BD Influx tasks and includes links to useful information. 
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Common BD Influx tasks 

System startup/setup 

To... Use this information. What you might want to know... 

Start up the BD Influx system System startup (page 223) Power distribution (page 64) 

Load a sample tube Introducing a sample into the 
system (page 237) 

Sample introduction (page 33) 

Perform daily QC Alignment and QC (page 241)  System startup (page 223) 

 Optimizing system settings for 
samples (page 263) 

 Optical detection (page 50) 

Customize the window layout Setting up your window layout 
(page 102) 

BD FACS Sortware overview (page 94) 

Optimize with compensation Creating plots and gates for 
optimization (page 264) 

 Optimizing with compensation 
controls (page 268) 

 Collecting data files for 
compensation (page 272) 

 Performing auto compensation 
(page 275) 

Save and restore system settings  Saving and restoring settings 
(page 112) 

 Saving and deleting settings 
(page 115) 

Creating storage folders (page 117) 

Sort setup 

To... Use this information. What you might want to know... 

Create sort trays Using the Tray Control pane 
(page 210) 

 Importing an existing BD Spigot sort 
device (page 209) 

 Modifying an existing sort device 
(page 214) 

Set the drop delay with Accudrop Determining the drop delay with 
BD FACS Accudrop (page 300) 

 Estimating the drop delay 
(page 295) 

 Determining the drop delay using 
the calibration slides (page 304) 

Create a user-defined sort mode Creating a user-defined sort 
mode (page 207) 

Using the Sort Settings pane (page 204) 
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Data visualization 

To... Use this information. What you might want to know... 

Create worksheets Creating a worksheet layout 
(page 141) 

Worksheet overview (page 138) 

Create and modify plots Creating plots in a worksheet 
(page 162) 

 Modifying dot plot properties 
(page 166) 

 Customizing worksheet properties 
(page 143) 

Create and modify gates and 
populations 

Creating rectangle gates 
(page 187) 

Gating overview (page 178) 

View a sort report Working with sort reports 
(page 312) 

 Creating a worksheet layout 
(page 141) 

 Customizing worksheet properties 
(page 143) 

Cleaning and 
maintenance 

To... Use this information. What you might want to know... 

Change or clean the nozzle tip Cleaning the nozzle tip 
(page 234) 

Removing and replacing the nozzle tip 
(page 81) 

Flush the system Flushing the system (page 233)  Startup workflow (page 224) 

 System shutdown (page 319) 

 Backflushing the sample line for a 
different sample (page 78) 

 Decontaminating the fluidics 
(page 79) 

Shut down the system System shutdown workflow 
(page 320) 

 Decontaminating the fluidics 
(page 79) 

 Replacing the nozzle assembly 
(page 89) 
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To... Use this information. What you might want to know... 

Operate the HEPA enclosure Enclosure operational checklist 
(page 354) 

 About the HEPA-filtered enclosure 
option (page 348) 

 HEPA enclosure safety (page 352) 

 About the HEPA enclosure controls 
(page 355) 

 Setting up the HEPA enclosure 
digital display (page 357) 

Perform regularly scheduled 
maintenance 

 Daily maintenance overview 
(page 206) 

 Weekly maintenance 
overview (page 207) 

 Monthly maintenance 
procedures (page 208) 

 Instrument cleaning and 
maintenance (page 71) 

 Component replacement (page 80) 

Align the system after maintenance or 
service 

Aligning and optimizing the 
optics workflow (page 242) 

NA 



 

Part 1 
Instrument information 

This part includes these sections: 

 Chapter 3: Instrument overview (page 23) 

 Chapter 4: Fluidics (page 31) 

 Chapter 5: Optics (page 47) 

 Chapter 6: Sort components (page 57) 

 Chapter 7: System power (page 63) 

 Chapter 8: Maintenance (page 69) 
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3 
Instrument overview 

This section includes these topics: 

 System description (page 24) 

 System and components (page 27) 

 Functional subsystems (page 29) 

Other related information: 

 About the HEPA-filtered enclosure option (page 348) 
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System description 

Introduction This topic describes how the BD Influx high-speed cell sorter functions. 

The BD Influx high-speed cell sorter is a research instrument that provides high-
speed detection, sorting of particles excited by laser light, and analysis. 

Detection The BD Influx sorter focuses laser light on a fast-moving, thin stream of particles 
(for example, cells, chromosomes, or organisms). Sensitive photomultiplier tubes 
(PMTs) collect the fluorescence and light scatter emitted by the particles. 

Beam stop 

Forward scatter 
detector 

Sorting overview The following steps describe the sorting process. 

Stage Description 

1 Drop drive energy is applied to the stream to break it into highly uniform 
droplets. 

2 Droplets detach from the stream a few millimeters downstream from the 
nozzle. 

3 When a particle is detected and meets the predefined sorting criteria, an 
electrical charge is applied to the stream just as the droplet containing that 
particle breaks off from the stream. 

4 Once broken off from the stream, the droplet—now surrounded by 
air—still retains its charge. The charged droplet passes by two strongly 
charged deflection plates. 
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Stage Description 

5 Electrostatic attraction and repulsion cause each charged droplet to be 
deflected to the left or right, depending on the droplet’s charge polarity. 

6 Uncharged droplets are not affected by the electric field and pass down the 
center to the waste drain. 

7 Charged drops sort into the appropriate tube or well. 

  

  
 

   

Nozzle 

Laser beam 

Deflection plate 

Waste 

Sorted cells 

Analysis Use worksheet tools to create plots, gates, and statistics views that you can use to 
visualize data, define populations, and create reports. 
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More information � System and components (page 27) 

� Functional subsystems (page 29) 
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System and components 

Introduction This topic describes the system and components. 

System components The following illustration and table describe the system components. 

Sheath and waste tanks 

   
 

   

  

  
 

 

   

(Optional) HEPA-filtered 
enclosure 

Auxiliary power switch 

Laser power supplies 

Enclosure HEPA filter 
indicators 

Computer(s) 

Digital scale 

Component Description 

HEPA-filtered enclosure Includes two blowers and HEPA filters to provide a 
controlled environment and control aerosols during 
operation of the cytometer. This is an optional feature. 

Auxiliary power switch Turns on the power for the electronics, oscilloscope, video 
cameras, and monitors. 

Laser power supplies Turn on each laser individually. You might have additional 
power supplies located on the back of the instrument or on 
the table next to the instrument, depending on the number 
and type of lasers on your system. 

Enclosure HEPA filter 
indicators 

Indicate the status of the HEPA filters. 
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Component Description 

Computer(s) Runs BD FACS Sortware sorter software. 

Depending on your configuration, this computer might 
also serve as the cytometer interface, or the system might 
include a second computer to serve as the cytometer 
interface. 

The cytometer interface is a dedicated computer that 
interacts with BD Sortware software and controls the 
cytometer hardware. 

Digital scale Displays the sheath tank weight. 

Sheath and waste tanks Hold up to 7 liters of sheath or waste. 

Instrument components The following illustration and table describe the instrument components. 

Nozzle 

Sort stage 

Sample station 

Sort chamber 

Laser alignment knobs 

Fluidic valve buttons 

 

 
 

 

 
  

  

    

  

  

 

Component Description 

Laser alignment knobs Control the beam alignment of each laser. Use these 
adjustments during signal optimization. 

Nozzle Hydrodynamically focuses the sample and sheath into a 
stream and directs it to the laser interrogation point. You 
can change the size of the nozzle tip depending on particle 
size. 

Sort chamber Contains the sort plate, sort stage, Accudrop laser, and the 
waste drain. 



 

 

 
   

  

  

29 Chapter 3: Instrument overview 

Component Description 

Sort stage A moving mechanical assembly that holds and positions 
different sort devices. Includes inserts for slides, plates, 
multi-tube assemblies, and universal cooling assemblies for 
tubes. 

Sample station Holds and pressurizes the sample tube. Also includes valve 
buttons and a bubble detector. 

Fluidic valve buttons Controls the sample valves to run a stream or remove 
bubbles. 

More information � System description (page 24) 

� Functional subsystems (page 29) 

Functional subsystems 

Introduction This topic describes the primary functional subsystems of the instrument. 

Instrument subsystems The BD Influx system includes the following instrument subsystems: 

 Fluidics (page 31) 

 Optics (page 47) 

 Sort components (page 57) 

 System power (page 63) 

More information � System description (page 24) 

� System and components (page 27) 
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4 
Fluidics 

This section includes these topics: 

 Fluidic components (page 32) 

 Sample introduction (page 33) 

 Pressure regulation and monitoring (page 37) 

 Sheath tank and fluidic components (page 40) 

 Waste fluidic components (page 43) 
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Fluidic components 

Introduction This topic describes the fluidics subsystem. 

Components The fluidic subsystem components are: 

 Purge and sheath tanks 

 Waste, sheath, and sample lines 

 Flush bucket 

 Stream drain and sample backflush drains 

 Waste, sample, and sheath valves 

The following figure shows the fluidics subsystem components. 

More information � System and components (page 27) 

� Functional subsystems (page 29) 

� Sample introduction (page 33) 

� Pressure regulation and monitoring (page 37) 

� Sheath tank and fluidic components (page 40) 

� Waste fluidic components (page 43) 
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Sample introduction 

Introduction This topic describes the fluidic components that introduce the sample into the 
instrument. 

Description Sample introduction generates a stream of sample particles, typically suspended in 
saline, in the center of a larger stream of sheath fluid (saline). 

Sheath flow Sample flow Sheath flow 

Laser beams 

The pressurized stream is forced through a tiny orifice in a nozzle. This produces a 
fine, fast-moving jet of fluid and sample particles. 

Components The main components of sample introduction include: 

 Sample station 

 Sample line 

 Nozzle assembly 

Sample station The sample station is where the sample tube is loaded and the sample is 
pressurized for sample introduction. 

The sample station includes: 

 Sample valve control buttons 

 Sort device ports 

 Sample line 

 Tube holder for loading sample tubes 

 Tube-lock lever 
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OVERRIDE button 

BACKFLUSH button 

SAMPLE button 

Fault LEDs 

Sort device 
ports 

  

  

  
 

  

 

  
   

  

 Sample line 

Tube holder 

Tube-lock 
lever 

Component Description 

OVERRIDE button Opens the pinch valve on the sample line during 
maintenance procedures. 

BACKFLUSH button Runs sheath fluid from the nozzle through the length of the 
sample line. 

SAMPLE button Pressurizes the sample tube and delivers sample to the 
nozzle. 

Fault LEDs LED 1 detects fluid in the air line. LED 2 detects air 
(bubbles) in the sample line. Both LEDs must be green to 
run samples. 

Sort device ports Connect to a universal sample cooling assembly (cooled 
sample assembly that inserts into the sort stage). 

Sample line Introduces the sample to the nozzle assembly. 

Tube holder Holds the tube in place. 

Tube-lock lever Locks the tube in place and ensures that the sample is 
sealed well with the top of the sample port. The tube is 
pressurized to allow the sample to travel to the nozzle. 



35 Chapter 4: Fluidics 

The sort device port connects to a universal sample cooling assembly (cooled 
sample assembly that inserts into the sort stage). 

Tubing connecting the cooled sample plate to the sort device ports. 

Sample line The sample line delivers the sample from the sample station to the nozzle 
assembly. The sample line has an inner diameter of 254 m. Backflush mode helps 
to minimize sample carryover by backflushing the sample line. This line can be 
easily replaced. 

Nozzle assembly 

Sample introduction 

Y connector 

Waste line 

Sample line 

Sheath line 
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Nozzle assembly The sample moves to the nozzle assembly where the sheath and the nozzle create 
hydrodynamic focusing on the sample so that the sample can be interrogated by 
the lasers. The assembly includes a piezoelectric element that converts the stream 
into controlled droplets. 

Nozzle tip 

Nozzle 

  

 

 

More information � Fluidic components (page 32) 

� Pressure regulation and monitoring (page 37) 

� Sheath tank and fluidic components (page 40) 

� Removing the sample line (page 82) 

� Installing a new sample line (page 83) 

� Sorting troubleshooting (page 364) 
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Pressure regulation and monitoring 

Introduction This topic describes the fluidic components that regulate and monitor the fluidics 
pressure. 

The fluidics subsystem applies air pressure to the sample tube and the sheath 
reservoir. It also monitors the sample and sheath pressures. 

Components The main components of pressure regulation are: 

 Air pressure (input) regulator 

 Fluidic valve controls 

 Pressure console 

Air pressure regulator Pressure is applied to the sheath tank and the sample tube to push sheath fluid and 
sample fluid through the nozzle. Sheath, sample, and boost pressure can be 
individually adjusted. An external air compressor is required if you do not have a 
compressed air supply in your laboratory. 

See Aerosol evacuation unit and air compressor options (page 362) for more 
information. 

Air pressure regulator 
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Fluidic valve controls The fluidic valve control buttons (located at the top of the pressure console) 
control the valve mode for the sheath and purge valves. 

 

     
 

  

 

The fluidic valve buttons are located above the sample station and the digital 
readouts. If your instrument has the enhanced forward scatter option installed (as 
shown), the fluidic valve buttons are obscured by the enhanced forward scatter 
collector. 

Component Description 

PULSE button Helps remove bubbles by quickly opening and closing the 
sheath valve.You must press PURGE before you can press 
PULSE. 

PURGE button Runs fluid from the nozzle to waste to flush bubbles from 
the nozzle area. In this mode, the sheath valve is closed and 
the waste valve is open. 

RINSE button Runs fluid through all fluidic lines and out the nozzle. 

RUN button Runs a sample stream through the nozzle. In this mode, the 
sheath valve is open and the waste valve is closed. 
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Pressure console The pressure console includes all sample and sheath pressure adjustments and 
displays. 

BOOST button 

Sheath and 
sample pressure 

displays 

  

     

  
 

  

 
 

 

  

   

 
 

    

 
  

 

Drop camera position 

Boost pressure regulator 

Sheath pressure regulator 

Sample pressure (coarse) regulator 

Sample offset pressure regulator 

AIR switch 

Component Description 

Drop camera position 
display 

Displays the relative position of the drop camera. The drop 
camera is used to estimate the drop delay. The drop camera 
has a micrometer to adjust the vertical position of the drop 
camera in relation to the stream. This value is displayed in 
the drop camera display on the pressure console. 

Boost pressure regulator Adjusts the initial boost pressure (the amount of pressure 
above the sample pressure). 

Sheath pressure regulator Adjusts the sheath pressure. The sheath regulator can 
regulate input pressure from 3–100 PSI. Typical operating 
pressure is <80 PSI. 

Sample pressure regulator Used for coarse adjustment of the sample pressure. The 
sample pressure regulator can regulate input pressure from 
3–100 PSI. Typical operating pressure is <80 PSI. 

Sample offset pressure 
regulator 

Provides fine-scale adjustment of the sample pressure. Used 
in combination with the sample pressure (coarse) 
adjustment. The sample offset regulator adds 0–5 PSI to 
the sample regulator. 

AIR switch (toggle) Located on the side of the pressure console. Used to toggle 
the air pressure on or off. 

BOOST button Located at the bottom of the pressure console. This button 
temporarily boosts sample pressure by the preset or the 
value you set with the Boost pressure regulator. 

Sheath and sample 
pressure displays 

Display the current sheath pressure and the current sample 
pressure. 
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More information � Functional subsystems (page 29) 

� Sheath tank and fluidic components (page 40) 

� Aerosol evacuation unit and air compressor options (page 362) 

Sheath tank and fluidic components 

Introduction This topic describes the sheath tank and the associated fluidic components. 

Description The sheath tank holds the sheath fluid. Pressure is applied to the sheath tank to 
push sheath fluid through the system. 

Components The main components of sheath tank and fluidics are: 

 Sheath tank 

 Digital scale (for sheath fluid level monitoring) 

 Sheath line 

Sheath tank The sheath tank is an autoclavable 7-L tank. 

Sheath tank 

The sheath tank has: 

 A sheath filter to filter the sheath fluid. 

 A sheath line to deliver the sheath to the nozzle. 

 An air line to pressurize the tank. 

 A pressure gauge to confirm the pressure. 
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 A release valve to remove the pressure from the tank. 

Sheath lineSheath filter Air pressure line 

Pressure 
gauge 

Pressure release valve 

Digital scale The digital scale weighs the sheath tank and its fluid. The weight is used to 
determine the level of fluid in the tank. 

Digital scale platform 

Digital scale 
control panel 

The digital scale must be zeroed to calibrate the scale and determine the weight of 
an empty tank each time you refill the sheath tank or whenever you shut down the 
system. 

When you add sheath fluid to the tank, the additional weight is converted to a 
liquid volume value that determines the level of sheath in the tank (1 kg of 
measured weight is equal to 1 L of sheath fluid). 

See Calibrating the digital scale with an empty tank (page 228) for more 
information about zeroing the scale. See Separate wall power source (page 66) for 
more information about power considerations for the digital scale. 
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Sheath line The sheath line connects the output of the sheath filter with the Y-fitting on the 
nozzle stage assembly. 

Waste line 

Nozzle 
assembly 

Sheath line 

The sheath line delivers sheath fluid from the sheath filter, through the pressure 
console sheath pinch valve, to the nozzle. 

More information � System and components (page 27) 

� Fluidic components (page 32) 

� Pressure regulation and monitoring (page 37) 
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Waste fluidic components 

Introduction This topic describes the waste fluidic components. 

Components The main waste fluidic components are: 

 Waste drains and bucket 

 Waste tank 

 Vacuum pump 

Waste drains and bucket The waste drains consist of the stream drain, backflush drain, and the flush 
bucket. 

 Stream drain. Located directly under the stream in the sort chamber. The non-
sorted fluid from the nozzle falls into the stream drain and is vacuumed to the 
waste tank. 

Stream drain 

 Backflush drain. Located below the tube in the sample station. This drain is 
used to draw the backflushed fluid to the waste tank. 

Backflush drain 
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 Flush bucket. Used during a system flush or purge. It is placed directly under 
the nozzle. The fluid is vacuumed to the waste tank. 

Flush bucket 

Waste tank The waste tank is an autoclavable 7-L tank. It has one port for the vacuum line 
and one for the gauge. The gauge is used to monitor the amount of vacuum 
applied to the tank. The waste line carries the waste to the waste tank. The waste 
tank lid must have a complete seal with the tank, or else it will not have the 
vacuum needed to pull the fluids. 

Waste line (red) Waste tank gauge 

      

   
 

 
 

   

  

 

 

 

Caution! The contents of the waste tank and waste tubing could be 
contaminated with biohazardous material. Follow your standard laboratory 
procedures for biological hazards during all cleaning and maintenance 
procedures. Wear protective clothing, eyewear, and gloves. 

Vacuum pump The vacuum pump draws waste from the stream drain, backflush drain, and the 
flush bucket to the waste tank. The vacuum line connects directly to the vacuum 
source fitting on the waste tank. 
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Vacuum pump 

Vacuum line 

Hydrophobic filter 

The vacuum pump runs directly from the wall power source, independent from 
the instrument power circuitry. 

Make sure that you run the system with the hydrophobic filter. Otherwise water 
can get into the vacuum lines and can cause damage to your pump. 

More information � Fluidic components (page 32) 

� Sheath tank and fluidic components (page 40) 
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5 
Optics 

This section includes these topics: 

 Optical illumination (page 48) 

 Optical detection (page 50) 

 Signal processing (page 55) 
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Optical illumination 

Introduction This topic describes the illumination subsystem. 

The illumination subsystem includes all components necessary to apply a focused 
beam of laser light through the sample stream. All laser beams are deflected into 
the sort head and are aligned independently by adjustable mirrors. Each laser 
beam has a final focus lens that is mounted on a dedicated translational stage for 
fine adjustments. 

Functions of the optic The optic system is one of the three main systems on a cytometer. It has two main 
system functions: 

 Illumination of the particles using laser(s), steering optics, beam shaping, and 
a focusing lens. 

 Detection of the signal from the illuminated particle as well as the scatter light 
of the particle. This is covered in the next section. 

Components The main components of the illumination subsystem are: 

 Lasers (up to seven) 

Laser Wavelength (nm) Power (mW) 

UV 355 100 

Violet 405 50 and 150 

Blue-violet 457 300 

Blue 488 200 

Green 532 150 

Yellow-green 561 75 and 150 

Red 640 50 and 150 

 Protective shields and guards 

 Laser shutters and the shutter interlock system 

 Steering optics and micropositioners 

 Beam-shaping prisms and/or mirrors which create round or elliptical beam 
shapes (3:1 ratio with a typical beam height of 15–20 m). 

 Iris diaphragms 

 Focusing lenses mounted on adjusting stages 

Location of lasers The instrument includes air-cooled lasers in two locations: 

 On the optical bench, behind the main sort head 

 Attached directly to the rear of the sort head 
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All laser beams are deflected into the sort head and are aligned independently by 
adjustable mirrors. Each laser beam has a final focus lens that is mounted on a 
dedicated translational stage for fine adjustments. 

Side-mounted lasers 

Side laser paths 

Rear-mounted lasers 

   
  

 More information � Functional subsystems (page 29) 

� Optical detection (page 50) 

� Signal processing (page 55) 
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Optical detection 

Introduction This topic describes the optical detection components. 

The optical detection system separates and quantifies the intensity of light and 
scattered light from the particle stream. 

This detection system includes focusing lenses and iris diaphragms to help center 
the signal down the optical path, filters, and mirrors that route the signal to the 
appropriate detectors. 

About light collection The collection lens collects the emitted light from the particle/laser interrogation. 
This signal then travels down the optical bench to the appropriate detectors. 
Emission light is collected through a 20X, 0.6 NA microscope objective. Light is 
focused on five spatially separated mirror pinholes. Modular detector blocks 
allow for a user-defined detection configuration. 

Detectors There are three detectors in the system: forward scatter, small particle forward 
scatter, and side scatter. 

 Forward scatter (FSC) detector. This detector collects the scattered light from 
the particle/laser interaction. Resolution for the standard forward scatter 
detector is >0.5 m (measured using beads). The collection angle is 2–17°. 

 Small particle forward scatter detector (SPO). This detector measures tiny 
particle applications (for example, marine biology). The scatter is detected by 
a 20X, 0.42 NA microscope objective. Resolution for the SPO is >0.2 µm 
(measured using beads and 0.1-µm filtered sheath fluid). The collection angle 
is 2–30°. See Small particle forward scatter detector option (page 361) for 
more information. 
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 Side scatter (SSC) detector. Side scatter is collected through the 90° collection 
lens and is measured using a PMT. Side scatter resolution is >0.2 m 
(measured using beads and 0.1-m filtered sheath fluid). 

Forward scatter 
capture lens 

Side scatter 
capture lens 

Stream drain 

PMTs 
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Filters In addition to the PMTs, the optical detection modules include the following 
filters. 

Component Description 

Longpass (LP) filters These filters steer light between the detectors within a 
detector array. They reflect shorter wavelengths and 
transmit longer wavelengths. For example, a 505 nm LP 
filter allows wavelengths equal to or greater than 505 nm 
to pass through to the detector. 

Bandpass (BP) filters Allow a designated range of spectral wavelength to pass 
through to the PMTs. A BP filter is located in front of each 
PMT. For example, a 530/40 BP allows wavelengths 
between 510 and 550 nm through to the detector. 

Neutral density (ND) 
filters 

The neutral density filters attenuate (decrease) the amount 
of light that passes through. 

Shortpass (SP) filters These filters reflect longer wavelengths and transmit 
shorter wavelengths. For example, a 550 SP allows only 
wavelengths equal to or less than 550 nm to pass through. 

Rejection (RP) filters These filters are used with a longpass filter to pass most 
frequencies unaltered, but they attenuate a specific range of 
frequencies to very low levels. It is the opposite of a 
bandpass filter. 

For example, if a 532/20 rejection filter is set in front of a 
530/20 BP, and the BP is set in front of a detector, then 
wavelengths between 522–542 nm are not allowed to pass 
through to the 530/20 BP. This is commonly used in 
situations to avoid another laser's signal from getting to 
the detector. 

Par (parallel polarizer) The parallel FSC measures the standard, polarized FSC 
signal. 

Per (perpendicular 
polarizer) 

The perpendicular FSC measures depolarized FSC light. 
This is used for specialized applications like marine 
biology. 
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Objective lens 

Pinhole 
(spatial filter) 

Collimating lens 

Filter 

Photo detector 

The following illustration shows an optical bench layout that includes: 488 nm 
excitation, scatter, and FITC, PE, PI, PE-Cy™5, PerCP, and PE-Cy™5.5 detectors. 

Laser delay The lasers are spatially separated, causing a slight delay between the detection of 
each laser’s signal. The calculated laser delay is a factor used to align all the signals 
so they can be measured and displayed on the same time scale. You typically set 
laser delay when you optimize multiple lasers. You typically set the laser delays 
during daily instrument QC and optimization. 

The following table describes laser delay with three lasers. 

Process Description 

1 A particle intercepts the blue laser first. 

2 A signal is generated. 

3 The same particle passes through the red laser in a given amount of time 
(red laser delay). The time between the blue laser and the red laser is 
measured when the particle hits the beam. 

4 The same particle passes through the violet laser in a given amount of time 
(violet laser delay). The time between the red laser and the violet laser is 
measured when the particle hits the beam. 
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More information � Functional subsystems (page 29) 

� Signal processing (page 55) 

� Setting laser delays (page 257) 

� Optical detector modules (page 333) 

� Small particle forward scatter detector option (page 361) 
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Signal processing 

Introduction This topic describes the signal processing components. 

Signal processing controls, amplifies, and processes PMT signals into data that 
can be: 

 Monitored by the operator 

 Acquired and analyzed by BD FACS Sortware sorter software 

 Used by the sort electronics subsystem 

Components The main signal processing components are: 

 Logarithmic and linear pre-amplifiers (log and lin preamps). Modify signal 
input to produce an output voltage. Linear amplifiers check coefficients of 
variation (CVs) in scatter or fluorescence signals. Log amplifiers detect 
smaller particles in scatter or fluorescence signals. 

 Analog-to-digital converters (ADCs). Perform 16-bit analog-to-digital 
conversion (65,536 channels). ADCs provide raw data to help determine 
compensation. 

 Digital signal processors (DSPs). Perform a 16 x 16 digital compensation 
matrix. Compensated parameters are added as separate parameters. 

 Integrators. Dedicated hardware components that measure the area and the 
width of a voltage pulse for selected parameters. They work in parallel with 
the height and peak measurement. Integrator boards are optional on the BD 
Influx instrument. 

The following illustration shows the signal processing components in the BD 
Influx electronics cabinet. 
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More information � Functional subsystems (page 29) 

� Optical detection (page 50) 

� Sort electronics (page 58) 



 

6 
Sort components 

This section includes these topics: 

 Sort electronics (page 58) 

 Sorted sample collection (page 59) 

 Sort monitoring rack (page 61) 
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Sort electronics 

Introduction This topic describes the sort electronics components. 

The sort electronics subsystem contains the electronics components necessary for 
processing signal data and for sorting particles. 

Components The main components of sort electronics are: 

 Control circuitry. Includes circuit boards, counters, and other components 
that control sorting and deflection. 

 Piezo drive. Powers the piezoelectric element (in the nozzle assembly) that 
converts the stream into controlled droplets. You can adjust the piezo 
amplitude and frequency when you define the droplet breakoff and when you 
configure a sort. 

 Stream deflection. High-voltage deflection plates deflect droplets from the 
main stream and direct droplets to specific tubes or wells in the sort tray. 

High-voltage deflection plates 

 

   

  
 

 
 

More information � Sort components (page 57) 

� Sorted sample collection (page 59) 

� Deflection plate power (page 67) 
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Sorted sample collection 

Introduction This topic describes the sorted sample collection components. 

Sample collection devices During sorting, the sample collection subsystem collects the charged droplets. You 
can sort droplets into the following sort devices: 

 Multiple test tubes 

 96-well tray 

 Standard microscope slides 

Sort stage The main component of sample collection is the sort stage. The sort stage is a two-
axis mechanism that holds sort trays (plates, or adapters which hold tubes or 
slides). You can control the position of the sort stage with BD FACS Sortware 
sorter software. 

Sort stage mechanism 96-well plate 

 

 

  
 

2-way (2-tube) sort 
adapter on sort tray 
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4-way (4-tube) sort 
adapter 

4-way 12 x 75 tube holder 

More information � Sort electronics (page 58) 

� Sort monitoring rack (page 61) 
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Sort monitoring rack 

Introduction This topic describes the sort monitoring rack. 

Use the sort monitoring rack to operate BD FACS Sortware sorter software, set up 
and adjust the drop frequency and alignment, and monitor a sort in real time as 
the BD Influx sorter acquires data. 

Components The sort monitoring rack includes the following components. 

Pinhole monitor Drop monitor Sort stream monitor 

Sortware user interface 

Oscilloscope 

Deflection plate power 

    
 

 

  

 

Component Description 

Pinhole monitor Displays an image of the pinholes through the pinhole 
camera. 

Drop monitor Displays an image of the stream breakoff through the drop 
camera. 

Sort stream monitor Displays an image of the sidestreams and stream drain 
through the stream camera. 
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Component Description 

Deflection plate power Includes the PLATE power button and +/- HV (high 
voltage) readouts. Deflection plate voltage is on when the 
PLATE button is illuminated. 

Sortware user interface Consists of a monitor, keyboard, and mouse. 

Oscilloscope Displays voltage pulses and laser delay settings as particles 
pass through the laser. 

Other components Other monitoring components are described in the fluidics section of this guide. 
These components include: 

 Pressure readouts 

 Sample station fault LED indicators 

 Drop position indicator 

More information � Functional subsystems (page 29) 

� Sample introduction (page 33) 

� Pressure regulation and monitoring (page 37) 

� Sorted sample collection (page 59) 

� Power distribution (page 64) 

� Deflection plate power (page 67) 
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System power 

This section includes these topics: 

 Power distribution (page 64) 

 AC power (page 65) 

 DC power supply (page 67) 
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Power distribution 

Introduction This topic describes the power distribution controls. 

Power is distributed to the instrument components by switched and unswitched 
power strips. You can use the power distribution controls to turn on specific parts 
of the instrument as needed. 

Components The electronics and power subsystems consist of the following: 

 AC power 

 DC power 

How power is distributed This figure shows how power is distributed from the AC power source to the 
isolation transformer, from the isolation transformer to the switched circuit or the 
Always On circuit, and from the Always On circuit to the DC power. 

AC power source Switched circuit 
Computer monitor 

Computer workstation 
Cytometer controller 

Digital scale (AC-to-DC adapter) 
Pinch valve (AC-to-DC adapter) 

UV lamp timer 

Vacuum pump 
AC isolation 
transformer 

Always On circuit 

DC power supply 

DC Power 

Lasers 
Preamp PCBs 

Sort monitoring rack 
Pinhole cameras 

Drop camera 
Stream camera 

Stream illumination LEDs 
Motion control 

Deflection plate power 
System fans and laser heatsink 

Oscilloscope 
Triple LCD monitors
 (AC-to-DC adapter) 

More information � AC power (page 65) 

� DC power supply (page 67) 
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AC power 

Introduction This topic describes the AC power for the BD Influx system. 

Main power switch and 
isolation transformer 

The BD Influx electrical system uses a power source of 120 VAC/60 Hz/15 A. 
From the source, the instrument sends the AC power to an isolation transformer. 
The main system power switch (power source) is typically located in the back of 
the instrument or on the bench next to the instrument. 

Main system power switch. 

Switched circuit 

Always On circuit 

 

 
     

 
    

 
 

   
      

  

 

  

The isolation transformer sends 120 VAC to the Always On and Switched circuits. 
The components of these two circuits are plugged into circuit-specific power strips 
which are plugged into the back of the transformer. 

Always On circuit The Always On circuit components run as long as the instrument is connected to 
its power source and that component is switched on. This circuit sends 120 VAC 
to the protector power strip. This power strip supplies 120 VAC to the following 
components: 

 Computer and monitor 

 Digital scale 

 UV lamp timer (controls when the UV lamp is turned on and off) 

A separate 8-outlet power supply delivers 120 VAC to the following components: 

 All lasers 

 Pinch valve power supply (solenoid pinch valve controller PCB on the 
pressure console) 

 An additional power strip (on the back of the DC power supply) 

 Upper and lower plenum of the optional HEPA-filtered enclosure 
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Switched circuit The Switched circuit is controlled by a 6-outlet power strip. The power strip 
receives 120 VAC from the isolation transformer. The main ON/OFF switch must 
be turned on to deliver 120 VAC to the following components: 

 DC power supply (See DC power supply (page 67) for more information.) 

 Oscilloscope 

 Triple LCD (120 VAC converted to 12 VDC/2 A) 

Separate wall power A vacuum pump runs directly from the wall power source, independent from the 
source instrument power circuitry. The vacuum pump is supplied with the instrument, 

but any vacuum pump that meets BD specifications can be used. 

You should consider powering the digital scale from a separate wall power source 
to avoid having to reset the digital scale each time the system is shut down. 

Auxiliary power switch The following figure shows the location of the power switches on the front of the 
and laser power supply system. 

Auxiliary power switch 

Laser power supplies 

Emergency shutoff Switch the main power switch off in emergency shutdown situations. 

More information � Power distribution (page 64) 

� DC power supply (page 67) 

� System startup (page 223) 
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DC power supply 

Introduction This topic describes the components that are powered by the DC power supply. 

DC power The DC power supply receives 120 VAC from the 8-outlet power strip. The 
system ON/OFF switch must be switched on for the DC power supply to supply 
power to its DC components. 

The DC power supply distributes DC voltages to the following components: 

 Preamp PCBs 

 Sort monitoring rack 

 Forward pinhole camera 

 Head connect PCB, which delivers power to the following components: 

– Pinhole camera 

– Drop camera 

– Stream camera 

– Stream illumination laser 

 Deflection plate voltage 

 Main control, which controls the preamp and laser heatsink fans 

Deflection plate power The PLATES button turns the power to the deflection plates on and off. The 
button illuminates when the power is on. The button and the HV readouts are 
located below the pinhole monitors on the sort monitoring rack. The voltage 
should be 3.6 kV (+HV) and –3.6kV (–HV) (+/– 0.02kV). 

More information � Sort electronics (page 58) 

� Power distribution (page 64) 

� AC power (page 65) 

� Calibrating the digital scale with an empty tank (page 228) 
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8 
Maintenance 

This section includes these maintenance topics: 

 Maintenance overview (page 70) 

 Instrument cleaning and maintenance (page 71) 

 Cleaning and inspecting the instrument (page 72) 

 Inspecting and cleaning the deflection plates (page 72) 

 Bypassing the sheath filter (page 75) 

 Cleaning the fan guards (page 77) 

 Backflushing the sample line for a different sample (page 78) 

 Decontaminating the fluidics (page 79) 

This section also includes the following component replacement topics: 

 Component replacement (page 80) 

 Removing and replacing the nozzle tip (page 81) 

 Removing the sample line (page 82) 

 Installing a new sample line (page 83) 

 Removing the sheath and waste fluidics lines (page 85) 

 Installing new sheath and waste fluidics lines (page 87) 

 Replacing the nozzle assembly (page 89) 

 Replacing the sample stopper (page 90) 
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Maintenance overview 

Introduction This topic describes the periodic maintenance procedures required for proper 
system operation and optimal performance. 

Who should perform 
maintenance 

This maintenance should be performed by your BD Influx system administrator. 
Contact your BD service representative if you do not have the proper tools or 
materials to perform these maintenance procedures. 

Daily maintenance Daily maintenance includes the following procedures. 

Stage Description 

1 Cleaning and inspecting the instrument (page 72) 

2 Inspecting and cleaning the deflection plates (page 72) 

3 Bypassing the sheath filter (page 75) 

4 Decontaminating the fluidics (page 79) 

5 Cleaning the nozzle tip (page 234) 

Weekly maintenance Weekly maintenance includes the following procedures. 

Stage Description 

1 Cleaning the fan guards (page 77) 

2 Decontaminating the fluidics (page 79) 

Monthly maintenance In addition to daily and weekly maintenance procedures, perform a system flush 
with bleach each month. See Flushing the system (page 233) for more 
information. 

Periodic maintenance Perform these maintenance procedures every 4 to 6 months or as needed. 

Stage Description 

1 Backflushing the sample line for a different sample (page 78) 

2 Removing the sample line (page 82) 

3 Installing a new sample line (page 83) 

4 Removing the sheath and waste fluidics lines (page 85) 

5 Installing new sheath and waste fluidics lines (page 87) 
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More information � Instrument cleaning and maintenance (page 71) 

� Component replacement (page 80) 

� Flushing the system (page 233) 

Instrument cleaning and maintenance 

Introduction This topic lists all the instrument cleaning and maintenance procedures that you 
can perform without assistance from BD service. 

 If you are performing regular daily, weekly, or monthly maintenance, follow 
the specific maintenance workflows. 

 If you need to clean or maintain the system due to accidents, spills, repairs, 
upgrades, or changes in performance, you can perform the cleaning and 
maintenance procedures in any order (as needed). 

Individual cleaning and 
maintenance procedures 

See the following topics for cleaning or maintenance (as needed): 

 Cleaning and inspecting the instrument (page 72) 

 Inspecting and cleaning the deflection plates (page 72) 

 Bypassing the sheath filter (page 75) 

 Cleaning the fan guards (page 77) 

 Backflushing the sample line for a different sample (page 78) 

 Decontaminating the fluidics (page 79) 

 Component replacement (page 80) 

 Flushing the system (page 233) 

 Cleaning the nozzle tip (page 234) 

More information � Maintenance overview (page 70) 

� Component replacement (page 80) 
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Cleaning and inspecting the instrument 

Introduction This topic describes the basic instrument cleaning and inspection procedures. 
Perform this procedure daily. 

Required materials  10% bleach 

 Deionized (DI) water 

 Wipes 

Procedure To clean and inspect the instrument: 

1. Remove dust from all exposed surfaces. 

2. Clean salt buildups from the parts and areas exposed to sheath or sample 
fluids. 

3. Clean the sort tray with a solution of 10% bleach and DI water. 

4. Clean the stream camera by wiping off any debris or spots. 

5. Vacuum dust and lint from fan areas, such as the back of the sort electronics 
console, laser power supplies, and the computer. 

6. Inspect the tubing and fluidics for leaks. 

More information � Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Inspecting and cleaning the deflection plates (page 72) 

� Component replacement (page 80) 

Inspecting and cleaning the deflection plates 

Introduction This topic describes how to inspect the deflection plates for wear or damage and 
how to clean them. 

Required materials  Kimwipes®wipe or other lint-free towel 

 DI water 
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Inspecting the deflection 
plates 

Caution: Electrical! To prevent possible electrical shock when working around the 
deflection plates, make sure that the plates are powered off. 

To inspect the deflection plates: 

1. Power off the deflection plates by pressing the PLATES button on the sort 
monitoring rack. The button should not be illuminated. 

2. To view the plates, open them by swinging them away from the stream drain 
so that the protective tape is facing towards you. 

3. Inspect the protective tape on the high-voltage deflection plates. Look for 
signs of wear or ripping. Check for wear or damage on the inside edge of the 
deflection plates. 

 

   

   
 

 

 

 

   

   
 

 

 
  

Inside edge of the deflection 
plates 

4. Inspect for signs of water leakage or wetness. 

5. Clean the plates thoroughly if salt crystals are visible anywhere on the tape. 

Cleaning the deflection To clean the deflection plates: 
plates 

1. Power off the deflection plates by pressing the PLATES button on the sort 
monitoring rack. The button should not be illuminated. 

2. To view the plates, open them by swinging them away from the stream drain 
so that the protective tape is facing towards you. 

3. Wet a Kimwipes wipeor other lint-free towel with DI water and wipe down 
the deflection plates. 

4. Wipe the plates again with a dry wipe to ensure that there is no fluid on the 
plates before closing them. 
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5. Close the deflection plates by swinging them into their closed position. 

The attached magnetic latches hold them in place. 

More information � Deflection plate power (page 67) 

� Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Bypassing the sheath filter (page 75) 
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Bypassing the sheath filter 

Introduction This topic describes how to remove and bypass the sheath filter when you want to 
perform a dry shutdown or when you want to replace the filter or tubing. 

Procedure To bypass the sheath filter: 

1. Press RUN to turn off all fluidics. 

2. Turn off the AIR switch on the pressure console. 

3. Depressurize the sheath tank. 

4. Remove the external sheath filter. 

5. Disconnect the upper quick connect fitting from the instrument sheath line. 

Upper quick connect . 

6. Disconnect the lower quick connect fitting from the tank sheath line. 

Lower quick connect 

7. Reconnect the sheath tank without the sheath filter. 

a. Close the pressure relief valve on the tank. 

b. Connect the external air line to the air input fitting on the tank. 
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c. Bypass the sheath filter by connecting the tank sheath line to the 
instrument sheath line. 

Sheath output to sheath line 

Air input 

Pressure relief valve 

The sheath filter is now bypassed. You can now flush the instrument fluidics 
with DI water, dry the fluidics tubing, or replace the sheath filter. 

More information � Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Cleaning the fan guards (page 77) 

� Component replacement (page 80) 
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Cleaning the fan guards 

Introduction This topic describes how to clean the fan guards on the system. Perform this 
procedure weekly. 

The system includes fan guards in the following locations: 

 Computer tower 

 Main power supply 

 Acquisition system grills 

Procedure To clean the fan guards: 

1. Brush or vacuum the top of the fan guards to clear any particulates or debris. 

More information � Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Backflushing the sample line for a different sample (page 78) 
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Backflushing the sample line for a different sample 

Introduction This topic describes how to prevent sample carryover when you run samples on 
the instrument. Perform this procedure as needed or when the sample line is 
clogged. 

Required materials Sheath fluid 

Procedure To backflush the sample line for a different sample: 

1. Load a sample tube with sheath fluid. 

2. Run clean sheath through the sample line at a high sample pressure (~3 PSI 
over the sheath pressure). 

3. Hold the BOOST button to maintain the high sample pressure. 

4. Run until no particles are detected. 

When you switch from one sample to another, make sure to backflush the 
sample line for approximately 10 seconds. This helps to minimize sample 
carryover. 

More information � Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Removing and replacing the nozzle tip (page 81) 

� Decontaminating the fluidics (page 79) 

� Component replacement (page 80) 
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Decontaminating the fluidics 

Introduction This topic describes how to decontaminate the fluidics. 

Required materials  10% bleach 

 DI water (1L) 

Procedure To decontaminate the fluidics: 

1. Load a tube of 10% bleach and press SAMPLE. Run it for 5 minutes. 

2. Load a tube of DI water and press SAMPLE. Run it for 5 minutes. 

3. Press RUN to turn off all fluidics. 

4. Turn off the AIR switch on the pressure console. 

5. Empty the sheath tank, rinse it, and fill it with about 500 mL of DI water. 

6. Bypass the sheath filter. 

7. Reattach the sheath tank and turn the air on. 

8. Press RINSE, and then BACKFLUSH to rinse all fluid lines with DI water 
until the tank runs dry and the sample line is no longer dripping water. 

9. Press RINSE to turn off the flow. 

10. Remove the nozzle tip and place the flush bucket under the nozzle. 

Caution! Make sure the piezo amplitude is turned off before removing the 
nozzle tip. 

11. Disconnect the air and fluid lines from the sheath tank and connect them to 
each other. 

12. Press RINSE, then BACKFLUSH. 

13. Allow air to blow through the system for about 10–15 minutes to completely 
dry it out. 

14. Turn off the air supply. 

15. Empty all fluid from the waste and sheath tanks, rinse them with clean DI 
water, and allow them to dry overnight. 

More information � Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Bypassing the sheath filter (page 75) 

� Replacing the nozzle assembly (page 89) 
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Component replacement 

Introduction This topic lists the components you can remove and replace without the assistance 
of a service representative. 

Before replacing 
components 

Before beginning any maintenance procedures, do the following: 

 Shutter or turn off the power to all lasers. 

 Turn off the piezo amplitude. 

 Turn off the deflection plates. 

 Turn off all PMTs. 

 Decontaminate any parts of the instrument that have been in contact with 
biohazardous samples, or use appropriate biohazard precautions. 

User-replaceable 
component procedures 

You can perform the following component replacement procedures: 

 Removing and replacing the nozzle tip (page 81) 

 Removing the sample line (page 82) 

 Installing a new sample line (page 83) 

 Removing the sheath and waste fluidics lines (page 85) 

 Installing new sheath and waste fluidics lines (page 87) 

 Replacing the nozzle assembly (page 89) 

 Replacing the sample stopper (page 90) 

More information � Power distribution (page 64) 

� Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Decontaminating the fluidics (page 79) 

� Turning off the power (page 326) 
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Removing and replacing the nozzle tip 

Introduction This topic describes how to remove and replace the nozzle tip. You need to 
remove the nozzle tip to clean the nozzle or change nozzle sizes. 

Removing the nozzle tip To remove a nozzle tip: 

1. Turn the system power off. 

Caution: Electrical! To prevent possible electrical shock when working with 
the nozzle assembly, make sure that the power is off. 

2. Loosen the nozzle nut by hand. Do not use a wrench. 

3. Remove the nut and nozzle tip. 

4. Place the nozzle tip, nut, and O-ring in a safe place. 

Replacing the nozzle tip To replace the nozzle tip: 

1. Place the clean nozzle tip into the nozzle nut, ensuring that the O-ring is in 
place around the nozzle tip. 

2. Screw the nozzle tip onto the nozzle, tightening by hand as much as possible. 
Do not use a wrench. 

More information � Maintenance overview (page 70) 

� Instrument cleaning and maintenance (page 71) 

� Backflushing the sample line for a different sample (page 78) 

� Decontaminating the fluidics (page 79) 

� Cleaning the nozzle tip (page 234) 
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Removing the sample line 

Introduction This topic describes how to remove the sample line. 

Removing the sample line prevents any sample carryover or cross-contamination 
of cells. Perform this procedure every 4 to 6 months, or when decreased event 
rates indicate that the sample line is clogged. 

Before you begin  See Before replacing components (page 80) for more information. 

 Make sure that your system is dry. 

Procedure To remove the sample line: 

1. Verify that the air switch is on. 

2. Remove the sample line from the nozzle assembly. 

3. Gently pull the silicone rubber seal where it attaches to the stainless steel 
tubing. 

Caution! Do not bend the stainless steel fitting. 

Silicone tubing 

4. Press the OVERRIDE button to release the sample line pinch valve. 

5. Remove the sample line from the sample line pinch valve. 

6. Remove the sample line from the sample stopper column. 
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7. Gently pull on the silicone rubber seal where it attaches to the stainless steel 
tubing. 

Caution! Do not bend the stainless steel fitting. 

More information � Maintenance overview (page 70) 

� Decontaminating the fluidics (page 79) 

� Component replacement (page 80) 

� Installing a new sample line (page 83) 

Installing a new sample line 

Introduction This topic describes how to install a new sample line to help minimize sample 
carryover. Perform this procedure every 4 to 6 months, or when decreased event 
rates indicate that the sample line is clogged. 

Required materials  Sheath sample line 

 DI water (2–3 mL) 

 Mirror 

 Flashlight 

Before you begin  See Before replacing components (page 80) for more information. 

 Remove the existing sample line. 

Procedure To install a new sample line: 

1. Remove the nozzle tip. 

2. Gently feed the sample line through the stainless steel fitting on top of the 
nozzle assembly, sliding the silicone rubber tubing over the stainless steel 
fitting. 

Caution! Do not bend the sample line or the stainless steel fitting. 
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3. Use a mirror and a flashlight to verify that the sample line is extending about 
1 mm beyond the end of the stainless steel fitting inside the nozzle assembly. 

Sample line installed incorrectly Sample line installed correctly 

Caution! Tighten the cap screw by hand. Do not use a wrench or you might 
crack the fitting. 

4. Press OVERRIDE on the sample station, if it is not already on. 

5. Install the sample line into the sample station by feeding it through the 
stainless steel tubing. 

6. Insert the silicone section of the tubing into the pinch valve. 

7. Verify that the sample line is not blocking the bubble detector just below the 
pinch valve. 

The bubble detector should have only silicone tubing in front of it. When the 
tubing is inserted properly, the bubble detector will register that there is air in 
the sample line, and the LED light will be off. 
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8. Install a tube and check the length of the sample line. Adjust if necessary. 

9. Run 2–3 mL of clean DI water through the sample line before running 
samples. 

More information � Maintenance overview (page 70) 

� Component replacement (page 80) 

� Removing the sample line (page 82) 

Removing the sheath and waste fluidics lines 

Introduction This topic describes how to remove the fluidics lines that connect to the sheath 
and waste tanks. Perform this procedure as needed. 

Before you begin See Before replacing components (page 80) for more information. 

Procedure To remove the fluidics lines: 

1. Verify that the air switch is on. 

2. Depressurize the sheath tank. 

a. Disconnect the air line to the sheath tank. 

b. Open the pressure release valve. 
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3. Remove the sheath and purge lines from the top of the Y fitting above the 
nozzle. 

Purge line 

Sheath line 

4. Press RINSE to open both the sheath and purge valves. 

5. Remove the tubing from the two valves. 

Sheath line valve 

Purge line valve 

6. Remove the hold-down covers that route the fluidic lines along the back of 
the instrument. 

If you have an instrument with a hood, you will have clips along the back of 
the instrument instead of a hold-down cover. 
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7. Undo the connections on the fluidics lines going to the sheath and waste 
tanks. 

8. Remove the sheath filter. 

More information � Maintenance overview (page 70) 

� Component replacement (page 80) 

� Installing new sheath and waste fluidics lines (page 87) 

Installing new sheath and waste fluidics lines 

Introduction This topic describes how to replace the fluidics lines that connect to the sheath 
and waste tanks. Perform this procedure as needed. 

Required materials Sterile sheath fluid (at least 200 mL) 

Before you begin  See Before replacing components (page 80) for more information. 

 Remove the existing fluidics lines. 

Procedure To install new fluidics lines: 

1. Attach a new sheath filter. 

2. Attach the new sheath and waste/purge lines and reroute them to the top of 
the instrument. 

3. Attach the fittings to the Y fitting. 
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The waste/purge line connects to the top of the Y fitting and the sheath line 
connects to the back of the Y fitting. 

Purge line 

Sheath line 

 
 

 

   

 

 

4. Slide the lines into the pinch valves. 

The waste/purge line runs through the right pinch valve and the sheath line 
runs through the left pinch valve. 

5. Run at least 200 mL of sterile sheath fluid through the tubes before running 
samples. 

More information � Maintenance overview (page 70) 

� Component replacement (page 80) 

� Removing the sheath and waste fluidics lines (page 85) 
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Replacing the nozzle assembly 

Introduction This topic describes how to replace the nozzle assembly. 

Required materials  Sterile sheath fluid (at least 200 mL) 

 7/64 in. Allen wrench 

Before you begin See Before replacing components (page 80) for more information. 

Removing the nozzle 
assembly 

Caution: Electrical! To prevent possible electrical shock when working with the 
nozzle assembly, make sure that the power is off. 

To remove the nozzle assembly: 

1. Remove the sample line from the top of the nozzle assembly by sliding the 
silicone off the stainless steel tubing. 

2. Detach the nozzle line from the Y fitting. 

3. Remove the screw using a 7/64 Allen wrench to hold the nozzle assembly in 
place. 

4. Inspect the drop charge contact and the piezo drive connections for corrosion 
or bending. 

Installing the new nozzle To install the new nozzle assembly: 
assembly 

1. Gently feed the sample line through the stainless steel fitting on the top of the 
new nozzle assembly, sliding the silicone rubber tubing over the stainless steel 
fitting. 

Caution! Do not bend the sample line or the stainless steel fitting. 

2. Verify that the sample line is extending about 1 mm beyond the end of the 
stainless steel fitting inside the nozzle assembly. 

3. Attach the new nozzle assembly using the thumbscrew removed earlier. 

The nozzle assembly will key into position automatically. 

4. Tighten the thumbscrew by hand. 

Do not use a wrench or you might crack the fitting. 

5. Reattach the sheath tubing to the Y fitting. 

6. Before attaching a nozzle tip, run at least 200 mL of sterile sheath fluid 
through the new nozzle assembly. 

More information � Component replacement (page 80) 
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Replacing the sample stopper 

Introduction This topic describes how to remove the sample stopper. 

Removing the sample To remove the sample stopper: 
stopper 

1. Turn off the power to the electronics and the lasers. 

The power to the pressure console can be left on. 

2. Remove the sample line from the nozzle assembly. 

3. Gently pull the silicone rubber seal where it attaches to the stainless steel 
tubing. 

Caution! Do not bend the sample line or the stainless steel fitting. 

4. Press the OVERRIDE button to release the sample line pinch valve. 

5. Remove the sample line from the sample line pinch valve. 

6. Remove the sample line from the sample stopper column. 

There is no need to remove the sample line from the nozzle assembly. 

7. Gently pull the sample stopper off the end of the sample column. 

Installing a new sample To install a new sample stopper: 
stopper 

1. Slide the new sample stopper onto the sample column. 

Do not force the sample stopper on. You can use a small amount of detergent 
to make it easier to slide the stopper onto the sample column. 

2. Inspect the stopper for cracks and replace it if there are cracks. 

3. Replace the sample line in the sample column. 

More information � Component replacement (page 80) 



 

 

Part 2 
Software information 

This part includes these sections: 

 Chapter 9: Software overview (page 93) 

 Chapter 10: Preferences and settings (page 101) 

 Chapter 11: Cytometer settings (page 119) 

 Chapter 12: Worksheets (page 137) 

 Chapter 13: Acquisition and recording tools (page 147) 

 Chapter 14: Plots (page 157) 

 Chapter 15: Gates and populations (page 177) 

 Chapter 16: Sort settings and layout (page 203) 
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Software overview 

This section includes these topics: 

 BD FACS Sortware overview (page 94) 

 About lasers and pinholes (page 98) 
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BD FACS Sortware overview 

Introduction This topic describes how BD FACS Sortware sorter software interacts with the 
instrument. It also describes the user interface and defines the panes that you can 
select from the main software window. 

How the software 
interacts with the 
instrument 

BD FACS Sortware sorter software serves as the user interface and works with the 
cytometer interface to control the instrument, acquisition, sorting, and analysis. 
The cytometer interface is a separate, dedicated computer that connects to the 
main computer and the sorter hardware. 

Main computer Separate, dedicated computer BD Influx 

Sorter hardware 
BD FACS Sortware 

(software user interface) 
Cytometer interface 

(instrument control software ) 

User interface BD FACS Sortware sorter software serves as the user interface and provides all 
user control for the instrument, acquisition, sorting, and analysis. 

The worksheet is always open. Use the worksheet to create and modify plots, 
monitor sort data, and analyze sort results. 

Worksheet 

Examples of panes in the workspace 
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Panes Panes can be opened, closed, resized, moved, and pinned within the workspace so 
that you can create your own window layout. Click the tools on the BD FACS 
Sortware sorter software toolbar to open panes in the workspace. 

You can arrange individual panes to create specific window layouts. See Setting up 
your window layout (page 102) for more information. 

Control Description 

Opens the Acquisition Dashboard pane. Use this pane to start 
or stop acquisition, record events, and monitor data 
acquisition details. 

See Using the Acquisition Dashboard (page 155) for more 
information. 

Opens the Recording Settings pane. Use this pane to set details 
about the FSC file that is generated when you record data. 

See Using the Recording Settings pane (page 152) for more 
information. 

Opens the Data Sources pane. Use this pane to view data and 
information from the instrument or loaded or recorded data 
sources (FSC files). 

See Using the Data Sources pane (page 148) for more 
information. 

Opens the Gate Hierarchy pane. Use this pane to display and 
manipulate the hierarchy (tree) of the gates in an active plot. 

See Using the Gate Hierarchy pane (page 180) for more 
information. 

Opens the Inspector pane. Use this pane to view and modify 
data source properties and properties for selected worksheet 
items. 

See Using the Inspector to view and modify plot properties 
(page 163) for more information. 

Opens the Logicle Scaling pane. Use the logicle scale after 
compensation to view events that have negative values. 

See Using the Logicle Scaling pane (page 133) for more 
information. 

Opens the Compensation pane. Use this pane to create a 
compensation matrix, select parameters for auto 
compensation, and calculate fluorescence spillover values. 

See Using the Compensation pane (page 130) for more 
information. 
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Control Description 

Opens the Tray Control pane. Use this pane to view or modify 
the current sort device and adjust the offsets for the tray, or 
create a new sort device configuration. 

See Using the Tray Control pane (page 210) for more 
information. 

Opens the Sort Layout pane. Use this pane to select the sort 
device, set up populations to be sorted, and control the 
position and readiness of the sort device. 

See Using the Sort Layout pane (page 217) for more 
information. 

Opens the Sort Settings pane. Use this dialog to set up the drop 
formation, drop delay, breakoff, and deflection parameters, 
and to select a sort mode. 

See Using the Sort Settings pane (page 204) for more 
information. 

Opens the Cytometer Settings pane. Use this pane to view the 
status or modify the laser and detector settings of the 
cytometer. 

See Using the Cytometer Settings pane (page 120) for more 
information. 

Setting numeric values in 
panes and dialogs 

BD FACS Sortware sorter software panes and dialogs include fields with 
adjustable numeric values. You can adjust these numeric values using different 
mouse and keyboard options. 

To set numeric values in fields with the mouse: 

 Hold the mouse pointer over the field and roll the mouse scroll wheel up or 
down to change the value. You do not need to click in the field to change the 
values with the scroll wheel. 

Cursor in Field 

 Click the small up and down arrows to change the value. 

 Click in the small blue/white data slider below the value to change the value. 
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 In the field, click and hold the larger down arrow. 

Small up and down arrows Larger down arrow 

The large data slider appears. 

Continue to hold the mouse button and slide the data slider left or right to 
adjust the values. 

To set numeric values in fields with the keyboard: 

 Click in the field and press the up or down arrow keys to adjust the values. 

 Click in the field and press CTRL and the up or down arrow keys to adjust 
the values in larger increments. 

The increment values are dependant on the field that is being adjusted. For 
example, the detector voltage is adjusted in increments of 0.1 with the arrow 
keys and 1.0 volts with Ctrl+arrow keys, while piezo amplitude is adjusted in 
increments of 0.01 and 0.1, respectively. 

More information � About lasers and pinholes (page 98) 

� Preferences and settings (page 101) 

� Worksheets (page 137) 

� Saving and restoring settings (page 112) 
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About lasers and pinholes 

Introduction This topic describes how lasers are assigned to pinholes. 

About pinholes Pinholes are used (along with the pinhole monitor) to provide a visual reference 
for aligning the sample stream and to help determine droplet breakoff points. One 
of the five pinholes is assigned as the “trigger,” which serves as the reference for 
comparisons in alignment. 

The following illustration shows a stream aligned with the pinholes as displayed 
through the pinhole monitor. 

Aligned sample stream and pinholes 

How lasers are assigned 
to pinholes 

The pinholes are set to correspond to the physical laser setup of your instrument. 
Since lasers are assigned to pinholes during initial installation and setup, you do 
not need to change the laser-to-pinhole assignment unless you change or add 
lasers to your instrument. 

The order of the lasers in the Cytometer Setup pane are based on the physical laser 
setup on your instrument. 

Note that laser 1 (as it appears in the list of lasers) corresponds to pinhole 1. The 
following figure shows descriptions added to the laser name to indicate how the 
lasers correspond to the pinholes. 
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How detectors are Detectors are assigned to lasers during initial installation and setup. Typically, you 
assigned to lasers do not need to change the detector-to-laser assignment unless you make changes 

to the system optics or create a custom configuration. 

In the following figure, FSC, SSC, and the 488-nm laser detectors are assigned to 
the Blue (488) laser (pinhole 1). 

Blue laser 

Assigned detectors 

More information � BD FACS Sortware overview (page 94) 
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10 
Preferences and settings 

This section includes these topics: 

 Setting up your window layout (page 102) 

 Editing user preferences (page 105) 

 Setting cytometer preferences (page 105) 

 Setting gate and population display preferences (page 108) 

 Setting plot display preferences (page 110) 

 Setting statistics views display preferences (page 111) 

 Saving and restoring settings (page 112) 

 Saving and deleting settings (page 115) 

 Creating storage folders (page 117) 

 Restoring saved settings (page 118) 
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Setting up your window layout 

Introduction This topic describes how to set up and customize the BD FACS Sortware sorter 
software window layout. 

You can open different panes within the BD FACS Sortware sorter software 
window and drag and dock them to different locations, or create standalone 
(floating) panes and save the window layout. 

Undocking and docking To undock panes: 
panes 

1. Click in the title bar area of any docked pane and drag the pane away from its 
docked location. 

The pane becomes a floating pane. 

An undocked pane 

Title bar 

To dock a floating pane to a new location in the workspace: 

1. Drag the floating pane over one of the following vertical or horizontal 
docking targets. 

The floating pane is now a docked pane. 

Changing themes To change the window theme: 

1. Select Windows > Themes. 

2. Select the default or other available window theme. 
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Saving the window To save the current window layout: 
layout 

1. Select Windows > Save Window Layout. 

The Save Window Layout dialog opens. 

2. Select the storage folder where you want to save this layout from the Storage 
menu. 

3. Under Window Layout Details, type a name for the new window layout in the 
Name field. 

4. Click OK to save the window layout and close the dialog. 
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Restoring the window To restore the window layout: 
layout 1. Select Windows > Restore Window Layout. 

The Restore Window Layout dialog opens. 

2. Select the storage folder that contains the file you want to restore (default or a 
user-defined storage folder) from the Storage menu. 

3. Under Window Layout List, select a layout to restore. 

4. Click OK. 

More information � Preferences and settings (page 101) 

� Editing user preferences (page 105) 

� Saving and deleting settings (page 115) 

� Restoring saved settings (page 118) 
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Editing user preferences 

Introduction This topic describes how to edit user preferences for gates, plots, statistical 
displays, acquisition, and the cytometer using the Edit User Preferences dialog. 

Preferences are not required. You can set preferences at any time and in any order. 
If you do not specify preferences, default values are used. 

User preferences You can set the following user preferences: 

 Setting cytometer preferences (page 105) 

 Setting gate and population display preferences (page 108) 

 Setting plot display preferences (page 110) 

 Setting statistics views display preferences (page 111) 

More information � Preferences and settings (page 101) 

� Saving and deleting settings (page 115) 

� Restoring saved settings (page 118) 

Setting cytometer preferences 

Introduction This topic describes how to specify: 

 The display of a parameter name 

 How plots are used 

 How the cytometer updates at startup 

 The sort tray direction 

These are global settings. You can use the default values or set custom preferences 
as needed. 

Procedure To set cytometer information: 

1. Select Edit > Preferences. 

The Edit User Preferences dialog opens. 
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2. Click the Cytometer tab. 

3. Set cytometer preferences. 

� Under  Parameters, select the Show Parameter’s Full Name checkbox to 
display the full fluorchrome/parameter name in plots and statistics views. 

� Under  Plot/Views, select plot and view options. 

If you select... Then... 

Set Scope to 
Parameter(s) 

Select a plot to view the signal on the oscilloscope 
using parameters from a plot. 

Set Cytometer Plots/ 
Views as Global 

All worksheet elements (plots, population 
hierarchies, statistics views) with Cytometer as the 
data source show data from a single file (the file 
selected in the Data Sources pane). Use this to 
quickly view all the data from a file. Non-global 
worksheet elements (those showing data from a file 
other than the file selected in the Data Sources 
pane) can still be added to the worksheet when this 
option is selected. 

See Worksheet overview (page 138) for more 
information. 
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� Under Cytometer Update at Startup, select a startup option. 

If you select... Then... 

Get Current Influx State 
from Server 

Gets the current instrument state from the 
cytometer interface. This does not include 
parameter names or labels. 

Restore Laser and 
Parameter Names 

Gets the current instrument state from the 
cytometer interface and restores parameters and 
labels. 

Restore Full Cytometer Restores the cytometer settings to the settings from 
the last time the system was used. 

� Under  Sort Tray Direction, select Optimized (for the plate to move in a 
serpentine motion: A1 to A12, B12 to B1), Left to Right, or Top to 
Bottom as the default sort tray sorting direction. 

4. Click OK to apply your preferences. 

More information � Preferences and settings (page 101) 

� Setting gate and population display preferences (page 108) 

� Setting plot display preferences (page 110) 

� Setting statistics views display preferences (page 111) 
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Setting gate and population display preferences 

Introduction This topic describes how to set gate and population display preferences. 

These are global settings. You can use the default values or set custom preferences 
whenever you want to modify the appearance of gates and populations. 

Procedure To set the default gate and population colors: 

1. Select Edit > Preferences. 

The Edit User Preferences dialog opens. 

2. Click the Gating tab. 

3. Click in the Gates field and enter a new default name for any of the gates 
(populations) in the list. 

4. Right-click a colored box next to a gate (population) in the list (for example, 
P1). 
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The Color Picker dialog opens. 

5. Click on a color sample in the Color Picker dialog or click Advanced Colors 
to create a custom color sample. 

The selected color appears in the Color sample at the bottom of the dialog. 

6. Close the dialog to apply the color. 

7. Click OK to apply your preferences. 

More information � Preferences and settings (page 101) 

� Setting cytometer preferences (page 105) 

� Setting plot display preferences (page 110) 

� Setting statistics views display preferences (page 111) 
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Setting plot display preferences 

Introduction This topic describes how to set the plot background, display attributes, and label 
fonts. 

These are global settings. You can use the default values or set custom preferences 
whenever you want to modify the appearance of plots. 

Procedure To set the plot background and the plot label fonts: 

1. Select Edit > Preferences. 

The Edit User Preferences dialog opens. 

2. Click the Plots tab. 

3. Make plot display selections: 

� Under  General, right-click the color sample for one of these options to 
open the color picker and select colors for the plot frame background, the 
plot area background, text, and tick marks. You can also set the level of 
transparency or show the plot border as full or half. 

� Under Title, modify the plot title font face, font size, or make the title 
invisible. 

� Under Axis/Tick, modify the plot axis label font face, axis size, tick mark 
size, or make these elements invisible. 

4. Click OK to apply your preferences. 
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More information � Preferences and settings (page 101) 

� Setting cytometer preferences (page 105) 

� Setting gate and population display preferences (page 108) 

� Setting statistics views display preferences (page 111) 

Setting statistics views display preferences 

Introduction This topic describes how to set statistical view display preferences. 

Statistics views contain summary data for plots and populations. These views 
include the population hierarchy and statistics box and appear in the worksheet. 
They can be saved or printed. 

These are global settings. You can use the default values or set custom preferences 
whenever you want to modify the appearance of statistics views. 

Procedure To set statistics view display preferences: 

1. Select Edit > Preferences. 

The Edit User Preferences dialog opens. 

2. Click the Views tab. 
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3. Make statistics views selections: 

� Under  General, select or clear the Show population hierarchy/statistics 
view border checkbox to show or hide the border for the statistics view. 

� Under Header, modify the statistics view header font face, size, and color. 

� Under Table, modify the table text display font face, size, and color. 

4. Click OK to apply your preferences. 

More information � Preferences and settings (page 101) 

� Setting gate and population display preferences (page 108) 

� Setting plot display preferences (page 110) 

� Setting cytometer preferences (page 105) 

Saving and restoring settings 

Introduction This topic describes the different settings that can be saved and restored. 

Settings that can be 
restored 

The settings that can be restored are: 

 Workspace 

 Cytometer settings 

 Analysis templates 

 Sort layouts 

 Window layouts 
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Workspace The following elements are saved with a workspace: 

 Cytometer settings 

 Compensation 

 Data sources 

 Gates 

 Analysis template 

 Sort layout 

 Window layout 

You can restore a previously saved workspace or the workspace that was 
automatically saved the last time you closed the software (Workspace on Exit). 

When you restore a workspace, you can select any of the following options. 

= 

If you select... The following data is restored 

Restore Cytometer Settings: 
Laser and Parameter Names 

 Laser names 

 Detector names 

 Detector labels 

Restore Cytometer Settings: 
All Settings 

All settings in the Cytometer Settings pane 

Restore Compensation  Compensation matrix 

 Logicle scaling 

Restore Data Sources Any data sources recorded in a saved workspace 

Restore Gates Any gates (local and global) 

Note that gates are automatically restored if data 
sources are restored. 

Restore Analysis Template  Worksheet settings 

 Analysis elements 

Restore Sort Layout All settings in the following panes: 

 Sort Settings 

 Sort Layout 

 Tray Control 

Restore Window Layout Pane presence, docking, and position 

Cytometer settings When you save cytometer settings, you save all settings in the Cytometer Settings 
pane. These settings are also saved with a saved workspace. You can restore these 
cytometer settings separately or when you restore a workspace. 
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Analysis template When you save an analysis template, you save the current worksheet settings and 
analysis elements (plots, population hierarchies, statistics views). When you 
restore an analysis template, you can select any of the following options. 

If you select... Then... 

Replace Current Analysis The current analysis is replaced by the saved analysis. 

If you clear the checkbox, the current analysis remains 
and the restored analysis is added to a new page. 

Restore Worksheet 
Preferences 

All worksheet settings in the Inspector pane except 
scale and number of pages are restored. 

Sort layout When you save or restore a Sort layout, you save or restore the current settings 
from the Sort Settings, and Sort Layoutdialogs, and the Tray Control pane. 

Window layout When you save a window layout, you save the current window layout and pane 
locations. You can restore the saved layout, a default layout, or the window 
layout that was automatically saved the last time you closed the software 
(Window Layout on Exit). 

See Setting up your window layout (page 102) for more information. 

Compensation After you have calculated compensation, you can save the compensation by right-
clicking and selecting Compensation below Cytometer Data Source. You can 
restore the compensation matrix to other FCS files in the Data Sources pane. 

More information � Saving and deleting settings (page 115) 

� Creating storage folders (page 117) 

� Restoring saved settings (page 118) 
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Saving and deleting settings 

Introduction This topic describes how to save new or modified settings. This topic also 
describes how to delete existing settings. 

Settings include the workspace, cytometer settings, analysis templates, and sort 
layouts. You can save settings at any time. Note that workspaces and window 
layouts are automatically saved when you close the software. 

Saving settings files To save settings: 

1. Select File > Save, then select a settings file type. 

The selected Save dialog opens. 

See Saving and restoring settings (page 112) for more information. 

2. Select the storage folder where you want to save this settings file in the 
Storage menu. 

See Creating storage folders (page 117) for more information about creating 
custom storage folders. 

3. Under Workspace Details, type a name for the new settings file in the Name 
field. 

4. Click OK to save the workspace and close the dialog. 

Deleting saved settings To delete saved settings files: 
files 

1. In the list of settings files, click the red X for the settings file you want to 
delete. 

The Confirm Deletion dialog opens. 

2. Click Yes to delete the cytometer settings file. 

3. Click OK to close the dialog. 
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Overwriting a saved To overwrite a setting that you have already saved: 
setting 

1. Select File > Save. 

2. Select the name of the settings files and click OK. 

3. Click Yes to confirm the overwrite. 

More information � Creating storage folders (page 117) 

� Setting up your window layout (page 102) 

� Restoring saved settings (page 118) 

� Preparing beads for QC (page 248) 
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Creating storage folders 

Introduction This topic describes how to create custom storage folders for user-defined 
workspaces, cytometer settings, analysis templates, and sort layouts. 

Procedure To create new storage folders for user-defined templates and settings: 

1. Select File > Save and select a settings file. 

The selected Save dialog opens. 

2. Click Add New Storage Location. 

The Create Storage Location dialog opens. 

Add New Storage Location button 

3. In the Name field, type a name for the new storage folder. 

4. Click OK. 

The new storage folder appears in the Storage field. 

More information � Saving and deleting settings (page 115) 



 

  

 

  
 

  

 

 

118 BD Influx User’s Guide 

Restoring saved settings 

Introduction This topic describes how to restore saved settings. 

When you start the BD FACS Sortware sorter software, all settings display default 
values. If you want to apply specific values or layouts, you need to restore these 
settings from a saved settings file. 

Procedure To restore saved settings files: 

1. Select File > Restore, then select a settings file type. 

The selected Restore dialog opens. 

See Saving and restoring settings (page 112) for more information about what 
system settings files data is restored. 

2. Select the storage folder that contains the file you want to restore (Default or 
a user-defined storage folder) from the Storage menu. 

3. Under Workspaces, select a file to restore. 

4. Click OK to open the settings file and apply all settings. 

More information � Saving and deleting settings (page 115) 
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Cytometer settings 

This section describes the different adjustment, customization, and compensation tasks you can perform 
using the Cytometer Settings pane. These tasks are not typically performed as a part of the daily workflow 
and can be performed as needed. 

This section includes these topics: 

 Using the Cytometer Settings pane (page 120) 

 Viewing cytometer status (page 121) 

 Assigning fluorochrome labels to detectors (page 121) 

 Selecting amplification preferences (page 123) 

 Powering the PMTs on and off (page 124) 

 Adjusting PMT voltages and using integrators (page 125) 

 Selecting channels to capture (page 127) 

 Viewing and setting cytometer details (page 129) 

 Using the Compensation pane (page 130) 

 Using the Logicle Scaling pane (page 133) 

 Importing cytometer settings from BD Spigot software (page 135) 

Other related information: 

 Preferences and settings (page 101) 

 Alignment and QC (page 241) 

 Optimizing system settings for samples (page 263) 
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Using the Cytometer Settings pane 

Introduction This topic describes the Cytometer Settings pane and the functions of the different 
tabs. 

Description Use this pane to view the status or modify the laser and detector settings of the 
cytometer. You can also view the integrator board options. 

This pane includes the following tabs: 

Tab Description 

Lasers/Detectors Use this tab to view and modify triggers and scope details, laser 
names and delays, detectors, power, voltage, scale, and labels. 

Integrators Use this tab to view any optional integrators. Integrators 
measure the area and the width of a voltage pulse for selected 
parameters. 

Status Use this tab to view the current status and any cytometer error 
conditions. 
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More information � Cytometer settings (page 119) 

� Viewing cytometer status (page 121) 

Viewing cytometer status 

Introduction This topic describes how to view the current status and any cytometer error 
conditions, and how to clear the status logs. 

Viewing the cytometer To view the cytometer status: 
status 

1. Click Cytometer Settings on the BD FACS Sortware sorter software toolbar to 
display the Cytometer Settings pane. 

2. Click the Status tab. 

The current cytometer status is listed by date. 

Clearing the status logs To clear the status logs: 

1. In the Status tab, click Clear. 

The status screen refreshes and all status messages are cleared. New status 
messages appear in the Status tab if any new errors occur 

More information � Using the Cytometer Settings pane (page 120) 

Assigning fluorochrome labels to detectors 

Introduction This topic describes how to assign fluorochrome labels to specific detectors. 

The label identifies how the detector is being used for a specific configuration and 
creates a more descriptive parameter label whenever the detector is used in a plot. 
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Procedure To assign a fluorochrome label to a detector: 

1. In the toolbar, click Cytometer Settings to display the Cytometer Settings 
pane. 

2. In the Lasers/Detectors tab, locate the detector you want to configure in the 
Detectors list. 

You can click +/- in the laser bar to expand or collapse the list. 

3. In the Label field, type a fluorochrome name. 

The fluorochrome label appears in the parameter label in a plot. 

More information � Cytometer settings (page 119) 

� Assigning fluorochrome labels to detectors (page 121) 
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Selecting amplification preferences 

Introduction This topic describes how to set linear or logarithmic amplification. 

About amplification 
preferences 

The amplification preference sets the scale for plots. The instrument is pre-
configured for linear (lin) signal amplification for scatter detectors and 
logarithmic (log) amplification for fluorescence detectors. 

Lin amplification is typically used whenever you use the FSC and SSC detectors. 
Use log amplification for all other fluorescence channels to provide a wider range 
of intensities. In special applications (for example, distinguishing small particles 
on an FSC vs SSC plot), you can use log amplification with FSC and SSC detectors 
to achieve a higher resolution on the lower end of the scale. 

Procedure To change lin or log settings: 

1. On the toolbar, click Cytometer Settings to display the Cytometer Settings 
pane. 

2. In the Lasers/Detectors tab, locate the detector you want to configure in the 
Detectors list. 

You can click +/- in the laser bar to expand or collapse the list. 

3. Select the Log checkbox to enable logarithmic amplification, or clear it to 
enable linear amplification. 
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More information � Assigning fluorochrome labels to detectors (page 121) 

� Adjusting PMT voltages and using integrators (page 125) 

Powering the PMTs on and off 

Introduction This topic describes how to power all the PMTs on and off and how to power off 
individual PMTs. 

PMTs are automatically powered on or off based on the user preferences selected 
when you open the BD FACS Sortware sorter software. Power off all the PMTs for 
maintenance purposes. 

Powering all PMTs on and To power all the PMTs on and off: 
off 

1. Click Cytometer Settings on the BD FACS Sortware toolbar. 

The Cytometer Settings pane opens. 

2. Click the Lasers/Detectors tab. 

3. Click PMT Power to turn on all the power buttons. 

PMT 
power on 

4. Click PMT Power again to turn off all the power buttons. 

PMT power off 
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Powering off individual If you do not want all PMTs on, you can selectively power off individual PMTs. 
PMTs 

To power off individual PMTs: 

1. In the Lasers/Detectors tab, click the Power button for any individual 
detectors you want to power off. 

More information � Assigning fluorochrome labels to detectors (page 121) 

� Adjusting PMT voltages and using integrators (page 125) 

Adjusting PMT voltages and using integrators 

Introduction This topic describes how to adjust PMT voltages and set laser delays using the 
Cytometer Settings pane. 

You can adjust voltages at any time. However, adjustment is typically performed 
after you create plots and are acquiring data. 

Before you begin You need to use the oscilloscope to monitor your PMT voltage gain adjustments, 
so make sure that you set up the oscilloscope display first. 

Procedure To adjust PMT voltages: 

1. Click Cytometer Settings on the BD FACS Sortware sorter software toolbar. 

The Cytometer Settings pane opens. 

2. Click the Lasers/Detectors tab. 

3. In the Detectors list, locate the detector you want to set. 

You can click +/- in the laser bar to expand or collapse the list. 
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4. Adjust the values by using the mouse scroll wheel, small arrows, data slider, 
or keyboard keys. 

See Setting numeric values in panes and dialogs (page 96) for more 
information. 

You can also use the data sliders in the plot to perform a coarse voltage 
adjustment. You need to place the mouse cursor over the plot axes to make 
the sliders visible. 

Plot axis data sliders 

5. Adjust the laser delay in the Delay field using the mouse scroll wheel, data 
slider, or keyboard keys. 

See Setting numeric values in panes and dialogs (page 96) for more 
information. 

Integrators tab Integrators are designed for use with linear events. They measure the area and the 
width of a voltage pulse for selected parameters and work in parallel with the 
height and peak measurement. You can select to enable or disable integrators as 
needed. The settings become the default but can be changed at any time. You can 
apply different integrators to different plots within the same worksheet. 
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Turning integrators on To turn the integrators on: 

1. Click the Integrators tab in the Cytometer Settings pane. 

2. Select a parameter in the ADC Intercept menu to turn the integrators on. 

3. Set the Gain to 1.0 initially and adjust as needed depending on your sample. 

Area and width for the selected parameter are now available to view in a plot. 

More information � Optical detection (page 50) 

� Cytometer settings (page 119) 

Selecting channels to capture 

Introduction This topic describes how to select channels in the Cytometer Configuration 
dialog. 

The default channel configuration enables all available channels for every sort, 
even if channels are not being used for specific samples. This results in a long list 
of available parameters for each plot. 

Select only specific channels each time you run samples to minimize the list of 
available parameters. 
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Procedure To select specific channels to capture: 

1. Select Cytometer > Configuration. 

The Cytometer Configuration dialog opens. 

2. In the Channels tab, select the appropriate checkboxes. 

� Select the Capture checkboxes only for channels that you want to capture 
with the current set of samples. 

� (Optional) Select the DC Mode checkboxes for channels when you want 
to plug an input into an ADC (other than a PMT) and use a direct current. 
When this mode is enabled, a PMT is not being used. This mode can be 
useful for some non-pulse measurements. 

3. If some integrators are turned on, click the Integrators tab and select the 
integrators that you want to capture. 

4. Click OK to apply your preferences and close the dialog. 

More information � Cytometer settings (page 119) 

� Viewing and setting cytometer details (page 129) 

� Resizing plots (page 172) 
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Viewing and setting cytometer details 

Introduction This topic describes how to open the Cytometer Details dialog to view and set 
information about the current cytometer configuration. 

This information is useful as a quick reference when multiple users work with the 
same instrument and software. This information is also displayed on the sort 
report header. You should update these values whenever you change nozzles or 
sheath pressure settings. 

Procedure To open the Cytometer Details dialog: 

1. Select Cytometer > Details. 

The Cytometer Details dialog opens. 

2. Type in the appropriate values for the cytometer configuration: 

� Diameter of the installed nozzle tip 

� Current sheath pressure 

These values are for informational purposes only. The settings are not applied 
or used in other settings or configurations, but are saved and restored with the 
workspace and cytometer settings (system settings files). 

3. Click OK to apply your preferences and close the dialog. 

More information � Cytometer settings (page 119) 

� Assigning fluorochrome labels to detectors (page 121) 



  

    

  

  

  
 

    

  

130 BD Influx User’s Guide 

Using the Compensation pane 

Introduction This topic describes the Compensation pane and related tabs and dialogs used to 
create a compensation matrix and calculate spillover values. 

About compensation To create a compensation matrix and calculate compensated values, you need to 
collect single or multicolor control data using ADCs, identify populations as 
positive or negative, and calculate the results to determine spillover values for 
each fluorochrome you plan to use. BD FACS Sortware sorter software uses the 
calculated values (matrix) and automatically applies compensation to minimize 
fluorescence spillover. 

You can view your compensated data on ADC parameters, but to sort with these 
compensated values, you need to create sort gates using DSPs as your parameters. 
Altering or applying a new compensation matrix to previously recorded files will 
not change the compensated events in the DSP parameters (including files with no 
compensation matrix defined). However, you can view alternate compensation 
with ADC parameters. 

If no compensation matrix was defined for a recorded file, all DSP parameters will 
be available to view (regardless of ADC capture status) and the DSP values for a 
given parameter will match the ADC values in the same parameter. 

DSP parameters ADC parameters 
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Once a compensation matrix is defined on the cytometer, DSP parameters in the 
subsequent recorded files will only display the compensation-defined parameters. 

Creating a compensation 
matrix 

To create a compensation matrix: 

1. Click Compensation on the BD FACS Sortware toolbar. 

The compensation matrix displays the spillover values for each compensated 
parameter. 
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2. In the Matrix tab, set the following properties. 

Properties Description 

Data Source Select a data source for compensation. 

Visualize Select this checkbox to view the software 
compensation for ADCs in the plot. 

Manage Parameters Click to display the Select Compensation Parameters 
dialog. 

Clear Click to clear the values in the compensation matrix. 

Value Manually adjust compensation values if needed. 

3. In the Auto Compensation tab, set the following properties. 

Properties Description 

Negative Select and drag, or right-click and select the ADC 
parameters that correspond to a negative control. You 
can drag a universal negative population on top of the 
negative header to populate all the negative boxes. 

Positive Select and drag, or right-click and select the ADC 
parameters that correspond to a positive control. 

Calculate Click to calculate compensation values after positive 
and negative populations have been assigned. 

More information � BD FACS Sortware overview (page 94) 
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Using the Logicle Scaling pane 

Introduction This topic describes the Logicle Scaling pane. 

Use the logicle scale after compensation has been applied to view any events with 
negative values. This is useful when evaluating the compensation matrix. 

Description After compensation, populations can include low mean values and negative 
values. Using a logarithmic scale, plots display a wide range of event data. 
However, they do not properly display events that have compensated low mean 
values, high variances, or negative values. 

Logicle scaling is only available when viewing ADC-compensated data. 

Procedure To calculate logicle display for the data: 

1. In the Compensation pane, select the data source that you want to view 
logicle scaling on (the data source must have a compensation matrix), then 
select the Visualize checkbox. 

2. In the Data Sources pane, select the data source that you want to perform 
logicle scaling on. 

3. Click Calculate Scales to calculate the logicle display for the data. 

You can adjust the R Factor (logical scale ratio) for each parameter to include 
negative or positive outliers in the plot to display data that conveys full and 
accurate information about the distributions of the events. 
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4. To view the logicle scale on a plot, select the plot and then open the Inspector 
pane. 

5.  Select the Logicle Scale field and X Parameter or Y Parameter. 

The following figure shows a plot in log scale and a plot in logicle scale. 

Log scale Logicle scale 

More information � Software overview (page 93) 

� Setting numeric values in panes and dialogs (page 96) 

� Using the Compensation pane (page 130) 
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Importing cytometer settings from BD Spigot software 

Introduction This topic describes how to import existing cytometer settings from previous 
versions of BD Spigot software using BD FACS Sortware sorter software. 

You must be running BD FACS Sortware sorter software to perform this 
procedure. 

Requirements You must have access to BD Spigot data files. 

Procedure To import cytometer settings from BD Spigot: 

1. Select Cytometer > Import Spigot Settings. 

The Select Cytometer File dialog opens. 

2. Navigate to a folder containing Spigot configuration files and select the 
desired configuration. 

Configuration files are the files that you loaded in Spigot using Open 
Experimental Setup or Open Full Configuration. 

3. Click Open. 
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The configuration file imports and sets the BD Influx electronics with the 
following settings. 

Category Details 

System settings  PMT Power 

 PMT Log Amplification Enable/Disable 

 PMT Voltage 

 Laser Delay 

 Trigger Channel 

 Trigger Threshold 

 ADC DC Mode Enable/Disable 

 ADC Laser Select 

 Integrator Baseline 

 Integrator Threshold 

 Integrator Channel 

 Integrator Gain 

Sort settings  Drop Delay 

 Stream Focus 

 Deflection Gain 

 Drop Amplitude 

 Drop Phase 

 Sort Extra Window 

 Drop Frequency 

 Sort Mode 

More information � Importing an existing BD Spigot sort device (page 209) 
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Worksheets 

This section includes these topics: 

 Worksheet overview (page 138) 

 Creating a worksheet layout (page 141) 

 Customizing worksheet properties (page 143) 

 Aligning and distributing worklist items (page 145) 

 Magnifying (scaling) analysis elements on a worksheet (page 146) 



  

 
   

  
  

138 BD Influx User’s Guide 

Worksheet overview 

Introduction This topic provides an overview of worksheet elements, layouts, and how to 
manage multiple worksheets. 

Description A worksheet contains all analysis elements including plots, gates, and statistics 
views. A new (blank) worksheet appears each time you start BD FACS Sortware 
sorter software. You can save and restore a worksheet with its analysis elements as 
an analysis template. 

Worksheet layouts A worksheet layout is created from a blank worksheet by adding plots, gates, 
population hierarchies, and statistics views that display your data. 
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Worksheet tools The Worksheet toolbar provides tools for creating plots and gates, managing 
multiple worksheets, and organizing worksheet items. 

Printing tools Worksheet and page view/control tools 

Plot/gate zoom tools Selection tools 

Plot tools Gate tools 

Alignment tools Distribution tools 

See Creating plots in a worksheet (page 162) for more information about using 
worksheet tools to create plots. See Gating overview (page 178) for more 
information about using worksheet tools to create and modify gates. 

Analysis templates You can save and restore analysis templates, and then modify the plots, 
histograms, gates, and statistics views to suit your needs. 

Worksheet pages You can create multiple pages in each worksheet and modify the size, distribution, 
alignment, magnification, and properties details of all elements on each page of a 
worksheet. 

Undo and redo functions You can undo and redo most actions (for example, adding or deleting any 
worksheet elements or changing Inspector properties) when working with the 
worksheet. 

To undo or redo an action: 

 To undo an action, press Ctrl+Z on your keyboard, or select Edit > Undo. 

 To redo an action, select Edit > Redo. 

You can perform multiple undos and redos. 

Defining a global 
worksheet 

Individual worksheet elements (plots, hierarchies, statistics views) are linked to 
one data source (cytometer for real-time data, or an FCS file). When you select Set 
Cytometer Plots/Views as Global in the Preference dialog, all worksheet elements 
with cytometer as the data source show data from a single file. Use this to quickly 
view all data from a file. 

To view live data: 

1. Select Edit > Preferences. 

2. Click the Cytometer tab. 
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3. Select the Set Cytometer Plots/Views as Global checkbox. 

4. Create plots, hierarchies, or statistics view with Cytometer selected in the 
Data Sources pane. 

With this feature, the FCS files in the Data Sources pane will have an eye icon 
beside it if the file was collected using the same configuration. The eye is an 
indicator that as the FCS file is selected, the data will show in the worksheet. 

Eye 

Note that the title of the plot is italicized. This indicates that the option is 
selected. 

If the Set Cytometer Plots/Views as Global is not selected, the plots are 
specific to the FCS file selected when drawing. 
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To change the plots to the same FCS file: 

1. Select all plots. 

2. In the Inspector pane, select the FCS file from the Source field. 

More information � Creating a worksheet layout (page 141) 

� Customizing worksheet properties (page 143) 

� Aligning and distributing worklist items (page 145) 

� Magnifying (scaling) analysis elements on a worksheet (page 146) 

� Using the Inspector to view and modify plot properties (page 163) 

Creating a worksheet layout 

Introduction This topic describes how to create a worksheet layout from a blank (default) 
worksheet. 

A blank worksheet appears in the window each time you start BD FACS Sortware 
sorter software. 

Creating a new 
worksheet layout 

To create a new worksheet layout: 

1. Add analysis elements to the worksheet: 

a. Click a plot tool on the Worksheet toolbar to add plots. 

You can add multiple plots to each worksheet. 

b. Click a gate tool on the Worksheet toolbar to add gates to the plots and 
define populations. 

c. Right-click the plot and select Statistics View to create a statistics view of 
the plot data. 
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d. Right-click the plot and select Population Hierarchy to create a population 
hierarchy of the plot data. 

Plot 

Gate 

Statistics view 

Adding pages to a To add pages to the worksheet: 
worksheet 

1. Click Add Page on the Worksheet toolbar. 

The page is added after the last page in the worksheet. 

Deleting pages from a To delete pages from a worksheet: 
worksheet 

1. In a multipage worksheet, scroll or click Go to to locate the page you want to 
delete. 

2. Right-click and select Delete Page, or press the Delete key. 

3. Click Delete Last Page on the Worksheet toolbar to delete the last page from 
the worksheet. 

Deleting analysis 
elements 

To delete analysis elements (plots, gates, histograms, statistics views) from a 
worksheet: 

1. Right-click an analysis element in the worksheet and select Delete, or press 
the Delete key. 

The analysis element is deleted. You can select multiple items at once to 
delete. 
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More information � Creating plots in a worksheet (page 162) 

� Displaying a statistics view (page 200) 

� Gating overview (page 178) 

Customizing worksheet properties 

Introduction This topic describes how to customize worksheet properties. 

Customizing worksheet To customize worksheet properties using the Inspector or the Worksheet toolbar: 
properties using the 

1. Click on a blank area of the worksheet. Inspector or the 
Worksheet toolbar 

2. Click Inspector on the BD FACS Sortware sorter software toolbar. 

The Inspector opens. 

3. Under General, select a display scale from the Scale menu. You can also use 
the toolbar to define the scale. Press Ctrl and roll the mouse wheel to adjust 
the page scaling. 

The default is 100%. 

� In the  Pages field, specify the number of pages in the worksheet. 

� Select a horizontal or vertical page layout from the Layout menu or use the 
worksheet toolbar. 

� Select True from the Grid menu to display a grid on the worksheet pages 
or select False to display the worksheet pages without a grid. You can also 
use the toolbar menu to toggle the grid on or off. 
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Customizing worksheet To customize worksheet headers and footers: 
headers and footers 

1. In the Inspector pane, click the Headers or Footers tab. 

2. Select the header and footer properties. 

� Select the Visible checkbox to display a header or footer on the worksheet. 

� Select the Border checkbox to display a border around the header or 
footer. 

� Under  Left, Center, and Right, select the elements you want to include in 
Line 1 and Line 2. You can also type in the field to enter information. 

More information � Worksheet overview (page 138) 

� Aligning and distributing worklist items (page 145) 
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Aligning and distributing worklist items 

Introduction This topic describes how to align and distribute plots, histograms, statistics, and 
other items on a worksheet. 

You can drag items to different locations within a worksheet. If you drag the item 
outside the viewing area, the viewing area automatically scrolls. 

Aligning items To align items on a worksheet: 

1. Click the item you want to use as your anchor item. 

2. Ctrl+click the other items you want to align to the anchor item. 

3. Click an alignment tool on the Worksheet toolbar (left, top, right, bottom, 
center horizontal, or center vertical). 

Distributing items To evenly distribute items on a worksheet: 

1. Click on the item you want to use as your anchor item. 

2. Ctrl+click the other items you want to distribute evenly to the anchor item. 

3. Click a distribute tool on the Worksheet toolbar. 

You can distribute selected objects horizontally, vertically, or both. 

When distributing in both directions, the selected objects are evenly spaced. 
The objects are not resized. 

More information � Worksheets (page 137) 

� Magnifying (scaling) analysis elements on a worksheet (page 146) 
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Magnifying (scaling) analysis elements on a worksheet 

Introduction This topic describes how to enlarge or shrink the size of analysis elements on the 
worksheet. 

Zooming in and out You can select an area within a plot and enlarge the image. Tick marks on the axes 
of the plot adjust to reflect the zoomed view. 

Zoom tools 

To zoom in or out: 

1. Complete one of the actions in the following table. 

You must have the plot selected to use the zoom out or clear buttons. 

To... Do this... 

Zoom in on an area in a 
plot 

1. Click Zoom In on the Worksheet toolbar. 

2. Select an area in the plot that you want to zoom in 
on using the mouse. 

Zoom out Click Zoom Out on the Worksheet toolbar. 

Clear the zoom Click Clear Zoom on the Worksheet toolbar. 

More information � Worksheet overview (page 138) 

� Creating a worksheet layout (page 141) 

� Resizing plots (page 172) 



   

  

 

  

 

13 
Acquisition and recording tools 

This software reference section describes the tools you use to select a data source, set the data recording 
details, acquire, and record. 

This section includes these topics: 

 Using the Data Sources pane (page 148) 

 Using the Recording Settings pane (page 152) 

 Using the Acquisition Dashboard (page 155) 

Other related information: 

 Alignment and QC (page 241) 

 Optimizing system settings for samples (page 263) 

 Sorting (page 283) 
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Using the Data Sources pane 

Introduction This topic describes how to use the Data Sources pane to view data and 
information from the cytometer or recorded data sources (FCS files). 

The Data Sources pane also allows you to browse and import FCS files. 

About the Data Sources 
pane 

From the Data Sources pane, you can double click the data source and open the 
following: 

 FCS keyword browser 

 Compensation matrix 

 Index sort analysis 

You can also right-click the data source in the Data Sources pane to: 

 Create sort gates 

 Save and restore compensation 

 Export BD FACSDiva™ software files 

 Export FCS files in comma separated values (CSV) format 

 Remove (delete) the data source from the Data Sources pane. 

Data sources tabs This pane has two tabs: 

 Data Sources. This tab displays a cytometer (real-time) source and the current 
FCS (recorded) file or other saved FCS files that you add to the list. BD FACS 
Sortware sorter software supports FCS v3.0 format. 

 Directory. This tab displays the directory you can use to locate recorded FCS 
data files and to select FCS files to add to the Data Sources list. 
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Selecting, importing, and 
deleting FCS files in the 
Data Sources pane 

When you first open the software or restore a settings file, Cytometer is selected as 
the default data source. At any time, one data source is always selected in the Data 
Sources pane. 

To select an FCS file as the data source: 

1. Click an FCS file in the list to display collected (recorded) data for analysis. 

FCS files only appear in the list when you record acquired data or when you 
import an FCS file. 

Importing FCS files as To import FCS files as data sources: 
data sources 

1. If the FCS file you want to use is not in the list, click the Directory tab and 
navigate to the folder that contains your FCS files. 

2. Double-click the file you want to add to the Data Sources tab. 

A disk icon appears next to FCS file added to the list. 
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3. To import multiple FCS files at the same time, select the files, right-click, and 
then select Import Data Source. 

Removing an FCS file To remove an FCS file from the Data Sources tab: 
from the Data Sources 

1. Right-click the file name and select Remove, or select the file and press the tab 
Delete key. 

Viewing data source To view data source details using the Inspector: 
details 

1. Click Inspector on the BD FACS Sortware sorter software toolbar. 

The Inspector opens in the left side of the workspace. 

2. Select the cytometer or an FCS data source in the Data Sources pane. 

The Inspector displays the data source details. 

Details for a cytometer data source Details for an FCS file data source 

Cytometer data sources details display the name, label, scale, and voltage for 
all current parameters for this cytometer. 
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FCS data source details display the name, location, and number of recorded 
events, keywords, and keyword values, and the parameter settings. The 
parameter settings are the settings used during recording. 

If you want to change the recording preferences or keywords before you 
record an FCS file, you need to use the Recording Settings pane. 

Exporting FCS files FCS files can be exported as BD FACSDiva–compatible files or as CSV files. 

To export FCS files compatible with BD FACSDiva software: 

1. In the Data Sources tab, right-click the FCS file you want to export. 

2. Select Export Diva Compatible FCS File. 

The Save Diva Compatible FCS dialog opens. 

3. Navigate to the target export folder, then click Save. 

To export FCS files in CSV file format: 

1. In the Data Sources tab, right-click the FCS file you want to export. 

2. Select Export FCS File in CSV format. 

The Save CSV File dialog opens. 

3. Navigate to the target export folder, then click Save. 

More information � Using the Recording Settings pane (page 152) 

� Using the Acquisition Dashboard (page 155) 
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Using the Recording Settings pane 

Introduction This topic describes the Recording Settings pane and how to set recording 
properties. 

Description Use the Recording Settings pane to set specific recording and keyword properties 
before you record data to set details about the FSC file that is generated during 
recording. 

This pane has two tabs. Use the Recording tab to set the default display count 
(total events to display), name the FCS file, and set the default location for the 
FCS files. Use the Keywords tab to define values for keywords in the FCS file. 

Setting recording To set recording properties: 
properties 

1. Click Recording on the BD FACS Sortware sorter software toolbar. 

The Recording Settings pane opens. 

2. Click the Recording tab. 

3. Under Display Buffer, select an event display count from the Default Display 
Count menu. 

The default display count determines the number of events to display in 
cytometer plots. You can modify the display count for individual plots in the 
Plot Properties Inspector. However, the default display count setting 
determines the maximum display count that can be selected (up to 1,000,000 
events). The default display count does not apply to plots made with existing 
FCS files. 
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4. Under FCS files, set the following properties for the FCS file that is generated 
when you record data. 

Property Description 

Path Click Path to select a storage location for the 
generated FCS file. 

Prefix Enter a prefix for the FCS files (for example, 
Presort). 

File Click File to view which FCS files have been 
recorded or to select an existing FCS file to append 
or overwrite. 

File Enter a file name for an FCS file. 

The recording progress bar appears at the bottom of the pane and displays the 
current recording progress. 

Recording progress bar 

5. Under Recording Rule, set the following properties. 

Property Description 

Event Limit Select the event limit (total events collected) as a 
stopping rule. 

Time (sec) Select the time-based stopping rule. 

Stopping Gate Select an available gate as a stopping gate. This 
indicates which gate to use to fulfill the event limit 
or time stopping rules. 

Storage Gate Select an available gate as the storage gate. Indicates 
which gated data is saved in the FCS data file. 
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Setting keyword values To set keyword values that appear in the generated FCS file: 

1. Click the Keywords tab. 

2. Enter a value for each keyword name you want to include in the generated 
FCS file. 

Viewing keywords with 
plots 

To view keywords with plots: 

1. Save an FCS file with at least one keyword. 

2. Select the FCS file in the Data Sources pane and create plots if required. 

3. Select the plots. 

4. Select the FCS keyword from the FCS Keyword menu in the Inspector pane. 

You can select only one keyword to view in the plot title. 

More information � Software overview (page 93) 

� Using the Acquisition Dashboard (page 155) 
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Using the Acquisition Dashboard 

Introduction This topic describes the Acquisition Dashboard and what data it displays. 

Description Use the Acquisition Dashboard to start or stop acquisition, record events, and 
monitor data acquisition details. The following figures show the controls and how 
they toggle between idle and acquisition modes. 

Idle 

During acquisition 

Acquisition controls The Acquisition Dashboard has the following controls. 

Control Description 

Starts acquisition and populates plots with data. During 
acquisition or recording, this button becomes the Stop button. 

Stops the current acquisition or recording. 

Clears the current acquisition data and status display. 

You can also press the F5 key to reset when acquiring with the 
cytometer selected in the data source. 

Records the current acquisition data in an FCS file. After you 
record data, the FCS file appears in the Data Sources pane. This 
button is only available after you click Acquire. 

Pauses the current acquisition or recording. This button is only 
available during acquisition or recording. 

Resumes acquisition or recording after pausing. 

Status display The Acquisition Dashboard counters are located to the right of the acquisition 
buttons. 
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The counters display the following acquisition status: 

Status Description 

Event Count Displays the total event count. 

Event Rate Displays the current event rate. 

Efficiency Displays the efficiency (accuracy) percentage of the acquisition 
(electronic aborts/total events x 100). 

Elapsed Time Displays the total elapsed time for acquisition. 

CRC Errors Indicates cyclic redundancy check (CRC) errors. CRC notes 
any errors that occur during the data transmission process. 

More information � Using the Recording Settings pane (page 152) 

� Sorting (page 283) 
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Plots 

This section includes these topics: 

 Plot overview (page 158) 

 Creating plots in a worksheet (page 162) 

 Using the Inspector to view and modify plot properties (page 163) 

 Modifying plot axis parameters (page 164) 

 Modifying dot plot properties (page 166) 

 Modifying density plot properties (page 166) 

 Modifying contour plot properties (page 168) 

 Modifying histogram properties (page 169) 

 Creating histogram overlays (page 170) 

 Resizing plots (page 172) 

 Resizing plots (page 172) 

 Saving plots as images (page 174) 

 Copying and duplicating plots (page 174) 
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Plot overview 

Introduction This topic describes the types of plots you can create and the color display 
options. 

Dot plots Dot plots display two-parameter data. Each dot in a dot plot represents one or 
more events. The dot location is defined by two values, one for each parameter. 

Density plots Density plots display simulated three-dimensional events. They are similar to dot 
plots except that they use different colors to show the number of events. The 
position of each event on the X and Y axes reflects its parameter values. The color 
shows how many events fall at each position. 
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Contour plots Contour plots are graphical representations of two-parameter data in which 
contour lines show the distribution of events. Similar to a topographical map, 
contour lines show event frequencies as peaks and valleys. 

Histograms Histograms are graphical representations of a single parameter of data. The 
horizontal axis of the graph represents the signal intensity of the parameter, and 
the vertical axis represents the number of events (counts) or percentage of events. 

Plot overlays Plot overlays display gated populations or All Events of two or more FCS files (or 
the cytometer) as histogram layers. This allows for direct comparison of events. 
Plot overlays are available only with histograms. 



  

  
 

   
   

     

 

    

   

160 BD Influx User’s Guide 

The following example shows a stained sample from a recorded FCS file (green) 
layered on an unstained sample from the cytometer (black). 

Cytometer plot with a 
target source 

You can add a target source to a cytometer plot to compare live data to a specific 
target FCS file with the same parameters and sample type. The targets can provide 
an acceptable range of data or specific event clusters that you want to 
approximate with live data. The target source appears in gray as an overlay 
(bottom layer) in the plot. This is particularly useful for QC. Target sources are 
available only with cytometer dot plots. 

The following figure shows live (black) events on top of FCS (gray) target events. 

Dot plot and histogram 
color display 

Dot plots display all events as black dots by default. Gated populations in the dot 
plot appear in different colors. You can modify the color of the events in the 
Inspector pane or select different default colors in the Edit User Preference dialog. 

Histograms display all events as black lines or filled areas by default. You can 
modify the color of the events and overlay events in the Histogram properties. 

Density and contour plot 
color display 

Density and contour plots use the following color type options: 

 Single color. The lowest level is the original population color and the colors 
fade toward white as levels increase. 
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 Multiple colors. The color shows how many events fall at each position by 
using a different color for each level. Colors range from dark blue 
(representing the lowest number of events) through the spectrum to red 
(representing the highest number). 

 Gray scale. Displays darker gray at lower levels and fades to white as the 
levels rise. 

More information � Creating plots in a worksheet (page 162) 

� Modifying dot plot properties (page 166) 

� Creating histogram overlays (page 170) 

� Modifying density plot properties (page 166) 

� Modifying contour plot properties (page 168) 
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Creating plots in a worksheet 

Introduction This topic describes how to create plots using the plot tools on the Worksheet 
toolbar. All plot types use the same procedure. 

Procedure To create plots: 

1. Open a worksheet or restore an analysis template. 

2. Click a plot tool on the Worksheet toolbar. 

Dot plot Contour plot 

Density plot Histogram plot 

3. Add the plot to the worksheet by doing one of the following: 

� To insert a new plot using the default size, click on the worksheet. 

� To draw a plot of any size, drag on the worksheet. 

� To move a plot, click and drag the plot. 

� To make the plot tool sticky, double-click it. This allows you to create 
many plots quickly on a worksheet. 

� To unstick the plot tool, click a different worksheet tool. 

More information � Plot overview (page 158) 

� Creating a worksheet layout (page 141) 

� Modifying dot plot properties (page 166) 



   

   
   

  
  

  
 

 

  

 

 

 

163 Chapter 14: Plots 

Using the Inspector to view and modify plot properties 

Introduction This topic describes how to use the Inspector to view and modify plot and 
parameter properties after you create a plot. 

Description You can click a plot on a worksheet to display plot properties in the Inspector 
pane. Use the Plot Properties tab to modify the plot title, type, source, and X/Y 
parameters and scales. 

Guidelines  The axis parameter name includes the measurement type. 

 If you select Cytometer as the data source, you can manually assign x- and y-
axis parameters to plots from a list of available parameters. 

 If you select an FCS file as the data source, the parameter names come from 
the FCS file, and labels are not applied unless they are in the FCS file. 

 If you select multiple plots on a worksheet, the parameter list includes the 
common parameter names and labels for each selected plot. 

Modifying plot and To modify plot and parameter properties: 
parameter properties 

1. Click Inspector on the BD FACS Sortware sorter software toolbar. 

The Inspector opens. 

2. Click a plot on the worksheet. 

3. In the Inspector, click the Plot Properties tab. 
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4. Set the following properties under General as needed. 

Property Action 

Title Enter a name for the plot. If this field is blank, the title 
defaults to the FCS file name. 

Plot Type Select a different plot type. 

Source Select cytometer or an FCS file data source for the 
plot. 

Display Count Select the maximum number of events to display. 

The default for cytometer plots is the Default Display 
Count in the Recording Settings pane. The default for 
FCS file plots is the total number of events in the file. 

5. Set the following properties under X Parameter as needed. 

Property Action 

Parameter Select an x-axis parameter for the plot. 

Scale Select linear, log, or logicle (biexponential) scale. 
Different parameters will have different scales 
available to them. 

6. Set the following properties under Y Parameter as needed. 

Property Action 

Parameter Select a y-axis parameter for this plot. 

Scale Select linear, log, or logicle (biexponential) scale. 
Different parameters will have different scales 
available to them. 

Modifying plot axis parameters 

Introduction This topic describes how to modify the axis parameters for existing plots. 

Modifying plot axis To modify the plot axis parameters in a plot: 
parameters in a plot 

1. In a worksheet, right-click on an x or y parameter label in a plot and select a 
parameter subgroup from the menu. 
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2. Select a parameter. 

Parameter type Description 

ADC Includes all available detectors for raw data collection. 

DSP Includes all available detectors for compensated data 
collection. 

Integrators The Integrators subgroup is only available if 
integrators are turned on for real-time data (or 
integrators were recorded for FCS files). Integrators 
are available for FSC, SSC, and any ADC parameter. 

 Measures the area. 

 Measures pulse width at threshold. 

Others  Trigger Pulse Width. Signal width of the pulse 
above the threshold. 

 Time. Time stamp that occurs every 100 ms. 

 ROI Bits 1-16. Bits 1–16 of the 32-bit field. 
Computed results from lookup tables, one bit per 
ROI (high = in, low = out). 

 ROI Bits 17-32. Bits 17–32 of the 32-bit field. 

 Classifier Bits. Result from classification hardware 
based on lookup tables, one bit per sort direction. 

 Sort Enable Bits. Includes information about sort 
decisions and counters associated with a sort 
direction. 

 Drop Phase. Measured location of an event center 
within the drop phase and distances out to 4 drops 
to the nearest events before and after, in 1/16 of a 
drop. 

More information � Setting plot display preferences (page 110) 

� Viewing cytometer status (page 121) 

� Adjusting PMT voltages and using integrators (page 125) 

� Creating plots in a worksheet (page 162) 

� Modifying dot plot properties (page 166) 

� Resizing plots (page 172) 
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Modifying dot plot properties 

Introduction This topic describes how to modify dot plot properties using the Inspector pane. 

You can also modify the plot display preferences using the Edit User Preferences 
dialog. 

Procedure To modify dot plot display properties: 

1. In the Inspector, click the Dot Plot(s) tab. 

2. Set the following properties under General as needed. 

Property Action 

Dot Size Select a small, medium, or large dot size to represent 
events in the plot. 

Target Source Select an available FCS file as the target source. See 
Plot overview (page 158) for more information about 
plots using a target source. 

More information � Setting plot display preferences (page 110) 

� Setting statistics views display preferences (page 111) 

Modifying density plot properties 

Introduction This topic describes how to modify density plots using the Inspector pane. 

You can also modify the plot display preferences using the Edit User Preferences 
dialog. 

Modifying density plot To modify density plot display properties: 
display properties 

1. In the Inspector, click the Density Plot(s) tab. 

2. Set the following properties under General as needed. 

Property Action 

Dot Size Select a small, medium, or large dot size to represent 
events in the plot. 

Color Type Select a color scheme for the event data. 

Percentage Type a percentage or use the data slider. This value 
determines the peak height and spacing between 
density levels. 
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Property Action 

Scale Mode Select a linear, probability density, or logarithmic 
scale. 

Show Density Lines Select True to outline the density area or select False 
for no outlines. 

Show Outliers Select True to show outliers (events that are below the 
lowest level) or select False to hide outliers. 

3. Set the following properties under Resolution as needed. 

Property Action 

Analysis Select a display resolution for analysis. 

Acquisition Select a display resolution for acquisition. 

4. Set the following properties under Smoother as needed. 

Property Action 

Is Smooth Select True to enable smoothing or select False to 
disable smoothing. 

Smooth Edges Select True to enable smoothing or select False to 
disable the smoothing of the edge. 

Kernel Size Select a kernel size of 3, 5, or 7. 

Smoothing Select a smoothing level. 

The density plot is drawn without smoothed data by default. Smoothing data 
does not affect the calculation of statistics or the display of outliers. 

More information � Setting plot display preferences (page 110) 

� Setting statistics views display preferences (page 111) 
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Modifying contour plot properties 

Introduction This topic describes how to modify contour plots using the Inspector pane. 

You can also modify the plot display preferences using the Edit User Preferences 
dialog. 

Modifying contour plot To modify contour plot display properties: 
display properties 

1. In the Inspector, click the Contour Plot(s) tab. 

2. Set the following properties under General as needed. 

Property Action 

Dot Size Select a small, medium, or large dot size to represent 
events in the plot. 

Color Type Select a color scheme for the event data. 

Percentage Type a percentage or use the data slider. This value 
determines the peak height and spacing between 
contour levels. 

Scale Mode Select a linear, probability density, or logarithmic 
scale. 

Fill Contour Select True to fill the contour area or select False to 
leave the contour area empty. 

Show Contour Lines Select True to outline the contour area or select False 
for no outlines. 

Contour Lines Colored Select True to color the contour area or select False for 
no color. 

Show Outliers Select True to show outliers (events that are below the 
lowest level) or select False to hide outliers. 

3. Set the following properties under Resolution as needed. 

Property Action 

Analysis Select a display resolution for analysis. 

Acquisition Select a display resolution for acquisition. 

4. Set the following properties under Smoother as needed. 

Property Action 

Is Smooth Select True to enable smoothing or select False to 
disable smoothing. 

Smooth Edges Select True to enable edge smoothing or select False to 
disable edge smoothing. 

Kernel Size Select a kernel size of 3, 5, or 7. 

Smoothing Select a smoothing level. 
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The contour plot is drawn without smoothed data by default. Smoothing data 
does not affect the calculation of statistics or the display of outliers. 

More information � Setting plot display preferences (page 110) 

� Setting statistics views display preferences (page 111) 

Modifying histogram properties 

Introduction This topic describes how to modify histograms using the Inspector pane. 

You can also modify the plot display preferences using the Edit User Preferences 
dialog. 

Modifying histogram To modify histogram display properties: 
display properties 

1. In the Inspector, click the Histogram Plot(s) tab. 

2. Set the following properties under General as needed. 

Property Action 

Draw Curve Select True to draw curves between data points on the 
histogram or select False to draw vertical bars of data. 

Fill Histogram Select True to fill the histogram area or select False to 
leave the histogram area empty. 

Y Axis Scale Select linear, logarithmic, percent, or normalized 
percent. 

Y Axis Max Select or type in a Y axis maximum value or select 
Calculated for an auto-calculated scaling. 

Overlays Select True to enable an overlay or False to disable an 
overlay. 

3. Set the following properties under Resolution as needed. 

Property Action 

Analysis Select a display resolution for analysis. 

Acquisition Select a display resolution for acquisition. 

4. Set the following properties under Smoother as needed. 

Property Action 

Is Smooth Select True to enable smoothing or select False to 
disable smoothing. 
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Property Action 

Smooth Edges Select True to enable edge smoothing or select False to 
disable edge smoothing. 

Kernel Size Select a kernel size of 3, 5, or 7. 

Smoothing Select a smoothing level. 

The histogram is drawn without smoothed data by default. Smoothing data 
does not affect the calculation of statistics or the display of outliers. 

More information � Setting plot display preferences (page 110) 

Creating histogram overlays 

Introduction This topic describes how to create overlays on a histogram using the Inspector 
pane. 

Before you begin  Create a histogram on a worksheet and open the Inspector pane. 

 If you want to make an overlay that includes the cytometer, the original 
histogram needs to have the cytometer as its data source. 

 You need to have at least one FCS file in the Data Sources pane to create an 
overlay. 

Procedure To create overlays: 

1. Click a histogram on the worksheet. 

2. In the Inspector pane, click the Histogram Plot(s) tab. 
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3. In the Overlays menu, select True. 

The Overlays tab appears. 

4. Click Overlays and select the FCS files to overlay. 
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5. Select the population that you want to overlay and the color of each overlay. 

More information � Creating plots in a worksheet (page 162) 

� Resizing plots (page 172) 

Resizing plots 

Introduction This topic describes how to resize plots. 

You can manually resize plots and plot events to any size within the worksheet, or 
expand, collapse, or reshape them based on predefined increments. 

Manually resizing a plot To manually resize a plot: 

1. Click on a plot in the worksheet. 

The plot frame and sizing handles are enabled. 
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2. Drag a handle to size the plot by doing one of the following: 

� To proportionally size the plot, drag a corner handle in or out. 

� To stretch the plot in a specific direction, drag a top, bottom, left, or right 
handle. 

Proportionally resizing To proportionally resize multiple plots (simultaneously): 
multiple plots 

1. Click on the first plot you want to resize. 

2. Press Ctrl and click on all other plots you want to resize. 

The plot frames and sizing handles are enabled. 

3. Drag a handle to size the plots by doing one of the following: 

� To proportionally size the plot, drag a corner handle in or out. 

� To stretch the plot in a specific direction, drag a top, bottom, left or right 
handle. 

Additional ways of Here are some additional ways of resizing a plot. 
resizing a plot 

Method Procedure 

To expand a single plot 
by predefined increments 

Right-click the plot and select Resize Plot > Expand. 

To contract (collapse) a 
single plot by predefined 
increments 

Right-click a plot and select Resize Plot > Contract. 

To make a plot square 
(reshape a modified plot) 

Right-click a plot and select Resize Plot > Make 
Square. 

More information � Magnifying (scaling) analysis elements on a worksheet (page 146) 
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Saving plots as images 

Introduction This topic describes how to save a plot as a PNG image file. 

Procedure To save a plot as an image file: 

1. In a worksheet, right-click a plot and select Save As. 

The Save as PNG image dialog opens. 

2. Navigate to a target folder. 

3. In the File name field, type a name for the image. 

4. Click Save. 

More information � Copying and duplicating plots (page 174) 

Copying and duplicating plots 

Introduction This topic describes how to copy and paste plots into third-party software as an 
editable metafile, and how to duplicate plots within a worksheet. 

About copying and 
pasting plots 

You can copy plots and associated metadata from a worksheet and paste them 
into third-party software (for example, Microsoft Word®, PowerPoint®). After 
you paste the plot, you can modify the plot name, axis labels, font, graphic border 
colors and thickness, and delete elements from the image. 

The following example describes how to copy and paste into a Microsoft 
PowerPoint slide. 

Copying and pasting To copy and paste a plot and the associated metadata into third-party software: 
plots into third-party 

1. Right-click a plot and select Copy.software 

2. Open Microsoft PowerPoint and click on the target slide. 

3. Select Edit > Paste Special > Picture (Enhanced Metafile). 

4. Click OK. 

The plot appears on the PowerPoint slide. The image pastes as a single, 
grouped object. If you want to modify the image, right-click the image and 
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select Grouping > Ungroup. Once the element you want to modify is 
ungrouped, you can customize the image. 

Copied plot before modifications Copied plot after ungrouping and modifications 

Duplicating plots To create an exact duplicate of a plot within a worksheet: 

1. Right-click the plot and select Duplicate. 

A duplicate plot appears. 

More information � Setting plot display preferences (page 110) 
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Gates and populations 

This section includes these topics: 

 Gating overview (page 178) 

 Using the Gate Hierarchy pane (page 180) 

 Viewing the population hierarchy (page 184) 

 Creating rectangle gates (page 187) 

 Creating polygon gates (page 188) 

 Creating ellipse gates (page 189) 

 Creating contour gates (page 190) 

 Creating interval gates (page 192) 

 Creating quadrant gates (page 193) 

 Working with gates (page 194) 

 Converting global and local gates (page 197) 

 Displaying a statistics view (page 200) 
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Gating overview 

Introduction This topic describes the gating tools you can use to create gates and define 
populations. 

Gating allows you to identify events of interest, classify events in populations, 
display them in plots, and calculate population statistics for display as statistics 
views. Gates are organized in a gate hierarchy based on parent and child 
(subpopulation) relationships. 

Types of gates You can draw the following types of gates on a plot: 

 Rectangle 

 Polygon 

 Ellipse 

 Contour 

 Quadrant (Quad) 

 Interval 

About drawing gates  The minimum and maximum size of a gate is determined by the size of the 
plot. 

 You cannot drag the vertex outside the plot. 

 All gate types can be used for sorting. 

Gate and population 
hierarchies and statistics 
view 

A population is a gated set of data. Populations can be viewed in the Gate 
Hierarchy pane, population hierarchy, or statistics view. Population hierarchies 
and statistics views are elements in a worksheet. 

Populations are assigned in the hierarchy based on the selected plot. When you 
draw a gate on a plot, the population is identified by a population number and a 
color. You can define default colors and names for each population in the Edit 
User Preferences dialog. 
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Comparison between The following figures are examples of a gate hierarchy, population hierarchy, and 
gate hierarchies, statistics view. 
population hierarchies, 
and statistics views 

Gate hierarchy 

Population hierarchy 

Statistics view 

The following table describes the similarities and differences in displays and 
actions of the Gate Hierarchy pane, population hierarchy, and statistics view. 

Displays and actions 
Gate 
hierarchy 

Population 
hierarchy 

Statistics 
view 

Displays the hierarchical relationship of 
gated populations 

Yes Yes Yes 

Interacts with the Inspector pane to 
modify gate name or color 

Yes Yes Yes 

Allows manipulation of parent/child 
populations by drag and drop 

Yes Yes No 

Allows drag and drop of populations in 
Compensation or Sort Layout panes 

Yes Yes No 

Allows creation of Sort Abort or NOT 
gates 

Yes Yes No 

Controls the show/hide display of gates 
and populations 

Yes No No 

Displays and allows the manipulation of 
global or local status 

Yes No No 
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Displays and actions 
Gate 
hierarchy 

Population 
hierarchy 

Statistics 
view 

Allows creation of AND or OR gates No Yes No 

Displays limited number of statistical 
details about selected populations 

No Yes No 

Displays broad choice of statistical details 
about selected populations and 
parameters 

No No Yes 

More information � Editing user preferences (page 105) 

� Setting gate and population display preferences (page 108) 

� Viewing the population hierarchy (page 184) 

Using the Gate Hierarchy pane 

Introduction This topic describes how to open and use the Gate Hierarchy pane to view and 
manipulate the relationship of populations, and show and hide populations. 

Opening the Gate 
Hierarchy pane 

To open the Gate Hierarchy pane: 

1. On the BD FACS Sortware sorter software toolbar, click Gates to display the 
hierarchy (tree) of the gates in an active plot. 

The Gate Hierarchy pane opens. The gate hierarchy corresponds to gates in 
the plot. 

The gate hierarchy corresponds to gates in the selected plots, population 
hierarchy, statistics view, or data source. When a data source, population 
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hierarchy, or statistics view is selected, the gate hierarchy displays only the 
global/local status. 

When a plot is selected, the Gate Hierarchy pane displays the population and 
gate frame controllers as well as the global/local status. 

Showing or hiding 
populations 

To show or hide populations in a plot: 

1. Click on a plot with gated populations. 

2. In the Gate Hierarchy pane, click the Show/Hide icon for the population you 
want to show or hide. 
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Showing or hiding gates To show or hide gates (gate frames) in a plot: 
(gate frames) 

1. In the Gate Hierarchy pane, click the Show/Hide icon for the gate you want 
to show or hide in the plot. 

Shown gate 

Hidden gate 

Creating Boolean gates To create Boolean gates using the Gate Hierarchy pane: 
using the Gate Hierarchy 

1. In the Gate Hierarchy pane, right-click a population. pane 

2. Select Create Gate, then select a Boolean gate type: (NOT) or Sort Aborts. 
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The new gate appears. In the following figure, the NOT events appear as the 
new population color. 

More information � Viewing the population hierarchy (page 184) 

� Converting global and local gates (page 197) 
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Viewing the population hierarchy 

Introduction This topic describes how to view population hierarchy information using the 
population hierarchy and the Inspector. 

Population hierarchy A population hierarchy view can display the following: 
components 

 Events 

 %Total 

 %Parent 

 %Grandparent 

Displaying a population To display a population hierarchy: 
hierarchy 

1. Right-click a plot and select Population Hierarchy. 

The population hierarchy appears. 

Modifying the population To modify the population hierarchy: 
hierarchy 

1. In the worksheet, click the header of the population hierarchy. 
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2. The Inspector refreshes and displays the Population Hierarchy tab. 

3. Select an FCS file as a data source if needed. 

4. Under Formulas, select the checkboxes for the statistical categories you want 
to include in the population hierarchy. 

5. Under Format, change the value in the Decimal field to change significant 
figures for the numbers displayed. 

Creating Boolean gates To create Boolean gates using the population hierarchy: 
using the population 

1. In the population hierarchy, right-click one or more populations. hierarchy 

2. Select Create Gate, then select a Boolean gate type (AND, OR, NOT) or Sort 
Aborts. 



 
 

 
 

 

186 BD Influx User’s Guide 

The new gate appears. In the following figure, the NOT events appear as the 
new population color. 

Deleting a population To delete a population hierarchy from a worksheet: 
hierarchy 

1. Right-click on the header of the population hierarchy in the worksheet and 
select Delete. 

More information � Using the Gate Hierarchy pane (page 180) 

� Creating rectangle gates (page 187) 
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Creating rectangle gates 

Introduction This topic describes how to create rectangle gates. You can draw a rectangle gate 
on a dot, density, or contour plots. 

Procedure To create a rectangular gate: 

1. Click the Rectangle gate tool on the Worksheet toolbar. 

2. Click inside a plot to position the first corner, then drag diagonally to the 
opposite corner point, then release the mouse button to set the gate. 

The Gate Hierarchy pane updates to include the new gated population. 

More information � Using the Gate Hierarchy pane (page 180) 

� Creating polygon gates (page 188) 
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Creating polygon gates 

Introduction This topic describes how to create polygon gates. 

You can draw a polygon gate on dot, density, or contour plots. 

Limitations Polygon gates require a minimum of 3 vertices and allow a maximum of 40. 

Procedure To create a polygon gate: 

1. Click the Polygon gate tool on the Worksheet toolbar. 

2. Click inside a plot to position the first vertex, then click to position each 
vertex. 

3. Double-click to complete the polygon to close the gate. 

This draws lines between vertices and creates the polygon shape. 

The Gate Hierarchy pane updates to include the new gated population. 

More information � Creating rectangle gates (page 187) 

� Creating ellipse gates (page 189) 
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Creating ellipse gates 

Introduction This topic describes how to create ellipse gates. 

You can draw an elliptical gate on dot, density, or contour plots. 

Procedure To create an ellipse gate: 

1. Click the Ellipse gate tool on the Worksheet toolbar. 

2. Click on a plot, then drag the cursor to create an ellipse of the desired shape. 
Release the mouse button to set the gate. 

The Gate Hierarchy pane updates to include the new gated population. 

More information � Creating polygon gates (page 188) 

� Creating contour gates (page 190) 
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Creating contour gates 

Introduction This topic describes how to view contour levels and create contour gates. 

You can only draw a contour gate on a contour plot. 

Viewing contour levels To view contour levels: 

1. Move the mouse cursor over any population (contour level) in the plot to 
display a data box. 

The following figure shows a contour plot and the data box for the contour 
level (in zoom view). 

Creating contour gates To create a contour gate: 

1. Click the Contour gate tool on the Worksheet toolbar. 

2. Click the population to automatically set a gate on the population (contour 
level). 
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The Gate Hierarchy pane updates to include the new gated population. 

More information � Creating polygon gates (page 188) 

� Creating interval gates (page 192) 
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Creating interval gates 

Introduction This topic describes how to create an interval gate. 

Intervals gates are gates between left and right endpoints on the horizontal axis. 
You can only draw an interval gate on a histogram. 

Procedure To create an interval gate: 

1. Click the Interval Gate tool on the Worksheet toolbar. 

2. Click in the plot to set the start point (right or left), drag horizontally, then 
release the mouse button to set an end point (right or left). 

The Gate Hierarchy pane updates to include the new gated population. 

More information � Creating ellipse gates (page 189) 

� Creating quadrant gates (page 193) 
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Creating quadrant gates 

Introduction This topic describes how to create quadrant (quad) gates. You can draw a 
quadrant gate on dot, density, or contour plots. 

Quad gates divide a plot into four quadrants. Each quadrant has its own 
population statistics. You can name and color the population in each quadrant 
individually. 

Procedure To create a quadrant gate: 

1. Click the Quadrant Gate tool on the Worksheet toolbar. 

2. Click in the plot to position the quadrant intersection point. 

Intersection point 

The Gate Hierarchy pane updates to include the new gated population. 

More information � Creating interval gates (page 192) 

� Converting global and local gates (page 197) 
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Working with gates 

Introduction This topic describes how to modify gate names and colors and manipulate the 
gate size and display. 

This topic also describes how to reprioritize gated populations and how to delete 
gates in a plot. 

Changing the hierarchical To change the hierarchical position of gates: 
position of gates 

1. In the Gate Hierarchy pane, click and drag a gate to the new desired parent. 

In this example, the P3 gate is now a child of P2. You can also perform the 
same action using the population hierarchy. 

Renaming gates Names are unique to gates. You cannot use the same name for two different gates. 
You cannot rename all events. 

To rename a gate: 

1. In the Gate Hierarchy pane, click a population. 

Alternatively, click a gate in a plot. 

2. In the Inspector, in the Name field, type a name for the gate (for example, 
Positive). 
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The new gate name appears in the Gate Hierarchy pane and in the plot. 

Changing a gate color This procedure only affects the color of individual gates (global or local). To set 
the default preferences for all gates, use the Edit Preferences dialog. Colors are 
unique to gates. You cannot use the same color for two different gates. 

To change a gate color: 

1. In the Gate Hierarchy pane, click a population. 

Alternatively, click a gate in a plot. 

2. In the Inspector, right-click the color box to display a color picker, then select 
a color. 

The new gate color appears in the Gate Hierarchy pane and in the plot. 

Resizing gates To resize an existing gate: 
proportionately 

1. Click a gate in a plot. 

The outline and handles are enabled. 
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2. Drag a corner handle in or out to resize the gate. 

If the gate is too small to view or drag a handle, zoom in on the gate, then 
resize it. 

Resizing gates using To resize gates using vertices: 
vertices 

1. Double-click a gate. 

2. Move cursor over a vertex. 

The cursor will show cross hairs. 

3. Click and move the vertex to desired location. 

Rotating gates To rotate a gate: 

1. Click a gate in a plot. 

The outline and handles are enabled. 

2. Move the cursor over a corner handle to display a rotation handle. 

3. Click and drag the rotation handle to the right or left to rotate the gate. 

Prioritizing gated 
populations in plots 

You can prioritize the gate display in a plot and move gated populations forward 
or backward in the display. 

To prioritize the gate display: 

 To move a gate back in the display, right-click the gate, select Send to Back, 
then select the population you want to move. 

 To move a gate forward in the display, right-click the gate, select Bring 
Forward, then select the population you want to move. 

Deleting gates To delete a gate in a plot: 

1. Right-click a gate in a plot and select Delete. 

Alternatively, click the gate in a plot and press Delete on your keyboard. 

To delete a gate in the Gate Hierarchy pane or Population Hierarchy view: 

1. Right-click the population and select Delete. 

Alternatively, click the population and press Delete on your keyboard. 

More information � Setting gate and population display preferences (page 108) 

� Viewing the population hierarchy (page 184) 

� Converting global and local gates (page 197) 
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Converting global and local gates 

Introduction This topic describes how to convert gates from global to local and from local to 
global. 

About global and local 
gates 

 Global gates. By default, when you create a new gate in a plot, the gate is 
global. Global gates are indicated by a G in the Gate Hierarchy pane. These 
gates apply to all the cytometer FCS files imported in the Data Sources pane 
that use the same plot parameters. 

 Local gates. You can make global gates unique by converting them to local 
gates. Local gates are indicated by an L in the Gate Hierarchy pane. These 
gates only apply to a specific data source. When a gate is converted from 
global to local, the original global gate remains on all other data sources. This 
allows you to change the position, color, shape, and name of a local gate 
without affecting the corresponding global gate on other data sources. 

Rules for converting 
gates 

The following rules apply when you convert a global gate to a local gate or a local 
gate to a global gate: 

 If a global gate has child gates and is converted to local, all child gates will 
also be converted to local gates. 

 Gates created with a local gate as a parent will be local (including Boolean 
gates). 

 You cannot drag a global gate onto a local gate. 

 Gates converted from global to local retain a link to their original global gate. 
When a local gate is converted back to global, it will update (overwrite) the 
original global gate with the local gate's position, size, name, and color. 
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In this example, the global red P1 gate was converted to a local gate in the 
data source Cells Unstain. The gate was moved and renamed Monocytes. 

The local gate Monocytes was converted back to global. The P1 gate was 
overwritten with the Monocytes gate properties. 

 If a local gate was created without a link to a global gate (for example, you 
created a child of a local gate), the gate name must be unique in order to 
convert to global. 

 If a local gate is converted to global and has child gates, the child gates will 
also be converted to global. 

 You cannot convert a local gate to global if its parent gate is local. 
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 Sort gates are always local gates (you cannot convert them to global). 

 You cannot convert a global gate to a local or a local gate to global if Boolean 
or Sort Abort gates are dependent on those gates. 

 You cannot convert the global/local status of Boolean or Sort Abort gates. 

Converting a global gate To convert a global gate into a local gate: 
into a local gate 

1. Right-click a gate in the Gate Hierarchy pane and select Convert to Local. 

Alternatively, right-click a gate in a plot and select Convert to Local. 

Converting a local gate 
into a global gates 

You can convert a local gate (in one data source) into a global gate (for all data 
sources with matching parameters). 

To convert a local gate to a global gate: 

1. Right-click a gate in the Gate Hierarchy pane and select Convert to Global. 

Alternatively, right-click a gate in a plot and select Convert to Global. 

The gate is now associated to all plots with matching parameters. 

More information � Gating overview (page 178) 
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Displaying a statistics view 

Introduction This topic describes how to display a statistics view for a plot in a worksheet. 

Default statistics view 
components 

The default statistics view displays the following: 

 Population 

 Events 

 %Total 

 %Parent 

 X-axis parameter mean events 

 Y-axis parameter mean events 

Displaying statistics for a To display a statistics view for a plot: 
plot 

1. In a worksheet, right-click a plot and select Statistics View. 

A statistics view appears. 

If your plot does not have gates, only data for All Events appears. 

If your plot has gates and defined populations, the data for each population 
and All Events appear in their hierarchical order. 

Editing the statistics view To edit statistics view: 

1. Click the header of the statistics view. 

2. In the Inspector pane, change the data source (if needed) and click Edit 
Statistics View. 
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The Edit Statistics View dialog opens. 

3. Use the tabs in this dialog to edit the population, parameters, percentiles, and 
decimal values. 

4. Click OK to apply changes. 

Moving a statistics view To move a statistics view within a worksheet: 

1. Click the header of the statistics view and drag it. 

Deleting a statistics view To delete a statistics view from the worksheet: 

1. Right-click the header of a statistics view box and select Delete. 

More information � Converting global and local gates (page 197) 
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Sort settings and layout 

This section includes these topics: 

 Using the Sort Settings pane (page 204) 

 Sort modes (page 205) 

 Creating a user-defined sort mode (page 207) 

 Importing an existing BD Spigot sort device (page 209) 

 Using the Tray Control pane (page 210) 

 Creating a new sort device (page 212) 

 Modifying an existing sort device (page 214) 

 Deleting sort devices (page 216) 

 Using the Sort Layout pane (page 217) 

 Controlling the sort tray position (page 219) 
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Using the Sort Settings pane 

Introduction This topic describes the Sort Settings pane and the different functions it provides. 

Description Use this pane to set the drop formation, delay, breakoff, and deflection 
parameters. You also use this pane to select a sort mode. 

This pane includes the following tools. 

Tool Description 

Drop Formation Contains controls for determining the stream breakoff. 

Stream Contains controls for optimizing the side streams. 

Stream Deflection Contains controls for adjusting of the side streams 
individually. 

Sort Mode and Settings Shows the representation of each sort mode. 

Delay Calculator Contains fields used to calculate the approximate drop 
delay. 

More information � Sort modes (page 205) 
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Sort modes 

Introduction This topic describes the different sort mode drop count options and describes 
phase gates and coincidence. 

About sort mode drop When you select a sort mode, you need to decide on a drop count. The following 
count table describes each drop count option. 

Drop count Description 

1.0 or 2.0 drops Use 1.0 or 2.0 drops when the exact count of a sort is important. 
For example, when you are sorting one particle into each of 96 
wells, the position of the particle inside the droplet must be within 
the boundary of the droplet. 

Particles that are too close to the droplet boundaries might end up 
in either droplet, and empty droplets might inadvertently be sorted. 

1.5 drop This sort mode sorts two drops when one particle is on a droplet 
boundary and one particle is in the center of a drop. This ensures 
an accurate sort count. 

Drop count attributes Each drop count is paired with one of the following attributes. 

Drop 
attribute Description 

Enrich The purity of a sort with coincidence disabled is completely 
determined by the sample-to-droplet rate ratio and might be 
compromised at high sample rates. 

This mode is most often used for collecting rare populations when sort 
yield is more important than purity. 

This mode provides low throughput, lower purity, high yield, and high 
recovery. 

Pure This is the number of particles sorted out of the number requested to 
be sorted. 

Use this setting when sample rates are low compared to droplet rates, 
and when the count of the sorted particles is important. 

This mode is used for single-cell sorting into multiwell plates, and is 
useful when sorting large particles. 

This mode provides low throughput, high purity, lower yield, and high 
recovery. 
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Drop 
attribute Description 

Single This setting is available for the 1.0 drop mode only. It applies a phase 
gate that allows only particles in the center of droplets to be sorted. 

This is useful when recovery of large particles (greater than ¼ of the 
nozzle diameter) is important. Large particles near droplet boundaries 
cause problems in the breakoff point and can cause sort streams to 
spray. 

This mode provides high purity, lower yield, and higher recovery for 
large particles. 

Yield This is the number of desired particles sorted out of the total number 
of desired particles in the entire sample aliquot. 

Use this setting when sample rates are high compared to droplet rates, 
and when the count (recovery) of the sorted particles is less important. 

This mode provides high throughput, high purity, high yield, and 
lower recovery. 

Recovery This is the number of cells sorted out of the final sort counter of the 
instrument. Use this setting for higher recovery of sorted particles. 

Phase gates and 
coincidence 

When selecting a pre-defined sort mode or creating a user-defined sort mode, 
consider both the position of particles inside droplets and coincident particles. 

 Phase gates. Allow you to sort only particles that are in a certain position in 
the droplet, such as the middle. 

Individual phase gates (blue) 

You can click to select individual phase gates in the Phase Mask area of the 
coincidence scale. 

 Coincidence. This occurs when two or more particles are closer than the 
spacing of the droplets. This results in more than one particle in a droplet. 
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Coincidence is higher when sample rates are higher and when droplet rates 
are lower. 

Individual coincidence particles (red) 

To increase throughput or sort with additional particles, click to add extra 
coincidence in the Extra Coincidence area of the coincidence scale. 

More information � Selecting a pre-defined sort mode (page 287) 

� Creating a user-defined sort mode (page 207) 

Creating a user-defined sort mode 

Introduction This topic describes how to create a user-defined sort mode. 

Procedure To create a user-defined sort mode: 

1. Click Sort Settings on the BD FACS Sortware sorter software toolbar. 

The Sort Settings pane opens. 
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2. Under Sort Mode, select the User Defined sort mode from the menu. 

3. Under Settings, select the number of drops from the Drops menu. 

4. Select the target result you want from the Objective menu. 

5. In the coincidence scale, click to add individual phase gates that determine the 
threshold and sort only particles that are in a certain position in the droplet. 

6. In the Extra Coincidence field, click to add or remove extra coincidence 
particles. 

� To ensure maximum purity, reduce or eliminate individual coincidence 
particles. 

� To increase throughput or sort with additional particles, add extra 
coincidence particles. 

See Setting numeric values in panes and dialogs (page 96) for more 
information. 
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Saving a user-defined To save a user-defined sort mode: 
sort mode 

1. Select Sorting > Save Sort Mode. 

The Save Sort Mode dialog opens. 

2. Under New Sort Mode, type a new name for the user-defined sort mode in the 
Name field. 

3. Click OK. 

More information � About sort mode drop count (page 205) 

� Importing an existing BD Spigot sort device (page 209) 

Importing an existing BD Spigot sort device 

Introduction This topic describes how to import an existing sort device into BD Spigot 
software. 

Requirements You must have BD Spigot tray files available in a folder on your computer or on a 
portable storage device to access them and perform this procedure. 

Procedure To import an existing sort device: 

1. Select Sorting > Import Spigot Device. 

The Select Spigot Sort Tray File dialog opens. 

2. Navigate to the folder that contains your Spigot tray files (.tray). 

3. Select the file, then click Open. 

The tray file saves as an available sort device. You can select the sort device in 
the Sort Layout dialog, then modify it in the Tray Control pane. 

More information � Using the Tray Control pane (page 210) 
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Using the Tray Control pane 

Introduction This topic describes the Tray Control pane which is used to view or modify the 
sort device. 

Description Use this pane to view or modify the current sort device and adjust the offsets for 
the tray, or create a new sort device configuration. This pane includes two tabs. 

 Current Sort Device tab. This tab displays the layout for the current sort 
device. You can modify the layout using the offset markers and grid 
coordinate controls. 
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 Create New Sort Device tab. Use this tab to create a new sort device layout by 
setting the number of rows and columns in the layout, selecting top (A1), 
bottom (B1), and Safe positions, and the current tray position. 
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Creating a new sort device 

Introduction This topic describes how to create a new sort device using the Tray Control pane. 

Sort devices are plates or multi-tube assemblies. You need to create plate or sort 
device layouts using the Tray Control pane to map the locations of wells or tubes. 
You can save sort devices for future sorts and select them in the Sort Layout pane 
when you are ready to start a sort. 

You can restore and modify sort device layouts using the Tray Control pane. You 
can manage a list of sort devices using the Manage Sort Device dialog. 

Before you begin Standard tray sort device dimensions and well layouts are based on BD Falcon™ 
plates. If you plan to use small well plates (96-well) from other manufacturers, 
you need to create a custom tray sort device to match the plate. 

 Set up for a sort. 

 Place a sort device in the sort chamber. 

Procedure To create a new sort device: 

1. Select Tray Control from the BD FACS Sortware sorter software menu to 
display the Tray Control pane. 
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2. Click the Create New Sort Device tab. 

Test sort 
control 

3. Type a name for the new sort device in the Name field. 

4. Enter the number of rows and columns in the Rows and Columns field. 

The number of rows for the device appears in the Rows field. The number of 
columns for the device appears in the Columns field. 

5. On the map, move the cursor to set the A1 (first well) position (upper left). 

a. Note where the sort device is in relation to the stream drain. Move the 
cursor on the map to bring the device A1 position close to the stream. 

b. Click Test Sort to sort a drop on the sort device. 

c. Open the Sort Layout pane. 

d. Click Eject to move the device forward. 

e. Check the position of the test sort drop. 

f. Repeat steps a to e until the test sort drop hits the center of the well. 

g. Click the Set button next to Upper Left (A1). 

6. Move the cursor to set the B1 (last well) position (bottom right). 

7. Repeat step 5 for the B1 position. 

8. Move the cursor to set the safe position. 

When you use the Sort Layout pane to set up or run a sort, you can click Safe 
to move the sort tray to this mapped safe position away from the sort 
chamber. Make sure to allow for enough space between the wells and the safe 
position (approximately equal to the number of rows in the plate) so that the 
sort tray can clear the sort chamber. 
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9. Click the Set button next to Safe Position. 

10. (Optional) Adjust the X or Y offsets (indicated by the blue line in the sort 
device map) by clicking the position up/down and left/right arrows, or by 
dragging the position markers in the sort device map. 

11. Click Create to create the new sort device. 

More information � Modifying an existing sort device (page 214) 

� Deleting sort devices (page 216) 

Modifying an existing sort device 

Introduction This topic describes how to modify an existing sort device using the Tray Control 
pane. 

Procedure To modify a sort device: 

1. In the Sorting Layout dialog, under Sort Device, select a sort device. 

The selected sort device appears in the Current Sort Device tab in the Tray 
Control pane. 
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2. Drag the vertical or horizontal offset markers to a new position in the map, or 
adjust the X and Y locations by clicking the up and down arrows in the 
Location fields. 

Offset marker 

Offset controls 

   
  

 
  

3. Click Set Home to shift the A1, B1, and Safe positions to the new locations. 
The new positions are saved with the selected sort device. 

More information � Using the Tray Control pane (page 210) 



 

 

  

216 BD Influx User’s Guide 

Deleting sort devices 

Introduction This topic describes how to delete existing sort devices using the Manage Sort 
Devices dialog. 

Procedure To delete existing sort devices: 

1. Select Sorting > Manage Sort Devices from the BD FACS Sortware sorter 
software menu. 

The Manage Sort Devices dialog opens. 

2. Under Sort Devices, click the X next to the sort device you want to delete. 

A confirmation dialog opens. 

3. Click Yes. 

The sort device is deleted. 

More information � Using the Tray Control pane (page 210) 
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Using the Sort Layout pane 

Introduction This topic describes the Sort Layout pane tools, options, and sort controls. 

Description Use this pane to select the sort tray or tube, select the sort mode, define the 
population for the sort target, and control the position and readiness of the sort 
tray or tube. 

Tube sort targets 

Tools and controls This dialog includes the following tools. 

Tool Description 

Sort Device Lists the available sort devices. 

Sort Mode Lists the available preset sort modes or user-defined modes. 

Sort Limit Displays the number of events. Modify this setting by typing a value 
in the field. 

Unlimited Enables or disables a continuous sort. 

Piezo Amp Displays the current piezo amplitude. Modify this setting by typing a 
value in the field or using the data slider. 

Sort Report Displays a preview of the sort report after the sort completes. 

This dialog includes the following sort controls and actions. 

Control or action Procedure 

Selecting individual sort 
targets 

Click inside the sort target to select only that target. 

Selecting all sort targets Click the upper left corner of the sort target table to 
select sort targets. 

Selected population (P1, 
P2, etc.) 

Right-click in a sort target to select a population for 
the tube or well. 

Start, Stop, Pause, Reset Click to control the sort operation. 
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Control or action Procedure 

Eject when sort complete 
(checkbox) 

Select to eject the sort tray at the end of a sort. 

Sort Ready Click to move the sort tray to the sort ready position. 

Safe Click to move the sort tray to the safe position, away 
from the sort head and deflection plates. 

Eject Click to eject the sort tray. 

More information � Software overview (page 93) 

� Using the Tray Control pane (page 210) 

� Sort setup workflow (page 284) 
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Controlling the sort tray position 

Introduction This topic describes how to move the sort tray position to optimize tube or well 
alignment with the sample stream. Use the Sort Layout dialog and the Tray 
Control pane to perform this procedure as needed. 

Moving the sort tray to 
predefined positions 

To move the sort tray to predefined positions: 

 To move the sort tray to the Home position (ready for sorting), click Sort 
Ready. 

 To move the sort tray to the safe position (away from the sample stream), 
click Safe. 

 To move the sort tray to the eject position so you can remove the sort device, 
Click Eject. 

Manually moving the sort To manually move the sort tray position: 
tray position 

1. Open the tray control. 

2. Click the Test Sort button to determine the current setting. 
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3. Move the tray by clicking the offset control arrows or adjust the values in the 
X or Y location fields by using the mouse scroll wheel, small arrows, data 
slider, or keyboard keys. 

Offset controls 

Test Sort control 

4. Click Set Home to save setting for the current sort device. 

More information � Using the Tray Control pane (page 210) 

� Using the Sort Layout pane (page 217) 



 

 

 

Part 3
 System workflow 

This part includes these sections: 

 Chapter 17: System startup (page 223) 

 Chapter 18: Alignment and QC (page 241) 

 Chapter 19: Optimizing system settings for samples (page 263) 

 Chapter 20: Sorting (page 283) 

 Chapter 21: System shutdown (page 319) 
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17 
System startup 

This section includes these topics: 

 Startup workflow (page 224) 

 Startup and troubleshooting components (page 225) 

 Powering up the system (page 226) 

 Preparing the fluidics tanks (page 228) 

 Flushing the system (page 233) 

 Cleaning the nozzle tip (page 234) 

 Removing bubbles from the sample line (page 235) 

 Backflushing the sample line (page 236) 

 Introducing a sample into the system (page 237) 
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Startup workflow 

Introduction This topic describes the workflow steps for starting up the Influx system. 

The workflow you perform depends on how the BD Influx instrument was shut 
down. 

Workflow (dry startup) Use this workflow if you are starting the BD Influx instrument for the first time, 
or if you are restarting after a dry shutdown (no fluids in the instrument). 

Stage Description 

1 Powering up the system (page 226) 

2 Preparing the fluidics tanks (page 228) 

3 Flushing the system (page 233) 

4 Cleaning the nozzle tip (page 234) 

5 Removing bubbles from the sample line (page 235) 

6 Backflushing the sample line (page 236) 

7 Introducing a sample into the system (page 237) 

Workflow (wet startup) Use this workflow if you are re-starting the Influx instrument after a wet 
shutdown (DI water in the instrument). 

Stage Description 

1 Powering up the system (page 226) 

2 Preparing the fluidics tanks (page 228) 

3 (If needed) Flushing the system (page 233) 

4 (If needed) Cleaning the nozzle tip (page 234) 

5 Removing bubbles from the sample line (page 235) 

6 Backflushing the sample line (page 236) 

7 Introducing a sample into the system (page 237) 

More information � Startup and troubleshooting components (page 225) 

� System shutdown (page 319) 

� System shutdown workflow (page 320) 
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Startup and troubleshooting components 

Introduction This topic describes the tools that are used during BD Influx startup, shutdown, 
and troubleshooting. 

Tools  Debubble reservoir. Use this tool when you remove bubbles from the fluidics 
during startup or as needed. This reservoir is also used during wet shutdowns 
to submerge the nozzle tip in fluid to prevent air from entering the fluidics. 

Debubble reservoir attached to a tube to 
hold fluid 

Debubble reservoir with DI water used 
to submerge a nozzle tip during a wet 
shutdown 

 Flush bucket. This is a moveable receptacle that is attached to the waste line. 
Use this tool during startup and shutdown to catch the sample stream from 
the nozzle assembly (when you bypass the flow to the sort stage and the 
drain). 

Flush bucket under the nozzle assembly during a 
flush procedure 

Debubble reservoir located on the flush 
bucket during a wet shutdown 

The flush bucket mounts in two places: 

– Under the nozzle assembly when in use 

– On top of the pressure console when not in use 

Use the flush bucket during startup whenever you: 

– Rinse without a nozzle tip to fill the fluidic lines 

– Purge with a nozzle tip to remove bubbles from the tip 
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Use the flush bucket during shutdown whenever you: 

– Dry the fluidics system in a dry shutdown 

– Submerge the nozzle tip in DI water for a wet shutdown 

More information � System startup (page 223) 

� Startup workflow (page 224) 

Powering up the system 

Introduction This topic describes how to power up the BD Influx system. 

Procedure To power up the system: 

1. Turn on the main power. 

The power source is typically located on the back of the instrument or on the 
bench next to the instrument. 

Main power switch on the AC isolation transformer 

The main AC isolation transformer is included with US instruments. This 
component and procedure might be different based on the transformer used 
for your specific installation. If you are not sure about the location of your 
power conditioner, contact your BD Service representative. 

2. Turn on the electronics using the auxiliary power switch on the front of the 
instrument table. 
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This powers the system electronics.  

  

 

 

Auxiliary power switch 

Laser power supply 

Caution: Laser! Close all laser shutters and power up all lasers in accordance 
with the manufacturer’s procedures. 

3. Turn on the power to the cytometer interface computer. 

The cytometer interface powers up in approximately 90 seconds. 

4. Start up the main computer. 

5. Turn the key on each laser to turn them on. Allow at least 30 minutes of 
warmup time. 

6. Double-click the BD FACS Sortware sorter software icon on the desktop to 
start the software. 

More information � System startup (page 223) 

� Power distribution (page 64) 

� Preparing the fluidics tanks (page 228) 
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Preparing the fluidics tanks 

Introduction This topic describes how to prepare the fluidics tanks and balance the sample-to-
sheath pressure. This topic includes procedures for calibrating the digital scale for 
an empty tank, and measuring a full or partially filled tank. 

Required materials  1 empty sheath tank 

 7 L of sheath fluid 

 0.7 L of bleach (if sorting biohazardous samples) 

 0.2-m sheath filter (provided). If you are not using a sheath filter, pre-filter 
your sheath fluid to 0.2-µm or smaller to avoid excess noise in the system. 

Calibrating the digital 
scale with an empty tank 

Perform this procedure only if the digital scale power has been turned off and you 
have an empty sheath tank, or if you need to refill an empty sheath tank. 

To calibrate (zero) the digital scale and determine the weight of an empty sheath 
tank: 

1. Turn on the digital scale. 

2. Place an empty sheath tank (with its cover on and the hoses and tubing 
connected) on the scale. 

3. Note the weight of the empty tank before you zero the scale. Save the note as 
a reference. 
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4. On the digital scale control panel, press On/Off Zero. 

Measuring a full or 
partial tank 

The empty tank weight is now equal to zero on the digital scale. 

When you add sheath fluid to the tank, the additional weight is converted to a 
liquid volume value that determines the sheath level in the tank (1 kg of 
measured weight is equal to 1 L of sheath fluid). 

If the digital scale power is turned off, it does not retain the “empty tank” 
calibration. The next time it powers up, the digital scale only reflects the current, 
combined weight of the tank and fluid. 

If you have a full or partially full tank, you should not recalibrate the scale. 
Instead, use the empty tank measurement from step 3 and subtract the weight of 
the empty tank from the weight that displays on the digital scale to get an accurate 
measurement. 

This eliminates the need for multiple sheath tanks and helps you avoid 
transferring sheath from one tank to another. 

When the tank is empty, you can recalibrate the digital scale before you refill the 
sheath. 

Filling the sheath tank Check the sheath level during startup (each day) and refill the tank as needed. 

To fill the sheath tank: 

1. After you calibrate the digital scale with an empty sheath tank, place the 
empty tank on the floor before refilling it. 

This helps to prevent accidental spillage of sheath fluid onto the digital scale. 

2. Fill the sheath tank with up to 7 L of sheath fluid. 

Do not fill past the weld line on the tank. This ensures that there is adequate 
space for the tank to pressurize. 
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3. Attach the sheath tank lid. 

Sheath output to sheath line 

Air input 

Sheath tank lid 

Pressure relief valve 

Preparing the waste tank 

4. Place the full tank into position on the digital scale. 

5. If you are starting the instrument from a dry shutdown, disconnect the blue 
quick connect sheath and air lines from each other, and attach the sheath line 
to a 0.2-µm sheath filter. 

6. Attach the air line to the tank and the sheath line (with the filter attached) to 
the sheath tank. 

If you are starting the instrument from a wet shutdown, the filter should 
already be attached. 

Check the waste tank level during startup (each day) and empty it each time you 
fill the sheath tank. 

Caution! The contents of the waste tank and waste tubing could be 
contaminated with biohazardous material. Follow your standard laboratory 
procedures for biological hazards during all cleaning and maintenance 
procedures. Wear protective clothing, eyewear, and gloves. 

To prepare the waste tank: 

1. Disconnect the quick connect fittings. 

2. Remove the sheath tank lid near the sink. 

3. Empty the waste tank carefully so that you do not spill waste fluid on the 
pressure gauge. 

4. Add bleach if sorting biohazardous samples. Add 0.7 L of bleach to achieve a 
10% concentration of bleach. 

5. Attach the sheath tank lid. 
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6. Place the waste tank next to the sheath tank, and then attach the quick 
connect fittings for the waste line input and the vacuum source. 

Waste line 

Vacuum port 

7. Ensure that the hydrophobic waste filter is connected between the vacuum 
source and the waste tank. 

8. If the waste tank overfills and wets the filter, empty the waste tank and 
replace the filter. 

Caution! Do not run the system without the filter in place. Liquid 
contamination in the house vacuum supply or the dedicated air compressor 
can cause damage to the vacuum system. 

Pressurizing the waste To pressurize the waste tank: 
tank 

1. Turn on the house vacuum supply or vacuum pump. 

2. Check the waste gauge and ensure that it reads between 5" Hg and 10" Hg. 

� If the gauge reads less than 5" Hg after a few seconds, tighten the waste 
tank lid to ensure that it is tightly sealed. If the waste lid is sealed but the 
pressure does not increase, see topics about pressurizing tanks in Sorting 
troubleshooting (page 364) for more information. 

� If the gauge reads more than 10" Hg, reduce the vacuum applied to the 
waste tank. 

Pressurizing the sheath To pressurize the sheath tank: 
tank 

1. Close the pressure relief valve on the sheath tank. 

2. Verify that the house air pressure supply or dedicated air compressor is on. 

3. Switch the pressure console Air switch on. 
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4. Verify that the sheath tank is sealed by checking the pressure gauge for the 
appropriate pressure. The pressure should be between 5–65 PSI depending on 
the nozzle size (use more pressure for larger nozzles). 

If the tank is not pressurizing, verify that the release valve is closed, or re-seat 
the sheath reservoir lid. 

5. Use the SHEATH pressure regulator knob on the right side of the pressure 
console to adjust the pressure level. 

Setting the sample 
pressure 

To set the sample pressure: 

1. Set the sample pressure to at least 1 PSI more than the sheath pressure with the 
SAMPLE pressure regulator knob. 

The sample flow rate is determined by the sample pressure setting. You can 
typically achieve a low flow rate when the sample pressure is 1 PSI higher 
than the sheath pressure. 

You can adjust the sample pressure to achieve a specific sample flow rate after 
you introduce a sample into the system. 

More information � System startup (page 223) 

� Flushing the system (page 233) 

� Introducing a sample into the system (page 237) 

� Sorting troubleshooting (page 364) 
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Flushing the system 

Introduction This topic describes how to flush the fluidics system to prime the system with 
fluid, forcing air out of the fluidic lines. 

You should flush the system: 

 After you start up the instrument from a dry shutdown 

 Whenever you change sample types 

 After you change the fluidic tubing 

Required materials Flush bucket 

Flushing the fluidics To flush the system: 

1. Remove the nozzle from the sort head if you are performing a wet shutdown. 

For a dry shutdown, the nozzle is already removed from the sort head. 

2. Place the flush bucket under the nozzle. 

Flush bucket 

3. Press RINSE and run for at least 30 seconds, checking that the lines are full of 
fluid and that the flush bucket is not overfilling. 

If the flush bucket is overfilling, check for low vacuum pressure, clogged lines, 
or possible pinches or kinks in the fluid waste line. 

Caution! If running at a high pressure, the flush bucket can easily overfill. 

4. If you are using the 0.2-m sheath filter, remove it from the metal bracket and 
tap it gently to dislodge any air bubbles. 

5. Press RINSE again to stop the flow. 
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More information � System startup (page 223) 

� Preparing the fluidics tanks (page 228) 

� Removing and replacing the nozzle tip (page 81) 

� Cleaning the nozzle tip (page 234) 

� Startup and troubleshooting components (page 225) 

� Sorting troubleshooting (page 364) 

Cleaning the nozzle tip 

Introduction This topic describes how to clean the nozzle tip. 

Clean the nozzle tip when the stream is diverted by an apparent obstruction or 
clog. You should also clean the nozzle tip daily as part of the startup workflow. 

Required materials Syringe with 0.2-m filtered water, sheath fluid, or a mild detergent 

Before you begin Remove the nozzle if it is still installed. 

Procedure To clean the nozzle tip: 

1. Sonicate the nozzle for 1–2 minutes. 

2. Prepare a syringe with 0.2-m filtered water, sheath fluid, or a mild detergent. 

3. Flush the nozzle in the opposite direction of normal sheath flow. 

4. Flush the nozzle again in the direction of normal sheath flow. 

5. Install the nozzle tip. 
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More information � System startup (page 223) 

� Backflushing the sample line (page 236) 

� Removing and replacing the nozzle tip (page 81) 

Removing bubbles from the sample line 

Introduction This topic describes how to remove bubbles from the sample line. 

Required materials  Debubble reservoir 

 Flush bucket 

Procedure To remove bubbles from the sample line: 

1. Fill the debubble reservoir with sheath fluid and place it on top of the flush 
bucket. 

2. Ensure that the tip of the nozzle is submerged in fluid. 

Debubble reservoir 

3. Press PURGE to pull fluid up through the nozzle tip and remove air from the 
system. 

4. When all air has traveled past the purge valve, press PULSE to free additional 
bubbles that might be trapped in the nozzle. 

5. Repeat steps 3 and 4 and until no additional bubbles are released from the 
nozzle. 

If you are having difficulty removing all the bubbles, try the following: 

� Make sure that the nozzle tip is submerged in fluid, refilling the debubble 
reservoir throughout the process as needed. 

� Use ethanol instead of sheath fluid in the debubble reservoir to dislodge 
bubbles. 

� Verify that the O-ring is installed in the nozzle nut and that it is as tight as 
you can get it without using a wrench. 
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� Remove and then reinsert the debubble reservoir briefly to introduce a 
large bubble into the nozzle. The large bubble will often dislodge the 
smaller bubbles. 

6. Press RUN to start a stream with the debubble reservoir still in place. 

7. Remove the debubble reservoir and remove excess fluid from the nozzle tip 
with a cotton swab, if needed. 

8. Verify that the stream is flowing straight out of the nozzle tip. 

If the stream is crooked or unstable, clean the nozzle and continue purging air 
from the lines. 

More information � System startup (page 223) 

� Cleaning the nozzle tip (page 234) 

� Startup and troubleshooting components (page 225) 

Backflushing the sample line 

Introduction This topic describes how to backflush the sample line to remove any fluid in the 
sample line. 

Procedure To backflush the sample line: 

1. Press RUN to start the stream. 

2. Remove the sample tube and move the sample tube lever to the open position. 

3. Press BACKFLUSH to backflush the sample line. 

4. After about 30 seconds, press BACKFLUSH again to turn backflushing off. 

More information � Startup and troubleshooting components (page 225) 

� System startup (page 223) 

� Cleaning the nozzle tip (page 234) 

� Introducing a sample into the system (page 237) 
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Introducing a sample into the system 

Introduction This topic provides basic information about how to load a sample tube into the 
sample station, then run a sample and test the stream alignment. 

Detailed information about aligning and optimizing the streams and lasers is 
included in the workflow sections. 

See Part 3: System workflow (page 221) for more information. 

About sample rate, 
sample pressure, and 
concentration 

Sample rate or event rate is determined by the combination of the sample 
pressure, the concentration of the sample, and ultimately, the width of the core 
stream. 

Adjust the pressure so that the sample core stream is as narrow as possible. When 
sample pressure is high, the sample core stream widens and the particles are 
dispersed into the wider stream. This causes defocused laser light during sample 
interrogation and a less accurate event count. 

If you want to increase the event rate, the sample concentration is important. If 
the sample is diluted, the sample pressure must remain low. If the concentration is 
high, then you can increase the sample pressure without causing substantial event 
loss. 

Typically, you can achieve a low flow rate when the sample pressure is less than 1 
PSI higher than the sheath pressure on some instruments. This setting can be 
different for each instrument and depends on the concentration of the sample. 

Requirements  Use only BD Falcon 5-mL polypropylene sample tubes. 

 Filter all samples to 40 m, or about half the nozzle tip size, to prevent nozzle 
clogs and ensure optimal sorting. 

 Use the flush bucket and Erlenmeyer flask to catch the stream during the 
stream testing procedure. 

Before you begin  Make sure that the sample pressure is set to approximately 1 PSI over the 
sheath pressure. 

 Make sure that the fault LEDs are both green. If the LEDs do not light up, see 
the fluidics troubleshooting section for more information. 

Loading a tube 

Caution: Biohazard! Use care when installing the sample tube. Once the tube is 
installed, the sample tube is pressurized. Sample fluid can spill or splatter if not 
properly installed and locked in place. 

To load a sample tube: 

1. Fill sample tube with up to 3 mL of sample. 
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2. Load the sample tube into the sample tube holder and pull the sample tube-
lock lever forward to lock the tube in place over the stopper. 

Do not damage or bend the sample line. 

 
 

   

 
 

    

 

 

   

  

      

 

  
 

Tube in the tube holder 

Tube-lock lever 

Running the sample You can run a sample at a low rate to help preserve the sample during alignment, 
optimization, or setting droplet breakoff. 

To run a sample: 

1. Press SAMPLE to open the sample valve and begin running the sample. 

2. Press BOOST for a few seconds to temporarily boost the sample to 3 to 5 PSI 
higher than the sheath pressure and introduce the sample into the sample line 
quickly. 

3. Create an FSC vs SSC dot plot to view the event scatter. 

4. Monitor the event scatter in the plot. 

a. Increase the sample pressure with the SAMPLE pressure regulator knob 
while you view events on the dot plot until the events begin to scatter. 

b. Adjust the pressure to keep the events cluster as tight as possible. 

5. Monitor the sample flow in the pinhole monitor. 

� If you are running bright calibration beads or cells at a low flow rate, a 
narrow sample core appears. 

� If the flow rate is too high, the sample core appears very large. 

� If no beads are observed flashing in the stream, then the flow rate is too 
low. 
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6. Adjust the sample pressure with the SAMPLE pressure regulator knob until 
you observe a low flow rate. 

Removing a sample tube 

Caution: Biohazard! Use care when removing the sample tube. The sample tube 
is usually pressurized and can include aerosolized cells, spills, or splatterings of 
sample fluid. 

To remove the sample tube: 

1. Press SAMPLE to stop the sample run. 

2. Push the tube-lock lever slowly backward until the tube is pushed down into 
the recessed area of the tube-lock lever. 

3. Remove the tube and then press BACKFLUSH to allow the residual sample to 
backflush. 

4. After the pressure is released you can remove the tube safely. 

More information � Sample introduction (page 33) 

� Pressure regulation and monitoring (page 37) 

� System startup (page 223) 
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18 
Alignment and QC 

This section includes these topics: 

 Aligning and optimizing the optics workflow (page 242) 

 Creating a QC workspace (page 243) 

 Preparing beads for QC (page 248) 

 Aligning the stream (page 249) 

 Aligning the primary laser to the core stream (page 253) 

 Optimizing the fluorescence signal for the primary laser (page 255) 

 Optimizing the forward scatter signal (page 256) 

 Optimizing additional lasers (page 257) 

 Creating an FCS file to record laser alignment (page 259) 

 Saving the QC workspace (page 260) 

 Verifying alignment using the target source (page 261) 
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Aligning and optimizing the optics workflow 

Introduction This topic provides a workflow for aligning and optimizing the optics for 
instrument QC. 

Purpose of the workflow Before running samples each day, the system needs to be aligned and optimized. 
Tracking the results of alignment ensures that the system is performing 
consistently over time and can help in troubleshooting instrument problems. 

While most alignment and optimization involves the mechanical adjustments of 
optics and fluidics, some alignment and optimization requires the use of BD FACS 
Sortware sorter software. 

Fine-tuning the instrument involves positioning the sample core at the focal point 
of the objective lens in the pinhole, illuminating the sample core optimally, and 
aligning the fluorescence and forward scatter (FSC). You might need to adjust 
PMT gains as you tune the system to keep the data on scale. 

Workflow 
Stage Description 

1 Create a QC workspace that includes all required scatter and fluorescent 
parameters, worksheet elements, and voltage settings. 

See Creating a QC workspace (page 243). 

2 Prepare beads that you can use for alignment and QC. 

See Preparing beads for QC (page 248). 

3 Introduce your sample into the system. 

See Aligning the stream (page 249). 

4 Align the stream to the pinholes and the center of the drain, or use BD 
Accudrop to align the side and center streams. 

See Aligning the stream (page 249). 

5 Optimize a fluorescence channel by aligning the primary laser into the sample 
stream. 

See Aligning the primary laser to the core stream (page 253). 

6 Optimize a fluorescence signal by aligning to the fluorescence detectors. 

See Optimizing the fluorescence signal for the primary laser (page 255). 

7 Adjust the forward scatter stage to maximize the signal from the standard and 
small particle forward scatter detectors. 

See Optimizing the forward scatter signal (page 256). 

8 Optimize additional lasers that your system might include. 

See Optimizing additional lasers (page 257). 

9 Save the QC workspace to store all alignment settings. 

See Saving the QC workspace (page 260). 
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More information � Creating a QC workspace (page 243) 

Creating a QC workspace 

Introduction This topic describes how to create a QC workspace for a specific sorting nozzle 
size and sheath pressure. 

The QC workspace includes a worksheet with plots to measure and track all 
scatter and fluorescent parameters that are required for QC. Once you assign 
lasers, create a worksheet, and adjust voltages, you can save the QC workspace 
and re-use it for daily QC or modify it for use with different nozzle sizes. 

About the QC workspace The QC workspace is designed to simplify alignment by presenting the correct 
alignment procedure. The procedure typically includes the following: 

1. Aligning the stream to pinholes and the drain 

2. Aligning the primary fluorescence parameter 

3. Aligning the forward scatter 

4. Aligning additional lasers 

After alignment and QC, the resulting cytometer settings can be saved to be used 
as the base daily cytometer settings. 

Procedure summary This example shows how to create a new QC workspace by adding plots and 
statistics views that display data for the primary laser fluorescence parameters, 
FSC vs SSC, and all other configured lasers and included parameters. Statistics 
should only show the essential categories for events, median or mean, and CV or 
RCV. 

Stage Description 

1 Start with a QC workspace. 

See Creating a QC workspace (page 243) 

2 Add plots for the primary laser fluorescence parameters. 

See Adding plots for primary laser fluorescence parameters (page 245) 

3 Add and customize statistics views for the primary laser fluorescence 
parameters and create a gate for QC population. 

See Adding and customizing a statistics view (page 245) 
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Stage Description 

4 Add an FSC vs SSC plot and statistics view. 

See Adding an FSC vs SSC plot and a statistics view (page 247) 

5 Add plots and statistics views for all other lasers and fluorescence parameters. 

See Adding plots and statistics for all other configured lasers and parameters 
(page 247) 

6 Save the workspace and an FCS file (after you perform the alignment 
procedures). 

See Saving the QC workspace (page 260) 

Creating a QC workspace To create a QC workspace: 

1. Select File > New Workspace. 

A confirmation dialog opens. 

2. Click OK. 

The worksheet clears and all plots, gates, data sources, and statistics are 
deleted. 

3. (Optional) Add header or footer information to customize the worksheet. 

See Customizing worksheet properties (page 143) for more information. 

4. In the Data Sources tab, in the Data Sources pane, select Cytometer as the 
source. 

5. In the Cytometer Settings pane, clear the Log checkbox for each detector to 
ensure that all parameters use the linear amplifier. 

Log/Lin scaling checkbox 
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Adding plots for primary To add plots for the primary laser fluorescence parameters: 
laser fluorescence 

1. On the worksheet, double-click the Dot Plot tool on the Worksheet toolbar, parameters 
then click in the worksheet to create several plots. 

2. To stop creating multiple dot plots, select a new tool such as the pointer icon 
used to select worksheet elements. 

3. Use the alignment tools to align the plots on the worksheet, then right-click 
the X and Y axis parameter and select different ADC parameters. 

Add dot plots for the primary (blue) laser fluorescence parameters and one for 
side scatter. For example, create the following fluorescence parameters: 

� 530/40 [488] vs 580/30 [488] 

� 692/40 [488] vs 750 LP [488} 

� SSC vs 750 LP [488} 

Adding and customizing a To add and customize a statistics view for the primary laser fluorescence 
statistics view parameters: 

1. Right-click a plot, then select Statistics View. 

A statistics view appears in the worksheet. 

2. Right-click the statistics view, then select Edit Statistics View. 

The Edit Statistics View dialog opens. 
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3. In the Populations tab, under Formulas, select only the Events checkbox. 

4. Click the Parameters tab. 

5. For each primary laser fluorescence parameter (488), select the Median and 
RCV checkboxes. 

6. Click OK. 

7. Drag the corners of the statistics view to size it to fit the width of the 
worksheet. 
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The worksheet should look like the following figure. 

Note that if you need more viewing or printing space for the statistics view, 
you can create separate statistics views for each plot, or any combination of 
plots. 

Adding an FSC vs SSC To add an FSC vs SSC plot and a statistics view: 
plot and a statistics view 

1. Do one of the following: 

� If you do not have the FSC depolarizer option, create an FSC vs SSC plot. 

� If you have the FSC depolarizer option, create plots for FSC (Par) vs SSC, 
and FSC (Par) vs FSC (Per). 

2. Right-click the dot plot(s) and select Statistics View. 

A statistics view appears in the worksheet. 

3. Right-click the statistics view and select Edit Statistics View. 

The Edit Statistics View dialog opens. 

4. In the Populations tab, under Formulas, select only the Events checkbox. 

5. Click the Parameters tab. 

6. For FSC and SSC, select the Median and RCV checkboxes. If you have the 
depolarizer option, also select FCS (Per). 

7. Click OK. 

8. Drag the corners of the statistics view to size it to fit the width of the 
worksheet. 

Adding plots and To add plots and statistics for all other configured lasers and parameters: 
statistics for all other 

1. Create plots, select parameters, and add a statistics view for each laser. configured lasers and 
parameters 
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2. If you require more space for your additional plots, click the Add Page tool on 
the Worksheet toolbar to add pages. 

More information � Saving and restoring settings (page 112) 

� Saving and deleting settings (page 115) 

� Viewing cytometer status (page 121) 

Preparing beads for QC 

Introduction This topic describes how to prepare beads for alignment and QC. 

Required materials  BD Falcon™ 35-2063 5-mL polypropylene sample tubes 

 3 µm SPHERO™ Ultra Rainbow beads 

 1 mL sheath fluid 

Preparing beads To prepare a tube of beads: 

1. Add at least 2 to 3 drops of beads and 1 mL of sheath fluid to a tube. 

2. Load the tube of Ultra Rainbow beads onto the sample tube holder and close 
the sample lever to lock the tube into place. 

3. Press SAMPLE to start the sample flow. 

More information � Introducing a sample into the system (page 237) 

� Aligning the stream (page 249) 
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Aligning the stream 

Introduction This topic describes the method for aligning the stream to the pinholes, as well as 
centering the stream to hit the center of the stream drain. If you have the BD FACS 
Accudrop feature, this is where you would also ensure that the Accudrop laser is 
hitting the side and center streams equally. 

Required materials Erlenmeyer flask 

Before you begin 

Caution: Shock hazard. You must power off the deflection plates before 
manually opening or adjusting them. 

1. Ensure that the deflection plate power is off. 

See Deflection plate power (page 67) for more information. 

2. Manually open the deflection plates to prevent the sheath fluid from splashing 
on the plates and spraying. 

Testing the stream 1. Place an Erlenmeyer flask is placed onto the sort stage under the stream drain. 
alignment 

2. Remove the flush bucket so that the stream passes through the illumination 
chamber into the sort chamber. 

Flush bucket under the nozzle assembly 

Caution! The stream might splash and spray out of the drain if the system is 
running at high pressures and droplets are not being generated. 

3. Press ILLUM on the monitor stand to illuminate the stream just above the 
drain. 
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How to adjust the nozzle The nozzle assembly provides adjustment knobs used to center the stream on the 
stage pinhole and to center the stream into the drain. 

Vertical adjustment 

Focus adjustment 

Horizontal adjustment 
Front of Nozzle 

Left/Right (roll) knob 

In/Out (pitch) knob 

Adjustment Description 

Vertical (top silver knob): 
Pinhole alignment 

Moves the stage vertically (perpendicular to the light 
path). Set this above the first pinhole. 

Focus (silver knob at the 
back of nozzle stage): 
Pinhole alignment 

Moves the stage perpendicular to the light path (either 
to focus the illumination beam or focus the 
fluorescent/scattered light spot). 

Horizontal (bottom silver 
knob): Pinhole alignment 

Moves the stage in and out, parallel to the light path. 

In/Out (pitch) black 
knob: Drain alignment 

Moves the nozzle pitch (in or out) and adjusts the 
stream alignment with the center of the stream drain. 

Left/Right (roll) black 
knob: Drain alignment 

Moves the nozzle roll (left or right) and adjusts the 
stream alignment with the center of the stream drain. 
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Adjusting the nozzle To adjust the nozzle stage to align the stream: 
stage to align the stream 1. Adjust the horizontal adjustment knob so that the stream is placed over the 

pinholes. 

2. Adjust the focus adjustment knob so that the stream is in focus. 

View the stream on the pinhole monitor. 

Pinholes and stream before alignment After alignment 

Stream 

Aligning the stream with To align the stream with the drain: 
the drain 

1. Adjust the In/Out (pitch) and Left/Right (roll) knobs on the nozzle stage to 
move the stream to the center of the drain, if needed. 

2. Ensure that the stream is still focused on the pinholes. 

You might need to go back and forth between aligning the stream to the 
pinhole and to the drain to get an accurate alignment. 

Stream 

Drain 

Right Left 

Out 

In 

 

 

 

   
  

 

  
 

 
 

 

  
    

 

 

Aligning the side and After you align the stream with the pinholes and the drain, you can use Accudrop 
center streams with to align the side and center streams (the stream is brightest when the laser is 
Accudrop aligned with the stream). Ensuring that the Accudrop laser is illuminating the 

streams equally is important for determining the most accurate drop delay before 
sorting. 
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To align the side and center streams with Accudrop: 

1. Determine the stream breakoff. 

2. Move the deflection plates into the sort position. 

3. Turn on the deflection plates. 

4. Test the side streams. 

5. View the side streams in the stream drain monitor. 

6. Ensure that both the side and center streams are illuminated by the Accudrop 
laser. Adjust the nozzle stage focus knob if necessary. 

7. Adjust the In/Out pitch knob only if absolutely necessary. 

8. Confirm that the stream is still focused on the pinholes. If not, repeat steps 1 
through 7. 

9. Turn off the test streams. 

10. Turn off the deflection plates. 

More information � Aligning and optimizing the optics workflow (page 242) 

� Preparing beads for QC (page 248) 

� Aligning the primary laser to the core stream (page 253) 

� Optimizing the droplet breakoff (page 285) 

� Optimizing the side streams (page 289) 
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Aligning the primary laser to the core stream 

Introduction This topic describes how to optimize a fluorescence channel by aligning the 
primary laser into the sample stream. In this procedure, the blue (488 nm) laser is 
the primary laser. 

Before you begin  Prepare a tube of SPHERO Ultra Rainbow beads 

 Verify that the fault LEDs are both green. 

Procedure To align the primary laser to the core stream: 

1. Close the nozzle chamber door and put the chamber lid in place. 

2. Place your finger over the reset sensor in the upper right corner of the 
chamber door to reset the safety interlock. 

Chamber lid Reset sensor 

Chamber door 

3. Open the shutter for the 488-nm (primary) laser on the left side of the sort 
head by pulling the laser shutter interlock pin out. 

You will see a glow in the pinhole monitor when the blue laser hits the stream. 

4. Load the tube of Ultra Rainbow beads onto the sample tube holder and close 
the sample lever to lock the tube into place. 

5. Check the sample pressure gauge to verify that the sample pressure is about 1 
PSI above the sheath pressure. Adjust the sample offset knob to correct the 
sample pressure, if necessary. 

See Introducing a sample into the system (page 237). 

6. Press SAMPLE to start running beads. 

7. Press BOOST for a few seconds to deliver sample to the laser more quickly, if 
needed. 
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8. Adjust the blue laser Vertical adjustment knob so that the laser glow appears 
just above the top pinhole and look for the flash of beads in the core stream. 

Vertical adjustment 

Horizontal adjustment 

9. Adjust the sample offset to change the flow rate until you see a narrow core 
stream in the pinhole monitor. 

� If the sample core stream is very wide, the flow rate is too high. 

� If the sample core stream is not visible, the flow rate is too low. 

When an optimal low flow rate is achieved, the sample pressure is typically 
slightly higher than the sheath pressure, usually within 1 PSI. 

10. Adjust the blue laser Horizontal adjustment knob until you see the brightest 
signal in the pinhole monitor. 

11. Adjust the Focus knob on the nozzle stage (back of nozzle stage) to focus the 
signal. 

12. Repeat steps 10 and 11 until the sample core is as narrow and bright as 
possible. 

13. Adjust the blue laser Vertical adjustment knob to place the sample core back 
on the top of the pinhole. 

More information � Optimizing the fluorescence signal for the primary laser (page 255) 

� Sorting troubleshooting (page 364) 
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Optimizing the fluorescence signal for the primary laser 

Introduction This topic describes how to use BD FACS Sortware sorter software to optimize the 
fluorescence signal for the primary laser. 

Procedure To optimize the fluorescence signal for the primary laser: 

1. Restore the user-defined QC workspace if needed. 

2. Click Recording on the BD FACSortware toolbar. 

The Recording Settings pane opens. 

3. Under Display Buffer, select a default display count of 200. 

The default display count dictates the default refresh for this session. While 
making adjustments, it is helpful to have a quick refresh. 

4. Click a plot that has the primary (typically blue) laser parameters. 

5. Use the vertical and horizontal adjustment knobs to maximize the bead 
fluorescence signal in the plots associated with the laser you are optimizing. 

6. View the oscilloscope pulse monitor and the plots in the worksheet while 
making adjustments to achieve the maximum signal. 

When a plot is selected, the oscilloscope (channels 1 and 2) update to reflect 
the signal from the detector (parameters). 

7. Once the signal has been optimized, adjust the fluorescence parameter 
PMTVs so that the bead population is at a mean of approximately 45,000 for 
each blue laser parameter. 

8. Draw a gate around the primary laser signal. 

More information � Saving and restoring settings (page 112) 

� Worksheet overview (page 138) 

� Viewing and setting cytometer details (page 129) 
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Optimizing the forward scatter signal 

Introduction This topic describes how to adjust the forward scatter stage to maximize the 
signal from the standard and small particle forward scatter detectors. 

Before you begin  Open your QC workspace (including plots and statistics views). 

 Align the fluorescence detectors. 

Optimizing the forward To optimize the forward scatter signal: 
scatter signal 

1. In the worksheet, click a plot that has the FSC parameter. 

This updates the scope to monitor the forward scatter detector. 

2. Adjust the Horizontal and Vertical knobs on the forward scatter stage to 
maximize the signal from the detector. 

View the oscilloscope pulse monitor and the plot in the worksheet while 
adjusting the focus, vertical, and horizontal positions of the forward scatter 
stage to further optimize the forward scatter signal. 

3. Adjust the FSC and SSC voltages to place the bead population at a mean of 
approximately 25,000. 

Optimizing for the small To optimize the forward scatter for the small particle detector or polarized 
particle detector forward scatter options: 

1. Flip the switch on the pinhole monitor to Video 2. 

Video 2 displays the small particle detector forward scatter pinhole. 

2. Adjust the focus, vertical, and horizontal positions of the FSC assembly. 

View the pinhole monitor and the plot in the worksheet while adjusting the 
three knobs on the forward scatter stage until the signal is maximized. 

3. Adjust the voltages to place the bead population at a mean of about 25,000. 

More information � Optimizing the fluorescence signal for the primary laser (page 255) 

� Optimizing additional lasers (page 257) 
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Optimizing additional lasers 

Introduction This topic describes how to optimize additional lasers that your system might 
include. 

About additional lasers Additional lasers must be aligned to the correct pinhole using the pinhole monitor. 
Fine-tune the laser using the oscilloscope and the signals viewed in BD FACS 
Sortware sorter software. 

The primary laser (through the top pinhole) is the system trigger. With multi-laser 
systems, you need adjust the laser delay to synchronize the signals from additional 
lasers. 

Before you begin  View the Cytometer Settings pane to verify that the lasers are listed in the 
proper order. 

 Ensure that the primary laser signal and forward scatter signals are optimized. 

 Make sure you have your QC log sheet. 

Aligning additional lasers To align additional lasers: 

1. Open the shutter for the laser that you want to align. 

2. Verify that the laser is aligned with the correct pinhole by looking for beads in 
the core stream on the pinhole monitor. 

To optimize the laser, see Aligning the primary laser to the core stream 
(page 253). 

Setting laser delays To set laser delays: 

1. In the QC workspace worksheet, click a plot that has the parameters for the 
laser you are aligning. 

If the plot does not exist on the worksheet, create a new dot plot and statistics 
view. The statistics view should include total events, median, and rCV for the 
laser you are aligning. 

2. View the oscilloscope and note where the voltage pulse is in relationship to 
the laser delay bucket. 

3. In the Cytometer Settings pane, locate the laser you want to adjust in the list. 

4. Adjust the delay in the Delay field using the mouse scroll wheel, data slider, or 
keyboard keys. 

See Setting numeric values in panes and dialogs (page 96) for more 
information. 
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Continue to adjust the value until the signal from the laser lines up with the 
appropriate bin on the third oscilloscope trace. 

    

  

 

 
 

 
 

 

Laser delay unadjusted Laser delay adjusted 

5. Use the Vertical and Horizontal adjustment knobs to maximize the bead 
fluorescence signal in the plots associated with the laser you are optimizing. 
View the oscilloscope pulse monitor and the plots in the worksheet while 
making adjustments. The goal is to achieve the maximum signal. 

6. Repeat steps 4 and 5 until the laser signal is maximized and the laser delay is 
optimal based on the voltage pulse in the oscilloscope. 

7. Adjust the PMTV to place the bead population at a mean of about 45,000 for 
each parameter of the laser you are aligning. 

You may need to adjust the PMTVs as you are optimizing the signal if the 
bead population is off scale. 

More information � Optimizing the forward scatter signal (page 256) 

� Creating an FCS file to record laser alignment (page 259) 
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Creating an FCS file to record laser alignment 

Introduction This topic describes how to create an FCS file to record laser alignment. 

Procedure After the instrument alignment is optimized for all lasers, create an FCS file for 
future reference. 

To save a data file to record laser alignment: 

1. Ensure that the laser shutters for all applicable lasers are open. 

2. Click Recording on the BD FACSortware toolbar. 

The Recording Settings pane opens. 

3. Under FCS File, click Path. 

4. Navigate to the folder where you want to store QC data and click OK. 

5. In the File field, name the new QC data file. 

6. Under Recording Rule, modify the recording rules as needed. 

7. Lower the event rate so that you have a small core stream. 

8. In the Acquisition Dashboard, click Acquire, then click Record to record the 
data file. 

9. Note the RCV, Median, and PMTV in your QC log. 

More information � Laser delay (page 53) 

� Adjusting PMT voltages and using integrators (page 125) 

� Optimizing the forward scatter signal (page 256) 

� Saving the QC workspace (page 260) 

� Verifying alignment using the target source (page 261) 
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Saving the QC workspace 

Introduction This topic describes how to save the QC workspace. 

Procedure To save the QC workspace: 

1. (Optional) Click Cytometer > Details. 

The Cytometer Details dialog opens. 

a. Type the nozzle and pressure that is used for this QC workspace. 

b. Click OK to apply your preferences and close the dialog. 

2. Select File > Save > Workspace. 

The Save Workspace dialog opens. 

3. Under Workspace Details, type a useful name for the QC workspace in the 
Name field (for example, 86 u 30 psi QC Workspace). 

4. (Optional) Type a description of this workspace template in the Description 
field. 

5. Click OK. 
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You can restore the QC workspace whenever you want to perform QC. 

More information � Aligning the stream (page 249) 

� Optimizing additional lasers (page 257) 

� Verifying alignment using the target source (page 261) 

Verifying alignment using the target source 

Introduction This topic describes how to use a target data source (FCS file) to verify instrument 
alignment. The following procedures describe how to create a QC target FCS file 
specifically for this purpose and apply it as a target source. To use the target 
source feature, the target source FCS file must match the parameters and the (log/ 
lin) of the plots. 

Recording a target source To record a target source FCS file: 
FCS file 

1. In the Recording Settings pane, create a QC FCS file that contains a small 
number of events (for example, 500 to 750). 

2. In the File field, name the file (for example, Target QC 86u 30 psi). 

See Creating an FCS file to record laser alignment (page 259) for instructions 
on creating an FCS file using the Recording Settings pane. 

3. In the Acquisition Dashboard, click Acquire, then click Record to record the 
data file. 

Applying the target You can add a target source to your plots to show what your optimized alignment 
source looks like. 

To apply the target source: 

1. Open the appropriate QC workspace. 

2. In the Data Source pane, click the Directory tab. 
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3. Click the Open Folder button and navigate the folder that contains the new 
target FCS file. 

4. Click OK. 

5. Double-click the FCS file to add it to the Data Sources tab. 

6. In the worksheet, select all plots. 

7. In the Inspector, click the Dot Plot(s) tab. 

8. In Target Source field, select the target QC FCS file. 

The target source appears in gray as an overlay (bottom layer) in the plot. 

9. Acquire the sample and view where the live events are in relationship to the 
gray target data. If the live cells are close to the target data, then the alignment 
is still good. If not, the lasers alignment needs adjustment. 

More information � Optimizing the forward scatter signal (page 256) 

� Laser delay (page 53) 

� Adjusting PMT voltages and using integrators (page 125) 

� Saving the QC workspace (page 260) 



 

 

 

 

19 
Optimizing system settings for samples 

This section includes these topics: 

 Creating plots and gates for optimization (page 264) 

 Optimizing with compensation controls (page 268) 

 Optimizing scatter parameters (page 269) 

 Optimizing fluorescence detector voltages (page 271) 

 Collecting data files for compensation (page 272) 

 Defining populations for compensation (page 273) 

 Performing auto compensation (page 275) 

 Saving a compensation matrix (page 279) 

 Restoring (importing) a compensation matrix (page 280) 
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Creating plots and gates for optimization 

Introduction This topic describes how to create plots and gates that you can use to optimize the 
fluorescence settings for a sample. This describes basic optimization tasks and 
does not include compensation. 

The following procedure uses 8-peak beads to illustrate the example. 

Creating plots for 
optimization 

To create plots to optimize settings for your sample: 

1. Load a tube of your sample and press SAMPLE. 

2. In the Data Sources pane, select Cytometer as the data source. 

3. Double-click the Dot Plot tool on the Worksheet toolbar, then click twice in 
the worksheet to create two plots (scatter and fluorescence). 

To stop creating multiple plots, click the pointer icon (used to select other 
worksheet elements). 

4. Use the alignment tools on the Worksheet toolbar to align the two plots. 

5. Verify that the first plot (scatter) displays FSC vs SSC for the x- and -y axis 
labels. 



  

 

  

 

  

265 Chapter 19: Optimizing system settings for samples 

6. Click the second plot (fluorescence) to enable the Plot Properties tab in the 
Inspector. 

7. Under X Parameter, select 530/40 from the Parameter menu. 

8. Under Y Parameter, select 670/30 from the Parameter menu. 

You can substitute different fluorescence parameters as needed. 

9. Click Acquire in the Acquisition Dashboard to populate the plots with data. 

10. Adjust the voltages for the scatter plot to place the population on scale, if 
needed. 
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11. Adjust the voltages for the fluorescence to place all peaks on scale. 

Creating gates for To create gates to optimize settings for your sample: 
optimization 

1. In the worksheet, click the scatter (FSC vs SSC) plot. 

2. Create a gate on the singlet bead population. 

Gate 

3. In the worksheet, click the scatter plot to enable the gating controls in the 
Gate Hierarchy pane. 
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4. In the Gate Hierarchy pane, click the Show/Hide icon for the All Events 
population to show only the P1 population in the plot. 

5. In the worksheet, click the fluorescence plot (530/40 vs 670/30). 

6. Create a gate around one of the bead populations. 
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More information � Creating rectangle gates (page 187) 

� Creating polygon gates (page 188) 

� Creating ellipse gates (page 189) 

� Creating interval gates (page 192) 

Optimizing with compensation controls 

Introduction This topic describes how to optimize the system using unstained and single-color 
controls to determine fluorescence spillover values and calculate compensation. 

Examples and figures show the application of this workflow using a generic 
immunophenotyping assay. You should adapt the procedure steps for your specific 
application. 

This procedure assumes that single-color controls are cells. If you plan to perform 
compensation with beads, your control tubes should include separate tubes with 
stained and unstained beads. Note that you must use ADCs to generate the raw 
data that you use to calculate compensation. 

Workflow 
Stage Description 

1 Optimizing scatter parameters (page 269) 

2 Optimizing fluorescence detector voltages (page 271) 

3 Collecting data files for compensation (page 272) 

4 Defining populations for compensation (page 273) 

5 Performing auto compensation (page 275) 

6 Saving a compensation matrix (page 279) 

More information � Creating plots and gates for optimization (page 264) 

� Restoring (importing) a compensation matrix (page 280) 
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Optimizing scatter parameters 

Introduction This topic describes how to optimize scatter parameters by creating a plot, 
populating the plot with data, drawing a gate, and adjusting the PMTVs and 
trigger levels. 

Procedure To optimize scatter parameters: 

1. Load the tube of unstained cells and press SAMPLE. 

2. In the Data Sources pane, select Cytometer as the data source. 

3. Create an FSC vs SSC dot plot in the worksheet. 

4. Click Acquire in the Acquisition Dashboard to populate the plots with data. 

The plot populates. 

Lymphocytes 

5. Click the FSC vs SSC plot to enable the Plot Properties tab in the Inspector. 
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6. In the Inspector, select 200 from the Display Count menu. 

A low display count is useful for setup and compensation. Use a larger display 
count when you acquire a data file. 

7. Adjust the FSC and SSC voltages so that sample is on scale. 

8. Continue to adjust the following as needed: 

– Sample pressure (on the BD Influx) 

– Display count (in the Inspector pane) 

9. In the Cytometer Settings pane, adjust the trigger level. 

If you set the trigger level too high, the population does not appear in the plot. 
If you adjust the trigger too low, you might display debris and less of the 
actual sample. 

10. Draw a gate around the population of interest on the FSC vs SSC plot. 

You can rename or change the color of the gate if needed. 

11. Press SAMPLE to stop sample introduction. 

12. Remove the sample tube and press BACKFLUSH for approximately 10 
seconds. 
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More information � Optimizing with compensation controls (page 268) 

� Optimizing fluorescence detector voltages (page 271) 

Optimizing fluorescence detector voltages 

Introduction This topic describes how to optimize the fluorescence detector voltages using the 
fully stained sample or the single-color cellular compensation controls. This 
procedure uses the single-color compensation controls. 

 For cell-based compensation, adjust the voltages for the detectors before 
recording samples. 

 For bead-based compensation, adjust the voltages with a sample that contains 
fully stained (positive) and unstained (negative) cells, and verify that both 
stained and unstained cells and beads appear onscale. 

Procedure To optimize the fluorescence detector voltages: 

1. Create dot plots so that each parameter in the experiment is represented. 

2. Load a tube containing fully stained positive control (mixed with negative 
control) on the tube holder and press SAMPLE. 

3. Adjust the voltage as necessary so that the negative and positive populations 
are on scale for each parameter. 

4. In the Acquisition Dashboard, click Reset to refresh all plots. 

More information � Optimizing with compensation controls (page 268) 

� Optimizing scatter parameters (page 269) 

� Collecting data files for compensation (page 272) 
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Collecting data files for compensation 

Introduction This topic describes how to collect data files for compensation using cell controls. 

Before you begin Optimize settings for the sample. All voltages should be verified before recording 
the first compensation control. Changes to fluorescence parameter voltages during 
or after this step can result in inaccurate spillover estimates. 

Recording controls To record the unstained control: 

1. Select Cytometer > Configuration. 

The Cytometer Configuration dialog opens. 

2. In the Channels Capture tab, select the detectors you want to record for this 
experiment. 

3. Select Cytometer as the data source. 

4. In the Recording Settings pane, under Recording Rule, set the event limit 
value for your sample. 

5. Load the tube of unstained cells and press SAMPLE. 

6. In the Recording Settings pane, click Path to select where you want to save the 
FCS file for the unstained control. 

7. In the Prefix field, type a prefix (name) or type a name in the File field for the 
unstained control sample before you record data. 

8. In the Acquisition Dashboard, click Acquire, then click Record to create an 
FCS file for the unstained sample tube. 

9. Press SAMPLE and remove the sample tube. 

10. Press BACKFLUSH for 30–60 seconds. 

11. Load a tube of single-color stained cells and press SAMPLE. 

12. Repeat steps 7 to 11 to record the remaining fluorescence controls. 

Next step Defining populations for compensation (page 273) 

More information � Optimizing with compensation controls (page 268) 
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Defining populations for compensation 

Introduction This topic describes how to define populations for compensation. Compensation 
is performed by sampling a positive and negative population for each fluorescence 
parameter. The software uses these representative populations to compute the 
amount of dye spillover from each primary detector reaching other detectors. 
Compensation is computed using a compensation matrix (the inverted spillover 
matrix). 

The workflow provided is an example of performing compensation when each 
color control is in a separate tube. The same principles can be used when more 
than one color is in a tube. 

Before you begin Collect files for compensation for using cell controls. 

Procedure summary  For each single-color tube, make the FSC vs SSC gate a local gate. 

 Draw child gates for the positive population specific to the source for a single 
color. 

 The negative population will be the local FSC vs SSC gate applied from the 
unstained control sample. 

Selecting the negative To identify and select a negative control population: 
control population 

1. Add a new page to the worksheet. 

2. In the Data Sources pane, select the unstained control. 

3. Create two FSC vs SSC plots. 

4. Draw a gate around the population of interest in the first plot. 

5. Rename the gate (if needed), by typing in the Name field in the Inspector pane 
when the gate is selected (for example, Cells). 

6. In the second dot plot, change the axes to fluorescence parameters using the 
Inspector pane or by right-clicking the axes labels. For example, PerCP-Cy5.5 
vs APC. 

7. In the Gate Hierarchy pane, right-click the newly created gate (cells) and 
select Convert to Local. 

8. Select the second plot. 
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9. In the Gate Hierarchy pane, select the Hide/Show button for All Events to 
hide all events. 

10. In the Gate Hierarchy pane, select the gate that you previously created (for 
example, Cells). 

11. Draw a gate around the negative events in the second plot and rename the 
gate (for example, Negative Control). 

12. (Optional) Change the axes in the second plot to other fluorescence 
parameters and make sure that your gate for negative cells is negative in all 
the relevant parameters. 

13. Select both plots. 

14. In the Inspector pane, change the source to one of your single-color 
compensation controls. 

15. In the Gate Hierarchy pane, right-click the gate of interest (for example, Cells) 
and select Convert to Local. 

16. Change the axes in the second plot so that one of the axes displays the 
parameter that matches your single-color sample (for example, if your sample 
is an APC positive control, select APC as one of the axes on the plot). 

17. Select the gate (cells) in the Gate Hierarchy pane, and then draw a gate 
around the positive population. 

18. Rename the new population (for example, APC Control). 

19. Repeat steps 13 to 18 for the remaining compensation controls. 
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More information � Working with gates (page 194) 

� Optimizing with compensation controls (page 268) 

� Collecting data files for compensation (page 272) 

� Performing auto compensation (page 275) 

Performing auto compensation 

Introduction This topic describes how to select auto compensation parameters to build a 
compensation matrix, then select positive and negative controls and calculate 
compensation. 

About applying Perform compensation using ADC parameters. However, when the plots that use 
compensation compensation are created for sorting, create plots and gates using DSP 

parameters. 

Before you begin Gate populations for compensation using cells. 

Selecting populations for To select the population for the negative compensation control: 
the negative 

1. Click Compensation on the BD FACS Sortware sorter software toolbar. compensation control 

The Compensation pane opens. 

2. Click the Matrix tab, then click Manage Parameters. 
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The Select Compensation Parameters dialog opens. 

3. Select only the checkboxes for the ADC parameters that should be 
compensated. 

4. Click OK to apply the selections and close the dialog. 

The Matrix tab refreshes and displays the compensation matrix for the 
selected parameters. 

5. Click the Auto Compensation tab. 
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6. Make sure the list of parameters includes all parameters you want to include 
for compensation. 

7. In the Gate Hierarchy, drag the negative control gate to the Auto 
Compensation tab and into the Negative column header. 

This applies the negative control to all parameters in the Auto Compensation 
tab. 
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Selecting populations for To select populations for the positive compensation control: 
the positive 1. In the Positive column, right-click the first parameter box, select the
compensation control corresponding data source (FCS file) that contains the positive control, and 

then select the positive population. 

In the following example, the gate (FITC Positive) was created with the FITC 
positive sample and is being assigned to the FITC-positive box. You can also 
drag the required populations from the Gate Hierarchy pane or the 
population hierarchy. 

The box changes color to reflect the assigned population. You can place the 
mouse cursor over each box to view the name of the population. 

2. Repeat the assignments for the remaining parameters. 

3. Click Calculate. 

A compensation matrix is computed from the sampled spillover values 
(population medians) defined in the selected populations and uploads it into 
the Influx firmware. Any unused DSP parameters (ADC parameters that are 
not compensated) are then removed from the list of available DSP parameters. 

4. Click the Matrix tab, then select the Visualize checkbox. 

This turns on software compensation for the ADC parameters, which mimics 
the output of the DSPs. You can visually compare uncompensated data to 
compensated data by toggling the Visualize checkbox using the ADC data in 
memory, which is easier and more efficient than reloading matrixes into the 
firmware and recollecting data. 

The Visualize checkbox applies to the selected data source in the 
Compensation pane. If you are having trouble visualizing ADC compensation 
with the checkbox, verify that a spillover matrix exists for your data source (a 
compensation icon will be visible under the FCS file name in the Data Sources 
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pane) and that the data source in the Compensation pane matches the data 
source of your plots. 

Compensation is applied through the software to the ADC (raw) data of the 
data source selected for visualization only. The DSP data is the actual 
compensated data used for classifying sort decisions. You must sort on DSP-
gated parameters (hardware compensation), not on compensation-enabled 
ADC parameters (software compensation). DSP parameters are indicated by 
an asterisk (*) in front of the parameter name on the axis parameters. 

More information � Optimizing with compensation controls (page 268) 

� Defining populations for compensation (page 273) 

� Saving a compensation matrix (page 279) 

� Restoring (importing) a compensation matrix (page 280) 

Saving a compensation matrix 

Introduction This topic describes how to save a compensation matrix file so that you can 
restore specific compensation settings at any time. 

Procedure To save a compensation matrix file: 

1. In Data Sources pane, under Cytometer, right-click Compensation, then select 
Save Compensation. 

The Save Compensation Matrix dialog opens. 

2. In the Name field, type a new file name. 
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3. In the Description field, add a description about when or how this 
compensation matrix should be used. 

4. Click OK. 

The compensation matrix file is saved. You can restore (import) this 
compensation matrix for other configurations. 

More information � Optimizing with compensation controls (page 268) 

� Performing auto compensation (page 275) 

� Restoring (importing) a compensation matrix (page 280) 

Restoring (importing) a compensation matrix 

Introduction This topic describes how to load a pre-defined compensation matrix for your 
configuration. Compensation matrixes can be restored on the cytometer 
(subsequent acquired or recorded data will have ADC visualized compensation as 
well as DSP compensation) or already recorded FCS files (only ADC visualized 
compensation will be available). 

Restoring a To restore (import) a compensation matrix file: 
compensation matrix file 

1. In Data Sources pane, right-click Cytometer or another data source (FCS file), 
then select Restore Compensation. 

The Restore Compensation Matrix dialog opens. 

2. Under Compensation List, select a compensation matrix. 

3. Click OK. 

The compensation matrix file imports into the current configuration. 
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4. In the Compensation pane, click the Matrix tab, select the desired data 
source, and then select the Visualize checkbox. 

More information � Performing auto compensation (page 275) 

� Saving a compensation matrix (page 279) 
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20 
Sorting 

This section includes these topics: 

 Sort setup workflow (page 284) 

 Optimizing the droplet breakoff (page 285) 

 Selecting a pre-defined sort mode (page 287) 

 Optimizing the side streams (page 289) 

 Aligning the side streams with the sort tubes (page 292) 

 Estimating the drop delay (page 295) 

 Determining an accurate drop delay (page 300) 

 Determining the drop delay with BD FACS Accudrop (page 300) 

 Determining the drop delay using the calibration slides (page 304) 

 Determining the drop delay using the three-puddle calibration slide (page 307) 

 Saving and restoring sort layouts (page 310) 

 Monitoring the sort (page 311) 

 Working with sort reports (page 312) 

 Index sorting (page 314) 
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Sort setup workflow 

Introduction This topic describes the key workflow steps for setting up and performing a sort. 

Before you begin  Perform QC. 

 Optimize system settings for your samples. 

Workflow 
Stage Description 

1 Optimizing the droplet breakoff (page 285) 

2 Optimizing the side streams (page 289) 

3 Estimating the drop delay (page 295) 

4 Determining an accurate drop delay (page 300) 

5 Monitoring the sort (page 311) 

More information � Creating plots and gates for optimization (page 264) 

� Selecting a pre-defined sort mode (page 287) 

� Aligning the side streams with the sort tubes (page 292) 

� Saving and restoring sort layouts (page 310) 

� Working with sort reports (page 312) 

� Index sorting (page 314) 

� Fluidics pressure and drop frequency settings (page 343) 
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Optimizing the droplet breakoff 

Introduction This topic describes how to optimize the droplet breakoff. 

Droplet formation and breakoff are achieved by applying piezoelectric element to 
focus an acoustic wave into the stream at the nozzle tip. 

Procedure To optimize the droplet breakoff: 

1. Click Sort Settings on the BD FACS Sortware sorter software toolbar. 

The Sort Settings dialog opens. 

2. Under Drop Formation, enter values in the Piezo Amplitude and Drop 
Frequency fields using the mouse wheel, data slider, or keyboard keys. 

See Fluidics pressure and drop frequency settings (page 343) for starting 
values for various nozzle sizes and sheath pressure combinations. 

3. For optimal breakoff stability, adjust the piezo amplitude to a wavelength 
equal to approximately 4.5 stream diameters (approximately 0.88 times the 
nozzle size). 

Find the optimal setting for each nozzle and sheath pressure combination by 
adjusting the piezo amplitude and drop frequency. Typically, the breakoff in 
drops will be approximately half the frequency in kHz. 

� If forward scatter CVs and noise increase, the amplitude might be too 
high. 

� If the side streams spray without particles running, the amplitude might be 
too low. 

� If the side streams do not spray without particles running and start to 
spray when the particles are running, the particle might be too large for 
the nozzle size. 

Warning! Do not touch the nozzle when the piezo amplitude is on. If you 
have a clog, turn off the piezo amplitude before removing the nozzle. 
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4. Adjust the drop camera micrometer so that you can see the breakoff in the 
camera image. 

The drop camera micrometer is the silver knob located behind the forward 
scatter detector stage. 

5. In the Drop Frequency field, adjust the value to find the optimal breakoff. 

As you adjust the drop frequency, adjust the camera position as needed to 
view the breakoff. The optimal frequency has the highest breakoff while 
maintaining the proper drop spacing. 

No breakoff Initial Adjusted Highest breakoff and 
breakoff breakoff optimal frequency 

Next step  Optimizing the side streams (page 289) 

More information � Sort setup workflow (page 284) 

� Fluidics pressure and drop frequency settings (page 343) 
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Selecting a pre-defined sort mode 

Introduction This topic describes how to select a pre-defined sort mode. 

You can select sort modes in the Sort Settings pane in the Sort Layout pane. 

Procedure To select a sort mode: 

1. Click Sort Settings on the BD FACS Sortware toolbar. 

The Sort Settings dialog opens. 

2. Under Sort Mode, select a pre-defined sort mode from the menu: 

� 1.0 Enrich, Pure, Single, or Yield 

� 1.5 Enrich, Pure, or Yield 

� 2.0 Enrich, Pure, or Yield 

See Sort modes (page 205) for more information about sort modes and 
coincidence. 

The coincidence scale is a graphical rendering of a drop divided into 16 time 
slices. Extra coincidence is the number of time slices to add to the default one 
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drop. The Extra Coincidence scale automatically displays the pre-defined 
phase mask and any extra coincidence for the selected mode. 

Extra coincidence scale 

Phase mask scale 

More information � Using the Sort Settings pane (page 204) 

� Sort setup workflow (page 284) 

� Optimizing the droplet breakoff (page 285) 
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Optimizing the side streams 

Introduction This topic describes how to optimize the side stream deflection by flash charging 
the stream. 

Optimizing the side streams ensures that the drop charge is in phase with the drop 
formation, which provides the highest recovery of cells when sorting. 

Before you begin 

Warning: Electrical! Do not touch the plates when the voltage is on. The PLATES 
button illuminates when the voltage is on. 

 Power down the deflection plates, clean them with DI water, and dry them 
completely. 

 Make sure that a flask is in place on the sort tray in the Safe position to catch 
the test stream. 

 Make sure that stream breakoff has been optimized. 

Adjusting the side To adjust the side stream deflection: 
streams with a flash 

1. Verify that the deflector plates voltage is turned off.charge 

2. Close the deflections plates (by hand). 

3. Press the PLATES button to turn on the high-voltage plates. 

The PLATES button illuminates when the voltage is on. 

4. Click Sort Layout on the BD FACS Sortware sorter software toolbar. 

The Sort Layout dialog opens. 

5. Place a flask on the sort tray and make sure it is centered. 

6. Click Safe to move the sort tray so that the flask is centered with the stream. 

7. Under Sort Device, select your sort device (2 Tube Holder - 2 Way Sort in this 
example). 

The left and right sort streams appear in the Sort Layout pane. 
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8. Click Sort Settings on the BD FACS Sortware sorter software toolbar. 

The Sort Settings pane opens. 

9. Under Stream, click Test Streams to charge the droplets and charge the side 
sort stream. 

Sort streams should now be visible in the sort stream monitor. 

10. If the streams are fanning or not visible, adjust the piezo amplitude. 

11. Under Stream, adjust the Maximum Drop Charge (Volts) so that the sort 
streams flow past the drain. 

� If the sort streams hit the plates, the gain is too high. 

� If the sort streams do not flow past the drain, the gain is too low. 

� If the side streams are not visible, make sure that they are not hitting the 
deflection plates by reducing the Maximum Drop Charge (Volts) value. 

12. Click Flash Charge to test the droplet charge. 

If the charge is not in phase with the droplets, the side streams are not 
optimally deflected. 
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13. Under Drop Formation, in the Piezo Amplitude field, adjust the amplitude 
until the side streams are deflected. 

Before amplitude adjustment After amplitude adjustment 

Fanning of 
main stream 

14. Under Stream, click Flash Charge again to turn it off. 

15. Under Stream, adjust the Stream Focus value to minimize the center stream 
fanning. 

Before stream focus adjustment After stream focus adjustment 

Residual charge 
on drops 

16. Click Test Streams to turn off the side stream deflection. 

17. Use the BD Influx drop monitor to visually verify that the piezo amplitude can 
be increased or decreased without drastic change to the breakoff. 

18. View and note how the drops are connected and note the size of the small 
detached droplet after the last connected drop. 

The droplet shape must remain constant while sorting. You might need to 
adjust the piezo amplitude while sorting to keep the shape of the drop at the 
breakoff constant. 
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Next step  Estimating the drop delay (page 295) 

More information � Sort setup workflow (page 284) 

� Selecting a pre-defined sort mode (page 287) 

Aligning the side streams with the sort tubes 

Introduction This topic describes how to align the side streams with the sort tubes. 

Procedure To align the side streams with the sort tubes: 

1. Click Sort Layout on the BD FACS Sortware sorter software toolbar. 

The Sort Layout pane opens. 

2. Click Eject to move the sort tray into the loading position. 

3. Load the tube or sort device you are planning to sort with. 

4. Under Sort Device, select the corresponding sort device. 

5. Place the appropriate number of tubes in the desired positions in the sort 
device. 

6. Place a microscope slide over the tubes. 

7. Click Sort Ready to move the sort tray to the sort ready position. 

8. Click Test Streams (two times quickly) to deposit a small puddle over the 
tubes. 
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9. Click Eject to access the sort tray and verify that the drops are aligned with 
the center of the tubes. 

Side view 

Properly aligned puddle on slide 

Slide on tube 

  

 

 

Top view 

10. If the puddles are not aligned over the tubes, adjust the deflection gain and 
repeat steps 2 through 9 until the side streams are aligned with the sort tubes. 

11. Adjust your tray control position if needed. 

� If the streams are hitting too far forward or backward, open the tray 
control pane and adjust the Y position to align the sort device with the 
streams. 
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� Click  Set Home to save the X and Y coordinates for the chosen sort 
device. 

More information � Sorting (page 283) 

� Sorted sample collection (page 59) 

� Sort setup workflow (page 284) 

� Optimizing the side streams (page 289) 
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Estimating the drop delay 

Introduction This topic describes the delay calculator and the drop camera and provides a 
procedure for estimating the drop delay. The drop delay is usually about half the 
value of the drop frequency. 

Use the delay calculator to approximate the delay and set the course adjustments 
for the starting position of the laser, where the drop starts, where the drop breaks 
from the stream, and where the drop ends. After determining the approximate 
drop delay using the camera, you can use BD FACS Accudrop or sort onto slides 
to determine the drop delay more accurately. 

About the delay Use the delay calculator to approximate the drop delay. You need to enter the 
calculator drop camera position at each of the four points indicated in the delay calculator to 

estimate the drop delay. 

About the drop camera The drop camera is located behind the back plate and between the two objective 
lenses. 

Nozzle assembly (shown without 
nozzle tip) 

Objective lenses 

Drop camera 

Use the drop camera micrometer (the silver adjustment knob located behind the 
nozzle assembly) to adjust the vertical position of the drop camera in relationship 
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to the stream. The resulting position value is displayed in the drop position 
display on the pressure console. 

Drop camera position 

You can view the drop camera live image on the drop monitor (the middle LCD 
monitor on the sort monitoring rack). 

Drop monitor 

Before you begin Optimize the droplet breakoff and frequency. 

Finding the location of To find the location of the first laser: 
the first laser 

1. Open the nozzle chamber door. 

2. Adjust the micrometer for the camera to move it up to the top of the stream. 

The camera is at the top when you see the nozzle tip in the drop monitor. 
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3. Mark the bottom of the nozzle with a piece of tape as shown in the following 
figure. 

Nozzle tip 

Stream 

4. Adjust the silver vertical adjustment knob to move the nozzle stage down to 
the first pinhole. 

The nozzle is visible as a dark shadow in the pinhole monitor. 

Nozzle tip 

Center of pinhole 1 

5. Enter the drop camera position in the Laser field. 
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This is the position of your first laser or first pinhole. 

First laser position 

This number is constant for each instrument. Save this number for future use. 

6. Move the nozzle back to its original position just out of the view of the 
pinhole monitor. 

7. Close the nozzle chamber door, and reset the laser safety interlock by placing 
your finger on the reset sensor. 

Locating the breakoff To locate the breakoff position: 
position 

1. Adjust the camera micrometer so that the breakoff is in view on the drop 
camera monitor. 

2. On the drop monitor, use a piece of tape to create a visual marker that 
indicates the position of the breakoff. 

Tape as a visual marker 
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3. Under Delay Calculator, enter the drop camera position in the Breakoff field. 

This converts the distance from the laser to the breakoff into the number of 
drops. 

Finding the Start 10 To find the Start 10 Drops position: 
Drops position 

1. Move the drop camera micrometer up five drops. 

2. Under Delay Calculator, enter the drop camera position in the Start 10 Drops 
field. 

Determining the End 10 To determine the End 10 drops position: 
Drops position 

1. Adjust the micrometer for the camera to move the camera down, counting ten 
drops from the Start 10 Drops position in the drop monitor. 

2. Position the drop camera so that the marker on your screen is at the end of 
ten drops, halfway between drops. 

3. Under Delay Calculator, enter the drop camera position in the End 10 Drops 
field. 

This measures 10 drops in camera units. 

4. Click Calculate to get the estimated drop delay. 

The calculator converts the number of drops into time using the frequency 
(drops/second). The estimated drop delay appears and is automatically set. 

Next step  Determining an accurate drop delay (page 300) 

More information � Sort setup workflow (page 284) 

� Aligning the side streams with the sort tubes (page 292) 
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Determining an accurate drop delay 

Introduction This topic list the different options for determining a more accurate drop delay. 

After you approximate the drop delay using the drop camera and the Drop 
Calculator, you can use BD FACS Accudrop or sort onto slides to determine the 
drop delay more accurately. 

Drop delay workflow You can perform any of the following drop delay workflow options. 
options 

 Determining the drop delay with BD FACS Accudrop (page 300) 

 Determining the drop delay using the calibration slides (page 304) 

 Determining the drop delay using the three-puddle calibration slide 
(page 307) 

More information � Sort setup workflow (page 284) 

� Aligning the side streams with the sort tubes (page 292) 

� Estimating the drop delay (page 295) 

Determining the drop delay with BD FACS Accudrop 

Introduction This topic describes how to determine a drop delay with BD FACS Accudrop. 

BD FACS Accudrop technology is a method for determining precise drop delay on 
the BD Influx cell sorter. 

How drop delay is 
determined 

To determine the drop delay, the streams are illuminated by the Accudrop laser 
just below the deflection plates. When the Accudrop optical filter is in place, 
Accudrop beads can be viewed in the center and side streams as the drop delay 
value is adjusted. The most precise drop delay value yields the most particles in 
the side streams and the fewest in the center stream. 

Before you begin  Determine the course drop delay value using the drop camera. 

 In a tube, mix approximately one drop of BD FACS Accudrop beads (BD Part 
No. 345249) in 0.5 mL of filtered phosphate buffered saline (PBS) or sheath 
fluid. 

 Use the delay calculator to estimate a starting point for Accudrop. 

See Estimating the drop delay (page 295) for more information 
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Determining the drop To determine the drop delay: 
delay 1. Load the tube of Accudrop beads onto the cytometer. 

2. Adjust the sample offset knob to achieve an event rate between 1,000 and 
3,000. 

You might need to further dilute the beads to reduce coincidence abort rates 
when setting up the system at lower pressures or when using a large nozzle tip 
size. Larger nozzles and/or lower pressure produces larger drops, so with the 
same event rates there is higher chance of two cells ending up in one drop and, 
therefore, being aborted. 

3. In the worksheet, create a large gate encompassing all events except debris of 
an FSC vs SSC plot. 

This gate should include all bead populations (including aggregates). 

Selecting the sort mode To select the sort mode: 

1. Click Sort Layout on the BD FACS Sortware sorter software toolbar. 

The Sort Layout pane opens. 

2. Under Sort Device, select Accudrop Setup. 

The sort mode defaults to 1.0 Drop Enrich and the Unlimited checkbox is 
checked. 

3. Right-click the sort target and select a population (for example, P1). 
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Alternatively, drag a population from a gate hierarchy or population 
hierarchy. 

Starting the sort To start the sort: 

1. Click Sort Ready. 

2. In the Sort Layout pane, click Start. 

You can monitor the sort data in the sort target. 

Sort target during sorting 

With the Accudrop filter in place, you can view the stream using the sort 
stream monitor. 

Setting up the Accudrop To set up the Accudrop filter: 
filter 

1. On the Accudrop assembly, turn the Accudrop filter selection knob to the 
Accudrop optical filter position. 

2. Ensure that the laser safety cover is closed. 
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Determining the drop To determine the drop delay: 
delay 

1. Locate the drop delay field in the Sort Settings dialog, under Delay Calculator, 
next to the Calculate button. 

2. Notice the brightness of the beads being sorted to the left and to the center 
(waste bucket) in the drop camera. 

3. Adjust the drop delay value while monitoring the center and left sort streams. 

The correct drop delay is set when center stream is dark (or not present) and 
the left stream is bright. 

The following figure illustrates correct and incorrect drop delays with the 
Accudrop filter in place. The image background color has been altered for 
illustrative purposes. 

The incorrect drop delay image shows that the illuminated beads are going to 
the waste bucket. The correct drop delay image shows that the illuminated 
beads are being sorted to the left. 

Incorrect drop delay with 
beads sorted to waste 

Correct drop delay with 
beads sorted to the left 

Next step  Monitoring the sort (page 311) 
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More information � Aligning and optimizing the optics workflow (page 242) 

� Sort setup workflow (page 284) 

Determining the drop delay using the calibration slides 

Introduction This topic describes how to test the estimated drop delay value to determine the 
precise drop delay by distributing multiple drops onto a coarse calibration 
microscope slide. 

A precise drop delay setting gives you the best sort results. There are multiple 
ways to sort onto a slide to determine the delay. This section describes the 
calibration slide method. 

Required materials  Fluorescent beads (larger beads are easier to see and count on the slide) 

 Slides 

 A fluorescence microscope 

Before you begin Prepare a tube of fluorescent beads. 

Preparing a calibration To prepare a calibration slide: 
slide 

1. Run a tube of fluorescent beads. 

2. Create an FSC vs FL1 plot. 

3. Draw a gate around the main bead population in the plot. 

4. Adjust the Sample Offset knob to achieve an event rate between 100 and 
1,000 beads per second. 

5. Click Sort Layout on the BD FACS Sortware sorter software toolbar. 

The Sort Layout pane opens. 

6. Click Eject to access the sort tray. 

7. Place a microscope slide in the front position of the sort tray insert. 

Sorting onto a calibration To sort onto a calibration slide: 
slide 

1. In the Sort Layout pane, under Sort Device, select Coarse Calibration Slide. 
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The Sort Mode and Sort Limit settings update automatically and reflect pre-
defined values for the coarse calibration slide. 

2. Select all wells and select the population to sort. For example, P1. 

This is the population you created for the main bead population. 

A1 sort target with the P1 population selected. 

 

  

   

  
 

 

 

  

  

3.  Ensure that the left side stream is aligned with the A1 location of the slide. 

a. Click Sort Ready. 

b. Click Start, then click Stop quickly to deposit a single drop onto the slide. 

c. If the test drop is not aligning with the A1 location of the slide, adjust the 
sort tray position settings. 

See Controlling the sort tray position (page 219) for more information. 

4. Click Sort Ready. 

5. Click Start to start the sort. 

The Sort Drop Delay dialog opens once the sort is complete. Do not close this 
dialog until you have determined the proper delay in the next step. 

6. Using a fluorescence microscope, count the number of beads in each puddle 
and identify which well contains the most events. Optimal delay is the drop 
delay in the well containing the most events. 
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7. In the Sort Drop Delay dialog, click the drop delay setting that corresponds to 
the drop with the highest bead counts. 

8. Click OK to set the drop delay. 

9. In the Sort Layout pane, select Sort Device > Coarse Calibration Slide, and 
repeat steps 1 through 8. 

Next step  Monitoring the sort (page 311) 

More information � Saving and deleting settings (page 115) 

� Sort setup workflow (page 284) 

� Determining an accurate drop delay (page 300) 
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Determining the drop delay using the three-puddle calibration 
slide 

Introduction This topic describes how to determine the drop delay using the optional three-
puddle calibration slide. This procedure provides an alternate method for 
determining the precise drop delay. 

In this method, rather than counting the events, the perceived density of events in 
the puddles is used to determine the delay. 

Before you begin Prepare the slide as described in Preparing a calibration slide (page 304). 

Procedure To determine a precise drop delay using the three-puddle method: 

1. In the Sort Layout pane, under Sort Device, select 3 Puddle Calibration Slide. 

The Sort Mode and Sort Limit settings update automatically and reflect pre-
defined values for the three-puddle calibration slide. 

2. Select all wells and select the population to sort. For example, P1. 

This is the population you created for the main bead population. 

A1 sort target with the P1 population selected 

 
 

   

 

 

 

 

  3. Ensure that the left side stream is aligned with the A1 location of the slide. 

a. Click Sort Ready. 
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b. Click Start, then click Stop (quickly) to deposit a single drop onto the 
slide. 

c. If the test drop is not aligning with the A1 location of the slide, adjust the 
sort tray position settings. 

See Controlling the sort tray position (page 219) for more information. 

4. Click Sort Ready. 

5. Click Start to start the sort. 

The Sort Drop Delay dialog opens once the sort is complete. Do not close this 
dialog until you have determined the proper delay in the next step. 

6. Using a fluorescence microscope, view the slide with the three sorted puddles 
to visually determine which puddle contains the most events. 

7. In the Sort Drop Delay dialog, click the drop delay setting that corresponds to 
the puddle with the highest bead counts. 

8. Click OK to set the drop delay. 

9. Repeat steps 1 through 8 until the first and third puddles contain an even 
amount of events. 

10. If the first and third puddles continue to have uneven event density, perform a 
sort in smaller increments. 
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11. Open the sort tray and change the delta drop delay value to less than 1. 

12. Click Start to sort. 

13. Repeat steps 5 through 9 until the first and third puddles contain 
approximately the same amount of events. 

Next step  Monitoring the sort (page 311) 

More information � Determining an accurate drop delay (page 300) 
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Saving and restoring sort layouts 

Introduction After you have set up your sort, you can save all sort settings in the Sort Settings, 
Sort Layout, and Tray Control panes. 

About saving and 
restoring sort layouts 

You can save a sort layout and restore it at any time. Note that the sort layout is 
also saved when you save a workspace. If you save a specific sort layout 
separately, you can restore it and apply it to any workspace. 

See Saving and restoring settings (page 112) for more information about what 
information is saved. 

Saving a sort layout To save a sort layout: 

1. Select File > Save > Sort Layout. 

The selected Save Sort Layout dialog opens. 

2. Select the storage folder where you want to save this settings file from the 
Storage menu. 

See Creating storage folders (page 117) for more information about creating 
custom storage folders. 

3. Under Sort Layout Details, type a name for the new settings file in the Name 
field. 

4. Click OK to save the workspace and close the dialog. 

Restoring a saved sort To restore a saved sort layout: 
layout 

1. Select File > Restore > Sort Layout. 

The selected Restore Sort Layout dialog opens. 

2. Under Sort Layouts, select the layout you want to restore. 

3. Click OK. 

The Sort Layout dialog reflects the restored layout. 
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Monitoring the sort 

Introduction This topic describes how to monitor the sort for best results. 

The timing of when a drop is charged is defined during the sort setup. It is 
important to monitor the sort to ensure that the breakoff does not change. It is 
also important to maintain the same scatter and population percentages during 
the sort. 

This section provides useful tips to maintain a successful sort. 

Before you begin  Make sure that you have removed bubbles from the fluidics tubing. 

 Turn on the deflection plates. 

 Filter all samples to 40 mm (about half of the nozzle tip size) to prevent nozzle 
clogs and ensure optimal sorting. 

 Load a sample tube. 

 Record data to create pre-sort FSC files. 

Monitoring the sort To monitor the sort: 

1. View the scatter plot in the worksheet and slowly adjust the flow rate. 

Stop increasing the sample flow rate when: 

� The scatter populations shift or change shape. 

� The sorting efficiency counter is unacceptably low. 

2. Monitor the following. 

Category What to look for Troubleshooting 

Efficiency counter Efficiency varies 
depending on population 
percentages and sample 
concentration. 

Decrease the flow rate to 
improve sorting efficiency. 

Gates and 
populations 

Populations should stay 
within the gates and 
should not move during 
the sort. 

Decrease the flow rate or adjust 
the gates. Refresh the plot 
display rate often to confirm 
that populations have not 
moved out of the gate. 

Drop monitor Breakoff should be stable 
and remain at the same 
drop. 

Adjust the piezo amplitude to 
keep the breakoff at the same 
drop. 

Stream monitor Side streams should not 
fan or spray out of the 
drain. 

 Verify that the nozzle is 
large enough for the cells 
being sorted. 

 Adjust the piezo amplitude 
slightly. 

 Filter the cells before 
sorting. 
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Saving a sort To save a sort if a clog appears during a sort: 

1. Quickly turn off the deflection plates, stop the sample flow, and stop the 
stream. 

2. If you are working with nonhazardous materials, remove the collection device 
to avoid contamination with unwanted cells. 

More information � Sort setup workflow (page 284) 

� Working with sort reports (page 312) 

Working with sort reports 

Introduction This topic describes how to preview and print sort reports after a sort completes 
and how to save them as PDF files. 

Viewing a report To view a sort report: 

1.  Under Sort Report, click Preview. 
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The Report Dialog opens. 

Printing a sort report To print a sort report: 

1. View a sort report. 

2. In the Report Dialog, click the Print button on the toolbar. 

3. Complete your typical printing procedure. 

Creating a PDF version of To create a PDF sort report: 
a sort report 

1. View a sort report. 

2. In the Report Dialog, click the PDF button on the toolbar. 

The Select PDF Output File dialog opens. 

3. In the Save in field, select a folder. 

4. In the File name field, type a new name for the report. 

5. Click Save. 

More information � Sort setup workflow (page 284) 

� Monitoring the sort (page 311) 
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Index sorting 

Introduction This topic describes index sorting. 

Index sorting places cells from sort regions into wells on a plate or on a slide. You 
can use this feature to ensure that a sorted cell with a specific phenotype has been 
sorted. Index sorting is useful in characterizing subpopulations of phenotypically 
similar events using post-sort genetic, chemical, and/or metabolic applications. 

Index sorting onto a plate To set up for index sorting: 
or slide 

1. In the Compensation pane, click Manage Parameters and verify that there are 
at least two unassigned parameters. 

If all parameters are assigned, clear at least two compensation parameters 
from the ADC list before starting index sort mode. The FSC and SSC DSP 
channels are typically not needed for compensation and can be used for index 
sorting. 

2. On the BD FACS Sortware sorter software toolbar, click Sort Layout. 

3. In the Sort Layout dialog, select a multi-position sort device: 

� Default multi-position formats including: 6 Well Tray, 24 Well Tray, 96 
Well Tray, 384 Well Tray, and Ampligrid Slide. 

� Custom multi-position formats. 
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4. Under Sort Mode, select 1.0 Drop Single Sort mode. 

5. Under Sort Limit, set the sort limit to 1. 

6. Prepare the sort chamber for sorting by cleaning the deposition area and 
installing a sort device onto the sort tray. 

7. Align the side streams to the sort device using the Sort Settings dialog and the 
Tray Control pane. 

8. Verify that the software is not currently acquiring data. 

9. Install the sample tube onto the sample station and press the SAMPLE button. 

10. (Optional) Run some sample and view the plots to ensure that the voltages, 
compensation, sort gates, and event rate are appropriate. 

11. In the Sort Layout dialog, assign populations to each well sort target. 

See Index sorting onto a plate or slide (page 314) for more information. 

12. Add a statistics view that has the medians of the parameters of interest. 

Starting an index sort To start an index sort: 

1. Make sure the software is not currently acquiring data. 

Acquisition must be stopped so that Index Sort Mode acquisition can start. 

2. In the Sort Layout pane, click Sort Ready. 
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3. In the Sort Layout pane, click Start Index Sort Mode. 

Data is continually recorded and displayed while index sort mode is running. 

Index sort mode creates a CSV file where all the sort deposition information and 
tray position information is stored on an event-by-event basis. All the events are 
stored in the file, including those not actually sorted. You can import this CSV file 
into a spreadsheet to review the results. 

Once the sort is complete, you must manually end index sort mode. 

Analyzing the index sort To analyze the index sort: 

1. In the Inspector for plots, select Large from the Dot Size menu. 

2. In the Data Sources pane, double-click the Index Sort Analysis for the index 
sort data source of interest. 

3. In the Index Sort Analysis and Report dialog, select one or more locations to 
display on plot(s). 
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To select multiple locations, wait for the crosshairs to appear, then drag your 
mouse to include locations of interest. 

Viewing index sort results You can generate an index sort report CSV file that you can import into a 
in a spreadsheet spreadsheet to view the results for each sort. 

To generate the index sort report CSV file: 

1. Right-click the statistics view associated with the plot you used for index 
sorting and select Export Index Sort Statistics. 

The Select Output File dialog appears. 

2. Navigate to the folder where you want to save index sort reports, then select 
the CSV file type. 

3. Click Save. 

4. Open your spreadsheet application and open the index sort report as a CSV 
file. 
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The following figure shows an example an index sort report for an AmpliGrid 
slide. To add Tray X and Tray Y medians, include them in your statistics view. 

Positive sorts are typically indicated by numbers of 100 or higher. Index sorting 
may occasionally report additional sort events in a well even though the correct 
number was sorted. 

More information � Sort setup workflow (page 284) 
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System shutdown 

This section includes these topics: 

 System shutdown workflow (page 320) 

 Cleaning the sample line (page 321) 

 Installing the debubble reservoir (page 322) 

 Rinsing the system (page 323) 

 Drying the fluidics lines (page 324) 

 Cleaning the sort chamber (page 325) 

 Turning off the power (page 326) 
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System shutdown workflow 

Introduction This topic describes the workflows for performing a wet or dry shutdown of the 
system. 

If you perform a wet shutdown, your startup workflow (the next day) is different 
than if you perform a dry shutdown. See Startup workflow (page 224) for more 
information. 

About wet shutdown Wet shutdown is useful when you plan to use the BD Influx sorter the next day 
and you do not need to run a specific cleaning or decontamination protocol as a 
part of your daily maintenance. 

Wet shutdown workflow 
Stage Description 

1 Cleaning the sample line (page 321) 

2 Installing the debubble reservoir (page 322) 

3 Turning off the power (page 326) 

About dry shutdown Dry shutdown is required when you need to prepare the system for a period of 
non-use, or when you want to run a specific cleaning or decontamination protocol 
in preparation for instrument service or maintenance. 

Dry shutdown workflow 
Stage Description 

1 Cleaning the sample line (page 321) 

2 Rinsing the system (page 323) 

3 Drying the fluidics lines (page 324) 

4 Cleaning the sort chamber (page 325) 

5 Turning off the power (page 326) 

More information � Instrument cleaning and maintenance (page 71) 

� Startup workflow (page 224) 
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Cleaning the sample line 

Introduction This topic describes how to clean the sample line for a wet or dry shutdown. 

Required materials  Sample tubes 

 10% bleach solution 

 Deionized (DI) water 

Procedure To clean the sample line for a shutdown: 

1. Load a tube of 10% bleach and run it for 5 minutes. 

2. Load a tube of DI water and run it for 5 minutes. 

3. Perform the following steps for the wet or dry shutdown workflow: 

Shutdown workflow Next steps 

Wet shutdown  Leave the tube of DI water on the sample holder. 

 Continue with Installing the debubble reservoir 
(page 322) 

Dry shutdown  Remove the tube from the sample holder. 

 Continue with Rinsing the system (page 323) 

Next step  Installing the debubble reservoir (page 322) 

More information � System shutdown workflow (page 320) 
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Installing the debubble reservoir 

Introduction This topic describes how to use the debubble reservoir for a wet shutdown. 

Required materials  Debubble reservoir 

 DI water 

 Flush bucket 

Procedure To install the debubble reservoir: 

1. Fill the debubble reservoir with DI water. 

2. Place it on top of the flush bucket. 

3. Verify that the nozzle tip is submerged in the water in the dubble reservoir. 

4. Press RUN to stop running the stream. 

Next step Turning off the power (page 326) 

More information � Pressure regulation and monitoring (page 37) 

� Startup and troubleshooting components (page 225) 

� System shutdown workflow (page 320) 
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Rinsing the system 

Introduction This topic describes the cleaning procedure to complete a dry shutdown. 

Required materials  1 L of DI water for the sheath tank 

 Flush bucket 

Before you begin Clean the sample line. 

Procedure To clean the system for dry shutdown: 

1. Press RUN to turn off the stream. 

2. Remove the DI water tube. 

3. Turn off the air supply by switching the AIR switch on the pressure console 
off. 

4. Empty the sheath tank and fill it with 0.5–1.0 L of DI water. 

5. Reattach the sheath tank and turn the air on. 

6. Install the flush bucket. 

7. Turn on the air supply. 

8. Press RINSE and then BACKFLUSH to rinse all fluid lines with DI water until 
the tank runs dry and the sample line is no longer dripping water. 

9. Press RINSE to turn off the flow. 

Next step  Drying the fluidics lines (page 324) 

More information � System shutdown workflow (page 320) 
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Drying the fluidics lines 

Introduction This topic describes how to dry the fluidics lines for a dry shutdown. 

Required materials  DI water 

 Flush bucket 

Procedure To dry the fluidics lines: 

1. Remove the nozzle tip. 

2. Place the flush bucket under the nozzle. 

3. Release the pressure in the sheath tank by opening the pressure release valve. 

4. Bypass the sheath filter by disconnecting the air and fluid lines from the 
sheath tank and connecting them to each other. 

5. Press RINSE, then press BACKFLUSH. 

6. Allow air to blow through the system for about 10–15 minutes to completely 
dry it. 

7. Turn off the system AIR switch on the side of the pressure console. 

8. Turn off the house air and vacuum supply. 

9. Empty all fluid from the waste and sheath tanks, rinse them with clean DI 
water, and allow them to dry overnight. 

Next step  Cleaning the sort chamber (page 325) 

More information � Removing and replacing the nozzle tip (page 81) 

� Bypassing the sheath filter (page 75) 

� System shutdown workflow (page 320) 

� Rinsing the system (page 323) 
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Cleaning the sort chamber 

Introduction This topic describes how to clean the sort chamber for a dry shutdown. 

Required materials  DI water 

 Kimwipesor other lint-free towel 

Procedure 

Caution: Biohazard! Wear protective clothing before cleaning the sort chamber. 

To clean the sort chamber: 

1. Verify that the deflection plates are off. 

2. Open and clean the deflection plates with DI water. 

3. Wet a Kimwipeswipe or other lint-free towel and wipe any spills in the sort 
chamber or sample port area. 

4. Wet a Kimwipeswipe or other lint-free towel with DI water and wipe again. 

Next step  Turning off the power (page 326) 

More information � Deflection plate power (page 67) 

� Cleaning and inspecting the instrument (page 72) 

� Bypassing the sheath filter (page 75) 

� System shutdown workflow (page 320) 
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Turning off the power 

Introduction This topic describes how to turn off the system power for a wet or dry shutdown. 

Procedure To turn off power for shutdown: 

1. Save your workspace, if needed. 

2. Select Cytometer > Shutdown Cytometer, then click OK. 

The cytometer interface is now disconnected from the instrument electronics 
and will turn off automatically. 

3. Exit Sortware software. 

4. Exit Windows and turn off the computer. 

5. Turn off the system auxiliary power. 

6. Turn off the air supply by turning off the pressure console, if needed. 

7. Turn off all lasers. 

8. Turn off the main power. 

9. Turn off the house vacuum and air supply. 

10. Depressurize the sheath tank by opening the release valve. 

More information � Power distribution (page 64) 

� Cleaning and inspecting the instrument (page 72) 

� System shutdown workflow (page 320) 

� Cleaning the sort chamber (page 325) 



 

 

Part 4
 Reference 

This part includes these sections: 

 Chapter 22: System reference information (page 329) 

 Chapter 23: BD Influx options (page 347) 

 Chapter 24: Troubleshooting (page 363) 
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System reference information 

This section includes these topics: 

 System specifications (page 330) 

 Sort performance (page 331) 

 Optical detector modules (page 333) 

 Fluorescence specifications (page 341) 

 Fluidics pressure and drop frequency settings (page 343) 

 Fluidics specifications (page 344) 

 Electronics and signal processing specifications (page 345) 
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System specifications 

Introduction This topic describes the power and environment requirements, and provides 
dimensions for the BD Influx HEPA-filtered enclosure, table, and cytocart. 

Operating environment 
and requirements Item Requirement 

Main voltage (North 
American models) 

No HEPA-filtered enclosure: 115–120 VAC/60 Hz, 8 A 

With HEPA-filtered enclosure: 115–120 VAC/60 Hz, 12 A 

Main voltage (European 
models) 

No HEPA-filtered enclosure: 220–240 VAC/50 Hz, 5A 

With HEPA-filtered enclosure: 220–240 VAC/50 Hz, 8 A 

Temperature 18–25°C (65–77°F) 

Humidity 5–80% non-condensing 

Air pressure 90 PSI/6.2 bar/183 in. Hg, Max. 0.2 L/min @ 60 PSI 

Room noise <80 dBA, accumulated noise from all running equipment 
(without the HEPA enclosure) 

Heat output Maximum output estimated to be 6,200 BTU/h, laser 
choice dependent 

Vacuum 2.5 PSI/0.17 bar/5.09 in. Hg or greater, 50 L/min 
recommended 

Electrical requirements 
for hood enclosure 

One 110 V/15 A circuit 

Table dimensions There are two tables available: the standard table and the extended table. 

Item Dimensions (W x D x H) 

Standard table 77 x 77 x 89 cm (30 x 30 x 35 in.) 

Extended table 77 x 102 x 89 cm (30 x 40 x 35 in.) 

Cytocart dimensions There are two cytocarts available: the standard cart and the HEPA-filtered cart. 

Item Dimensions (W x D x H) 

Standard cytocart 117 x 89 x 82 cm (46 x 35 x 32 in.) 

HEPA-filtered cytocart See HEPA enclosure specifications (page 388) for more 
information. 
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More information � System reference information (page 329) 

� Sort performance (page 331) 

� Optical detector modules (page 333) 

� HEPA enclosure specifications (page 351) 

Sort performance 

Introduction This topic describes sort performance characteristics. 

Drop drive frequency Adjustable 9–180 kHz 

Purity and yield At 60 PSI and 100 kHz with an average threshold rate of 25,000 events per 
second, a four-way sort achieves a purity of 98% and a yield >80% of Poisson’s 
expected yield for all four populations. Higher threshold rates, even rates 
exceeding the droplet formation rate, can be achieved without affecting purity. 
However, yield will decrease based on Poisson statistics. 

Viability As shown in published literature, sorts performed using murine and human cells 
and/or cell lines demonstrated good recovery and viability in several experimental 
systems. Optimal sort conditions need to be established for different cell types. 

Sort collection devices All collection devices are designed to fit on the Computerized Cell Deposition Unit 
(CCDU). The CCDU is standard on all instruments. 

The following sort collection devices can be used with CCDU: 

 Two-way sorting. Microtubes, 12 x 75-mm, 15-mL, and 50-mL tubes 

 Three-way sorting. One 50-mL tube and two 12 x 75-mm tubes 

 Four-way sorting. Microtubes, 12 x 75-mm tubes 

 Plates and slides. 6, 24, 48, 96, and 384-well plates; slides; and user-defined 
collection devices 

Nozzles  70 m 

 86 m 

 100 m 

 140 m 

 200 m (optional) 
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Sort monitoring  Live video feed of waste collection and side streams. 

 Live video feed of the breakoff point. 

 Drop delay determination through a semi-automated sort protocol on 
microscope slides using the CCDU. 

More information � System reference information (page 329) 

� System specifications (page 330) 

� Optical detector modules (page 333) 
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Optical detector modules 

Introduction This topic provides reference information for optic placement in the PMT 
modules. 

The following illustration shows an optical bench layout that includes: 488 nm 
excitation, scatter, and FITC, PE, PI, PE-Cy5, PerCP, and PE-Cy5.5 detectors. 

355-nm module (1 PMT) The following tables are grouped by wavelength. 

Layout PMT module Longpass filter Bandpass filter 

355-A 1: 400 LP 2: 460/50 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Highest wavelength filter 

Dichroics: 

A: Dichroic empty 
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355-nm module (2 PMTs) 

405-nm module (2 PMTs) 

Layout PMT module Longpass filter Bandpass filter 

355-A 1: 400 LP 

A (dichroic): 550 LP 

2: 460/50 BP 

3: 670/30 BP 

355-B 1: 364 LP 

A (dichroic): 440 LP 

2: 406/15 BP 

3: 530/40 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Middle wavelength filter 

3. Highest wavelength filter 

Dichroics: 

A: Dichroic 

Layout PMT module Longpass filter Bandpass filter 

405-A 1: 420 LP 

A (dichroic): 480 LP 

2: 460/50 BP 

3: 550/50 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Middle wavelength filter 

3. Highest wavelength filter 

Dichroics: 

A: Dichroic 
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488-nm module (2 PMTs) 

488-nm module (3 PMTs) 

Layout PMT module Longpass filter Bandpass filter 

488-A 1: 505 LP 

A (dichroic): 550 LP 

2: 530/40 BP 

3: 580/30 BP 

488-B 1: 505 LP 

A (dichroic): 527 LP 

2: 513/17 BP 

3: 542/27 BP 

488-C 1: 505 LP 

A (dichroic): 600 LP 

2: 530/40 BP 

3: 692/40 BP 

488-D 1: 505 LP 

A (dichroic): 550 LP 

2: 530/40 BP 

3: 610/20 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Middle wavelength filter 

3. Highest wavelength filter 

Dichroics: 

A: Dichroic 

Layout PMT module Longpass filter Bandpass filter 

488-A 1: 505 LP 

A (dichroic): 550 LP 

B (dichroic): 685 LP 

2: 530/40 BP 

3: 670/30 BP 

4: 710/50 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Second lowest wavelength filter 

3. Second highest wavelength filter 

4. Highest wavelength filter 

Dichroics: 

A: Lowest wavelength dichroic 

B: Highest wavelength dichroic 
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488-nm module (4 PMTs) 

Layout 
PMT 
module Longpass filter Bandpass filter 

Rejection 
filter 

488-A 1: 505 LP 

A (dichroic): 550 LP 

B (dichroic): 600 LP 

C (dichroic): 645 LP 

2: 530/40 BP 

3: 580/30 BP 

4: 610/20 BP 

5: 670/30 BP 

N/A 

488-B 1: 505 LP 

A (dichroic): 550 LP 

B (dichroic): 610 LP 

C (dichroic): 710 LP 

2: 530/40 BP 

3: 580/30 BP 

4: 610/20 BP 

5: 670/30 BP 

N/A 

488-C 1: 505 LP 

A (dichroic): 550 LP 

B (dichroic): 600 LP 

C (dichroic): 645 LP 

2: 530/40 BPa 

3: 580/30 BP 

4: 610/20 BP 

5: 692/40 BP 

2: 532/20 BPb 

488-D 1: 505 LP 

A (dichroic): 527 LP 

B (dichroic): 560 LP 

C (dichroic): 610 LP 

2: 520/15 BP 

3: 542/27 BP 

4: 585/40 BP 

5: 692/40 BP 

N/A 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Second lowest wavelength filter 

3. Middle wavelength filter 

4. Second highest wavelength filter 

5. Highest wavelength filter 

Rejection filter: 

In front of the 530/40 BP filter 

Dichroics: 

A: Lowest wavelength dichroic 

B: Middle wavelength dichroic 

C: Highest wavelength dichroic 

a. The 530/40 BP is mounted behind the 532/20 BP filter. 
b. The 532/20 BP is mounted in front of the 530/40 BP filter. 
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488-nm module (5 PMTs) 

532-nm module (2 PMTs) 

Layout 
PMT 
module Longpass filter 

Bandpass 
filter 

488-nm 1: 505 LP 

A (dichroic): 550 LP 

B (dichroic): 600 LP 

C (dichroic): 645 LP 

D (dichroic): 740 LP 

6: 750 LP 

2: 530/40 BP 

3: 580/30 BP 

4: 610/20 BP 

5: 692/40 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Second lowest wavelength filter 

3. Middle wavelength filter 

4. Second highest wavelength filter 

5. Highest wavelength filter 

Dichroics: 

A: Lowest wavelength dichroic 

B: Second lowest wavelength dichroic 

C: Second highest wavelength dichroic 

D: Highest wavelength dichroic 

Layout PMT module Longpass filter Bandpass filter 

532-A 1: 532 LP 

A (dichroic): 645 LP 

2: 585/40 BP 

3: 670/30 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Middle wavelength filter 

3. Highest wavelength filter 

Dichroics: 

A: Dichroic 
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532-nm module (4 PMTs) 

561-nm module (2 PMTs) 

Layout PMT module Longpass filter Bandpass filter 

532-A 1: 532 LP 

A (dichroic): 600 LP 

B (dichroic): 645 LP 

C (dichroic): 700 LP 

5: 750 LP 

2: 585/29 BP 

3: 610/20 BP 

4: 670/30 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Second lowest wavelength filter 

3. Middle wavelength filter 

4. Second highest wavelength filter 

5. Highest wavelength filter 

Dichroics: 

A: Lowest wavelength dichroic 

B: Middle wavelength dichroic 

C: Highest wavelength dichroic 

Layout 
PMT 
module Longpass filter Bandpass filter 

Rejection 
filter 

561-A 1: 570 LPa 

A (dichroic): 610 LP 

2:593/40 BP 

3: 624/30 BP 

1: 561 RBb 

561-B 1: 570 LP 

A (dichroic): 645 LP 

2: 593/40 BP 

3: 670/30 BP 

1: 561 RB 

Filters LP and BP: 

1. Lowest wavelength filter 

2. Middle wavelength filter 

3. Highest wavelength filter 

Dichroics: 

A: Dichroic 

a. The 570 LP is mounted behind the 561 RB filter. 
b. The 561 RB is mounted in front of the 570 LP filter. 
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561-nm module (4 PMTs) 

Layout 
PMT 
module Longpass filter Bandpass filter 

Rejection 
filter 

561-A 1: 570 LPa 

A (dichroic): 600 LP 

B (dichroic): 645 LP 

C (dichroic): 700 LP 

5: 750 LP 

2: 585/29 BP 

3: 610/20 BP 

4: 670/30 BP 

1: 561 RBb 

561-B 1: 570 LPa 2: 585/29 BP 1: 561 RB 

A (dichroic): 645 LP 3: 610/20 BP 

B (dichroic): 685 LP 4: 670/30 BP or 

C (dichroic): 740 LP 
670/30 BP 

5: 750 LP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Second lowest wavelength filter 

3. Middle wavelength filter 

4. Second highest wavelength filter 

5. Highest wavelength filter 

Dichroics: 

A: Lowest wavelength dichroic 

B: Middle wavelength dichroic 

C: Highest wavelength dichroic 

a. The 570 LP is mounted behind the 561 RB filter. 
b. The 561 RB is mounted in front of the 570 LP filter. 
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635-nm module (2 PMTs) 

635-nm module (3 PMTs) 

Layout PMT module Longpass filter Bandpass filter 

635-A 1: 650 LP 

A (dichroic): 700 LP 

3: 750 LP 

2: 670/30 BP 

635-B 1: 650 LP 

A (dichroic): 740 LP 

3: 750 LP 

2: 692/40 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Middle wavelength filter 

3. Highest wavelength filter 

Dichroics: 

A: Dichroic 

Layout PMT module Longpass filter Bandpass filter 

635-A 1: 650 LP 

A (dichroic): 680 LP 

B (dichroic): 740 LP 

4: 750 LP 

2: 660/20 BP 

3: 720/40 BP 

635-B 1: 650 LP 

A (dichroic): 700 LP 

B (dichroic): 740 LP 

4: 750 LP 

2: 660/20 BP 

3: 720/40 BP 

635-B_a 1: 650 LP 

A (Dichroic): 700 LP 

B (Dichroic): 740 LP 

4: 750 LP 

2: 670/30 BP 

3: 720/40 BP 

Filters (LP and BP): 

1. Lowest wavelength filter 

2. Second lowest wavelength filter 

3. Second highest wavelength filter 

4. Highest wavelength filter 

Dichroics: 

A: Lowest wavelength dichroic 

B: Highest wavelength dichroic 
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More information � System reference information (page 329) 

� Sort performance (page 331) 

� Fluorescence specifications (page 341) 

Fluorescence specifications 

Introduction This topic describes fluorescence sensitivity, resolution, and linearity of the 
emission optics. 

Sensitivity Fluorescence sensitivity was measured using SPHERO Rainbow Calibration 
Particles (RCP-30-5A) according to the manufacturer’s specifications. 

Setting Value 

Sheath pressure 33 PSI 

Drop drive ~68 kHz 

Excitation 488 nm, 200 mW 

Emission FITC: 530/40 nm 

PE: 580/30 nm 

FITC: 125 molecules of equivalent soluble fluorochrome (MESF-FITC) 

PE: 125 molecules of equivalent soluble fluorochrome (MESF-PE) 

Resolution Fluorescence resolution was measured using propidium iodide (PI)-stained 
chicken erythrocyte nuclei (CEN). 

Setting Value 

Sheath pressure 33 PSI 

Drop drive ~68 kHz 

Excitation 488 nm, 200 mW 

Emission PI: 610/20 nm 

Coefficient of variation (CV) of PI: <3%, full G0/G1 peak 
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Linearity Fluorescence linearity was measured using PI-stained chicken erythrocyte nuclei 
(CEN). 

Setting Value 

Sheath pressure 33 PSI 

Drop drive ~68 kHz 

Excitation 488 nm, 200 mW 

Emission PI: 610/20 nm 

Doublet/singlet ratio: 1.95–2.05 

More information � System reference information (page 329) 

� Optical detector modules (page 333) 

� Fluidics pressure and drop frequency settings (page 343) 

https://1.95�2.05
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Fluidics pressure and drop frequency settings 

Introduction This topic describes fluidics pressure and drop frequency settings. 

About fluidics pressure 
and drop frequency 
settings 

Settings 

For each nozzle size, there are several optional sheath pressures that can be used, 
depending on the requirements of your application and the resonant frequencies 
of the system. 

The values in the following table are a sampling of theoretical optimal nozzle size/ 
sheath pressure/drop frequency combinations. These values are to be used as a 
starting place only and are based on typical Influx resonant frequencies. Every 
instrument requires droplet breakoff optimization. 

Piezo amplitude. In general, piezo amplitudes will be between 2 and 20, though 
higher values may be needed for high sheath pressures and drop frequencies. 

Drop delay. In general, the expected drop delay from most nozzles (drops to 
breakoff) is approximately half the drop frequency in kHz for optimized pressure/ 
frequency combinations. For example, a 70-µm nozzle at 33 PSI and 72 kHz will 
have an expected drop delay of about 32 to 40 drops when properly adjusted. 
Fewer drops increase the chances of optical interference and more drops increase 
the chance of less than optimal voltage being applied to the piezo drive. 

Nozzle size 
(m) 

Sheath 
pressure (PSI) 

Drop frequency 
(kHz) 

70 22 59 

33 72 

65 101 

86 15 39 

22 48 

33 58 

100 7 23 

17 36 

140 5 14 

200 3 8 

More information � System reference information (page 329) 

� Optimizing the droplet breakoff (page 285) 

� Fluorescence specifications (page 341) 

� Fluidics specifications (page 344) 
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Fluidics specifications 

Introduction This topic describes the system fluidics specifications. 

General operation  Laboratory air pressure and/or vacuum can be used for operation (regulated 
at 90 PSI, 6.2 bar). 

 An optional air pressure supply and vacuum pump are available. 

 Sheath pressure is adjustable from 1–90 PSI (0.07–6.2 bar). 

Fluidics reservoirs Autoclavable 7-L sheath and waste containers, equipped with pressure and 
vacuum readout, are provided. Remove the gauge before autoclaving. 

Fluidics control  Sheath, sample, and boost pressure can be individually adjusted. 

 A sample flow fine adjustment is provided for precise regulation of sample 
flow. 

 Purge, pulse, rinse, and run buttons are provided for quick stream startup and 
bubble removal. 

Replaceable fluidics path  The fluidics path, including the nozzle assembly can be exchanged. There are 
no inline valves. Only pinch valves are used. 

 The sample line can also be exchanged. 

Bubble detector A bubble detector in the sample line detects air bubbles from the sample tube and 
stops sample flow when the sample tube is empty, preventing air bubbles from 
reaching the nozzle assembly. 

Sample input 12 x 75-mm polypropylene tubes 

More information � System reference information (page 329) 

� Electronics and signal processing specifications (page 345) 
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Electronics and signal processing specifications 

Introduction This topic describes electronics and signal processing specifications. 

Data acquisition channels 16 channels, usually 14 colors plus forward and side scatter 

Signal processing  16-bit analog-to-digital conversion, 65,536 channels 

 Parallel data stream with channel ID and integrity check 

 Less than 1 correlation error per 108 events 

Acquisition rate The system dead time is 5 s. This leads to a maximum theoretical processing 
capability of 200,000 events/second, independent of the number of parameters. 

Fluorescence 16 x 16 digital compensation matrix (DSP). Compensated parameters are added 
compensation to the bus as separate parameters. 

Pulse processing 
electronics 

 All signals are height (peak) by default. 

 Optional pulse processor electronics add area and width measurements for a 
maximum of 8 parameters to the bus. 

 Width measurement on the trigger parameter is standard. 

Time Time can be correlated to any parameter for kinetic experiments or other 
applications. 

Threshold channel  Any parameter can be used as the threshold from the primary laser. 

 Lasers and detectors can easily be switched to change laser sequence. 

More information � System reference information (page 329) 

� System specifications (page 330) 
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BD Influx options 

This section includes these topics: 

 About the HEPA-filtered enclosure option (page 348) 

 HEPA enclosure specifications (page 351) 

 HEPA enclosure safety (page 352) 

 Enclosure operational checklist (page 354) 

 About the HEPA enclosure controls (page 355) 

 Setting up the HEPA enclosure digital display (page 357) 

 Small particle forward scatter detector option (page 361) 

 Aerosol evacuation unit and air compressor options (page 362) 
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About the HEPA-filtered enclosure option 

Introduction This topic provides a functional description of the BD Influx HEPA-filtered 
enclosure option. 

Description The HEPA (high efficiency particulate air) filtered enclosure is specifically 
designed for the BD Influx system. It provides protection from biological agents 
approved for use in Biosafety Level 1 or 2 environments. 

The enclosure features: 

 Recirculating HEPA filtration 

 Variable speed blowers 

 Solid state, automated speed control 

 Analog and digital pressure indicators 

 Clean room–compatible epoxy exterior 

How it works The stainless steel diffuser is located below the upper HEPA filter and ensures that 
the work area is supplied with HEPA-filtered air. 

The filtered air flows around the instrument and the optical bench, then down 
into a common lower plenum. 

A recirculated volume of air is returned to an upper plenum for refiltering, while 
the remaining air is exhausted to the room via a lower HEPA filter. 

The arrows in the following figure indicate the direction of air flow. 

Filters 

Direction of 
air flow 
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A manual damper in the upper plenum maintains the balance between the two fan 
units. Another damper in the diffuser ensures a proper downflow velocity over the 
work area. 

All areas of the enclosure are under negative pressure relative to the ambient 
external laboratory. Air that is handled by the enclosure is HEPA filtered before 
being released into the room. 

If a leak occurs in a contaminated pressure plenum, the negative pressure creates 
suction and pulls air in so it cannot escape into the laboratory space. 

If a leak occurs from one of the two positive pressure plenums (between a fan and 
a HEPA filter), the surrounding negative pressure area recaptures the 
contaminated air and recirculates it through the filter. 

Components The HEPA-filtered enclosure option includes the following components. 

Upper plenum 

Enclosure top 

Top access panel 

Pressure gauge Front sash door 
(open) 

Enclosure cage 

Enclosure tray 
Tray access panel 

Digital display 

Lower plenum 

Exhaust HEPA 

Component Description 

Upper plenum Recirculates air. Provides access to the plenum electronics. 

Top access panel Provides access to the upper HEPA filter. 

Pressure gauge Displays the enclosure air pressure. 



 

 

 

   
  

 
   

   
 

    
 

 

 

  

 

   

 
 

350 BD Influx User’s Guide 

Component Description 

Enclosure cage Provides a skeletal framework for the sliding 
polycarbonate panels that surround the instrument work 
area. All sliding panels are fully removable. 

Enclosure tray The laser optical bench has an air gap around it. Small 
drop-in gap trays are used in the rear optical area to 
restrict and balance the free flow of air around the bench. 
A front access panel provides for access to the trays and air 
gap. 

Exhaust HEPA Exhausts filtered air. 

Enclosure top Sits on top of the enclosure cage. Two removable panels on 
the right and left sides provide access to any internal 
pressure tubing or electrical wiring. 

Front sash door Provides access to the instrument. 

Tray access panel Provides access to the catch tray, below the instrument. 

Digital display Displays the HEPA filter status. 

Lower plenum A common plenum for both the recirculating and 
exhausting air supplies. The lower plenum includes a 
variable speed fan motor and replaceable exhaust HEPA 
filter, as well as a digital pressure display and a lower 
differential pressure gauge. A front access panel provides 
non-contaminated access to the plenum electronics. 

More information � BD Influx options (page 347) 

� HEPA enclosure specifications (page 351) 

� HEPA enclosure safety (page 352) 

� About the HEPA enclosure controls (page 355) 

� Setting up the HEPA enclosure digital display (page 357) 
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HEPA enclosure specifications 

Introduction This topic provides the HEPA enclosure and site specifications. 

Dimensions  Outside (W x D x H): 46 x 34 x 85 in. (117 x 86 x 216 cm) 

 Height: 85.3 in. (216.7 cm) 

 Width: 46 in. (116.8 cm) 

 Depth: 34 in. (86.4 cm) 

 Filtered work area (W x D): 32 x 17 in. (81.3 x 43.2 cm) 

 Work surface height: 37 in. (94 cm) 

 Sash dimensions (W x H): 25.5 x 8 in. (64.8 x 20.3 cm) 

 Weight: 210 lb. (95.2 kg) 

Airflow  Inflow method: indirect exhaust 

 Average inflow: 85–130 FPM 

 Average downflow: 40–60 FPM 

Filtration  Efficiency: 99.9995% at 0.3 

 Leak detection: >10 Jg/L 

 Resistance: 0.48'' wg (inches of water gauge) 

 Filter size: 559 x 559 x 90 mm 

 Max flow: 320 CFM 

Laboratory requirements  Room height (floor-to-ceiling): 8 ft (2.44 m) 

 Operational footprint (W x D): 7 x 7 ft (2.13 x 2.13 m) 

 Electrical: 115 V at 50/60 Hz, 11 A peak, 5 A nominal 

Enclosure location Proper placement of the BD Influx system within the laboratory is essential. 

Warning! A strong, disruptive air current (exceeding the intake velocity of the 
enclosure) might enable contamination to escape the enclosure. 

To prevent exposure to disruptive air currents, place the BD Influx enclosure in a 
dead-end corner of the laboratory or cleanroom. The instrument should be away 
from personnel traffic, vents, doors, windows, or any other sources of disruptive 
air currents. 
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More information � BD Influx options (page 347) 

� About the HEPA-filtered enclosure option (page 348) 

� HEPA enclosure safety (page 352) 

HEPA enclosure safety 

Introduction This topic describes the official use, cautions, and limitations of the HEPA 
enclosure. 

Intended use The HEPA enclosure has been designed as a containment device to protect users 
from any aerosols generated while sorting with the BD Influx cell sorter. 

It is designed for work with Biosafety Level (BSL) 1 and 2 agents as listed in The 
Centers for Disease Control HHS publication number 84-8395: Biosafety in 
Microbiological and Biomedical Laboratories. 

U.S. Department of Health and Human Services, Public Health Service, Centers 
for Disease Control, and National Institutes of Health, U.S. Government Printing 
Office, Washington, D.C. 20402 

Biological safety 
Caution! Biosafety Level 3 (BSL-3) agents should not be used unless other 
containment measures approved for work with BSL-3 agents encapsulate the 
entire enclosure or unless the enclosure is located within an existing BSL-3 rated 
facility. 

Biosafety Level 4 or extremely high risk agents should never be used in the 
enclosure. Please consult your safety professional for a proper risk assessment. 

Caution! The use of any hazardous material in the enclosure requires that it be 
monitored by a safety officer or other qualified individual. 

Do not use explosive or flammable substances in the enclosure. 

If chemical, radiological, or other non-microbiological hazards are present, be 
sure to employ appropriate protective measures in addition to formaldehyde 
decontamination. 

Using proper technique The BD Influx HEPA enclosure must be used properly in combination with proper 
sterile techniques to provide an adequate protective barrier. 
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Enclosure fluid spills Instrument administrators and safety personal should create an emergency spill 
procedure. If you work with hazardous agents, you should also assemble a kit that 
includes: 

 Respirator 

 Chemical splash goggles 

 Two pairs of gloves 

 Two sheets of absorbent material 

 Spill control pillows 

 Waste disposal bags 

Any fluid that spills inside the enclosure is primarily contained to the work area. If 
a large volume of fluid spills, some spilled fluid might drip into the tray area 
below the optical table. No drain is provided for the tray. You must manually 
remove any spilled fluid in the tray by removing the tray access panel. If the spill is 
large enough to create puddles of liquid in the tray area, then you should follow 
an emergency spill procedure. 

If an accident causes spills and splatters in the work area, you must decontaminate 
all items and surfaces before any items are removed. 

Disinfecting after a spill If a biological spill drips down into the tray area: 

1. Flood the area with up to 1 L of an appropriate disinfectant. 

2. After the disinfectant has pooled in the tray, remove any fluid in the tray by 
removing the tray access panel. If the spill involves a hazardous Biosafety 
Level 2 or 3 agent: 

� Leave the enclosure running to permit aerosols to settle before you start 
cleanup procedures. 

� With some spills, you might need to decontaminate the room with an 
agent such as formaldehyde gas. Consult a safety professional for proper 
procedures and treatment of the specific agent. 

Caution! Never use Biosafety Level 4 agents in the BD Influx enclosure. 

If the spill contains volatile liquids that generate flammable or explosive vapors: 

 Turn off the enclosure and other electrical devices. 

 Evacuate and seal the room. 

 Call for immediate help from a safety professional for proper procedures and 
treatment of the specific agent. 
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More information � BD Influx options (page 347) 

� HEPA enclosure specifications (page 351) 

� Enclosure operational checklist (page 354) 

Enclosure operational checklist 

Introduction This topic provides a list of steps you must complete before you begin using the 
HEPA enclosure. 

You must perform these steps to ensure safe and effective operation. 

Before you begin A qualified professional or safety officer must approve the use of any hazardous 
agents with the BD Influx HEPA enclosure. This person should monitor the 
system and operating personnel at regular intervals to ensure appropriate use. 

Checklist Before introducing any biological agents into the enclosure: 

1. Power up the enclosure. 

The digital display lights up. 

2. Make sure all four enclosure panels are in place and are completely closed. 

3. Pressurize both HEPA filters. 

Check the pressure on both analog gauges and the digital display. If the 
analog gauges and digital display show different values, the enclosure might 
require service. 

4. Close and latch the enclosure sash door. 

5. Follow all BD Influx instrument startup procedures. 

Warning! If a low-flow alarm condition occurs, stop all work and service the 
enclosure. 

6. If you introduce any biological agents into the enclosure, continuously 
monitor the sample and work area for any fluid spills. 

Warning! The enclosure and blowers are designed for continuous operation. 
To minimize the chance of contamination, do not turn off the blowers unless 
you are shutting down the system for a period of non-use or for servicing the 
instrument or enclosure. 
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More information � BD Influx options (page 347) 

� System startup (page 223) 

� HEPA enclosure safety (page 352) 

� Setting up the HEPA enclosure digital display (page 357) 

About the HEPA enclosure controls 

Introduction This topic describes the HEPA enclosure controls. 

Controls  Blower power switch. This controls the main power to the blowers and to the 
enclosure. It is located to the rear of the lower plenum assembly, near the 
floor. When you power on the switch, a brief calibration alarm sounds. 

 Fluorescent light switch. This controls the operation of the fluorescent light 
inside the enclosure. 

 Digital display. The digital display monitors the incoming signal from both 
upper and lower plenum sensors. These sensors sample the differential 
pressure between the pressurized side of the HEPA filters and the room. If 
certain threshold levels are exceeded, the display triggers a relay and alarm. 

 Alarm Acknowledge Button (ACK). This temporarily mutes any audible 
alarm. The button is located on the lower plenum digital display. If a fault 
condition exists, the alarm resumes after a preset time until the fault is 
cleared. 
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 Pressure indicators. The enclosure provides both digital pressure indicators 
and analog pressure gauges. 

Both indicators monitor the air pressure generated by the fans against the 
HEPA filter surfaces. The digital indicators are measured in mA, and appear 
as data bars. 

More information � BD Influx options (page 347) 

� Enclosure operational checklist (page 354) 

� Setting up the HEPA enclosure digital display (page 357) 
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Setting up the HEPA enclosure digital display 

Introduction This topic describes how to set up the digital display on the lower plenum of the 
HEPA enclosure. 

Make selections by pressing one of the control buttons at the bottom of the digital 
display which correspond to the task. The display is set at the factory. However, 
you can change the trigger levels. 

Procedure The Display Main screen displays a summary of both sensor channels. 

To set up the HEPA enclosure digital display: 

1.  Press SETUP. 

2. In the Display Setup screen, use the arrow to select CHANNEL #1, then press 
ENTER. 

The Analog Input #1 screen displays the parameters for the lower plenum 
sensor. 
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3. To select an item, press the arrows, then press EDIT. Make sure that the 
following parameters are set: 

� Input Type: 4–20 mA Transmitter 

� Function: Linear 

� Channel ID: Lower Unit 

4. Select Configure Display Parameters, then press EDIT. 

5. Make sure that the following parameters are set: 

� Max Value: 20.0 mA 

� Min Value: 4.8 mA 

� Format: 99999.9 mA 

� Units: mA  

6. Press EXIT. 

7. Select Configure Sensor Input, then press EDIT. 

8. Make sure that the following parameters are set: 

� High Value: 20.0 mA 

� Sensor: 20.00 mA 

� Low Value: 4.0 mA 

� Sensor: 4.00 mA 

9. Press EXIT to return to the Display Setup screen. 

10. Use the arrow to select CHANNEL #2, then press ENTER. 

The Analog Input #2 screen displays the parameters for the upper plenum 
sensor. 

11. Press the arrows to select an item, then press EDIT. 

12. Make sure that the following parameters are set: 

� Input Type: 4–20 mA Transmitter 

� Function: Linear 

� Channel ID: Upper Unit 
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13. Select Configure Display Parameters, then press EDIT. 

14. Make sure that the following parameters are set: 

� Max Value: 20.0 mA 

� Min Value: 4.0 mA 

� Format: 99999.9 mA 

� Units: mA  

15. Press EXIT. 

16. Select Configure Sensor Input, then press EDIT. 

17. Make sure that the following parameters are set: 

� High Value: 20.0 mA 

� Sensor: 20.00 mA 

� Low Value: 4.0 mA 

� Sensor: 4.00 mA 

18. Press EXIT to return to the Display Setup screen. 

19. Use the arrow to select ALARM RELAY #1, then press ENTER. 

The Alarm Setup screen allows a mechanical relay to be triggered by a current 
level from the lower plenum sensor. 
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20. Make sure that the following parameters are set: 

� Alarm Mode: Annunciator: High 

� Channel: [1] Lower Unit 

� High Value: 16.5 mA 

� Low Value: 16.0 mA 

� Delay ON: 15.0 sec 

� Delay OFF: 8.5 sec 

� Reset Ch: [1] Read SW: 1 

21. Press EXIT to return to the Display Setup screen. 

22. Use the arrow to select ALARM RELAY #2, then press ENTER. 

23. Make sure that the following parameters are set: 

� Alarm Mode: Annunciator: High 

� Channel: [2] Upper Unit 

� High Value: 11.0 mA 

� Low Value: 10.5 mA 

� Delay ON: 15.0 sec 

� Delay OFF: 0.5 sec 

� Reset Ch: [2] Read SW: 2 

24. Press EXIT twice to return to the Display Main screen. 

The digital display is now set up. 

More information � BD Influx options (page 347) 

� About the HEPA enclosure controls (page 355) 

� About the HEPA-filtered enclosure option (page 348) 
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Small particle forward scatter detector option 

Introduction This topic describes the Small Particle Detector Option (SPO). 

Description The SPO incorporates a 20X, 0.42 NA microscope objective, a mirror pinhole, 
and a pinhole camera. Resolution for the SPO is >0.2 m (measured using beads 
and 0.1-m filtered sheath fluid). The collection angle is 2–30°. 

The small particle detection module, forward pinhole, and forward pinhole 
camera are optional devices that come with the SPO. 

The forward image block assembly includes the following components: 

 Forward objective microscope lens. Focuses the forward scatter light into the 
pinhole. 

 Forward pinhole. Focuses the forward scatter beam profile. 

 Forward pinhole camera. Monitors and displays (on the pinhole LCD) the 
forward scatter beam on the pinhole. 

Forward pinhole camera 

Contact your BD representative for more information about ordering and 
installing this option. 

More information � BD Influx options (page 347) 

� About the HEPA-filtered enclosure option (page 348) 

� Aerosol evacuation unit and air compressor options (page 362) 
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Aerosol evacuation unit and air compressor options 

Introduction This topic describes the aerosol evacuation unit option for the BD Influx HEPA-
filtered enclosure. It also describes the air compressor option for the system. 

Aerosol evacuation unit The Surgifresh® evacuation unit is an aerosol management option for the HEPA-
filtered enclosure. This unit evacuates aerosols from the lower chamber of the 
HEPA-filtered enclosure, preventing the aerosols from being circulated back 
through the enclosure. 

Contact your BD representative for more information about ordering and 
installing this option. 

Air compressor option An external air compressor is necessary if you do not have a compressed air 
supply in your laboratory. The external air compressor provides a constant supply 
of clean, dirt-and-oil free, pressurized air at 60–90 PSI to the cytometer during 
operation. 

More information � BD Influx options (page 347) 



24 
Troubleshooting 

This section includes these topics: 

 Sorting troubleshooting (page 364) 

 Acquisition troubleshooting (page 369) 

 Fluidics troubleshooting (page 373) 

 Alignment troubleshooting (page 375) 

 Applications troubleshooting (page 377) 

 Electronics troubleshooting (page 378) 
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Sorting troubleshooting 

Introduction This topic describes sorting problems and possible solutions. 

Stream out of alignment 

No stream visible 

Possible causes Possible solutions 

Nozzle is not aligned Adjust the silver knobs to align the stream to the pinholes 
and adjust the black knobs to align the stream to the 
drain. See Aligning the stream (page 249) for more 
information. 

Bubbles in the nozzle  Install the debubble reservoir filled with clean sheath 
or ethanol and purge the nozzle. 

 Verify that the nozzle and O-ring are seated properly 
and aligned. 

Clogged or damaged nozzle Remove the nozzle and sonicate it in DI water or 
detergent to remove the clog. Examine the nozzle under a 
microscope to check for damage. If the nozzle is 
damaged, replace it. 

Possible causes Possible solutions 

Empty sheath tank Refill the sheath tank. 

Sheath tank is not 
pressurized 

 Check the fittings for leaks and tighten the pressure 
release valve, using a wrench if necessary. 

 Make sure that the O-ring is properly installed 
around the tank lid and that the lid is properly seated. 

 Check the air compressor or the house air supply. 
Make sure that the AIR switch is on. 

Clogged or damaged nozzle Remove the nozzle and sonicate it in DI water or 
detergent to remove the clog. Examine the nozzle under a 
microscope to check for damage. If the nozzle is 
damaged, replace it. 

Nozzle was not installed 
properly, seal is leaking 

Reinstall the nozzle and ensure that the O-ring is properly 
installed. 

Air in sheath filter Purge the sheath filter. 

Side streams not aligned 
Possible causes Possible solutions 

Stream deflection is 
incorrect 

Start the stream and adjust the stream deflection so that 
the stream is aligned to the tube. 

Tray position is incorrect Use the Tray Control pane to move the tray to its 
appropriate location. 
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Last column is 
unreachable during plate 
sort 

Possible causes Possible solutions 

Side stream is deflected too 
far to the left and unable to 
reach the far right column 

Decrease the side stream deflection and reinsert the tray. 

Unstable stream or 
stream breakoff Possible causes Possible solutions 

Debris or bubbles in the 
nozzle 

 Remove the nozzle and sonicate it in DI water or 
detergent to remove the clog. 

 Purge the nozzle using the debubble reservoir and 
clean sheath fluid or ethanol. 

 Verify that the nozzle and O-ring are seated properly 
and tightened. 

Fluidics are not warmed up Run the stream for 30 min to 1 hr before sorting. 

Air currents  Close the sort chamber door. 

 Check the room for drafts. 

Air or fluid leak  Check the sheath tank for leaks. 

 Check the fluidic lines for leaks. 

 Contact BD service personnel to check the pressure 
console for leaks. 

Chemical residue in sheath 
line 

Perform a system flush or replace the sheath line. 

Sheath tank low or empty Refill the sheath tank. 

Air in sheath filter Purge the sheath filter. 

Clogged sheath filter Replace the sheath filter. 

Large cells or clumpy 
sample 

 Install a larger nozzle. The nozzle should be at least 
5–6 times the size of the particles being run. 

 Filter the sample. 

Frequency setting is not 
optimal 

1. See the Fluidics pressure and drop frequency settings 
(page 343) to select an approximate frequency. 

2. Find the frequency setting that will give you the 
shortest breakoff and the most stable stream. 

Sample line was not 
installed correctly in the 
nozzle 

Adjust the sample line position in the nozzle. 

Debris in the sample Prepare a new sample or use a larger nozzle. 
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No side streams are 
visible Possible causes Possible solutions 

Drop charge is not turned 
on 

1. Turn on the test deflection. 

2. Start the drop charge amplitude at 0 and increase it 
while watching for side streams. 

Deflection plates are not 
turned on 

Turn on the deflection plates. 

Deflection plates are open 1. Turn off the deflection plates. 

2. Close the deflection plates. 

Drop charge is too high Start the drop charge amplitude at 0 and increase it while 
watching for side streams. 

Drop drive is not turned on 1. Increase Piezo amplitude to appropriate settings. 

2. Optimize the drop drive frequency. 

DI water is in the sheath 
lines 

Use a sheath fluid with the appropriate salinity for drop 
charging. 

Pressure and frequency 
settings are not optimized 

1. See Fluidics pressure and drop frequency settings 
(page 343) to select an approximate frequency. 

2. Find the frequency setting that will give you the 
shortest breakoff and most stable stream. 

Bad contact point for drop 
charge connection 

Make sure the piezo amplitude is zero and then remove 
the nozzle assembly to inspect the charge contacts. 

 If there is corrosion, clean the contact points. 

 If the contact points are damaged, replace them. 

Arcing between deflection 
plates 

1. Turn off the deflection plates. 

2. Clean any salt buildup off the plates and dry them 
thoroughly. 

Side streams are not 
aligned to the Accudrop 
laser 

Realign the side streams. 

Wet, dirty, or salty plates 1. Turn off the plates. 

2. Clean and dry the plates. 

Nozzle chamber door is 
open 

Close the nozzle chamber door. 
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Fanning around center or 
side streams when 
deflection plates are on 

Possible causes Possible solutions 

Clogged or damaged nozzle Remove the nozzle and sonicate it in DI water or 
detergent to remove the clog. Examine the nozzle under a 
microscope to check for damage. If the nozzle is 
damaged, replace it. 

Large cells or clumpy 
sample 

 Install a larger nozzle. The nozzle should be at least 
3–4 times the size of the particles being run. 

 Filter the sample. 

Pressure and frequency 
settings are not optimized 

1. See Fluidics pressure and drop frequency settings 
(page 343) to select an approximate frequency. 

2. Scan the frequency settings around the recommended 
frequency to find the setting that will give you the 
shortest breakoff and most stable stream. 

Piezo amplitude is too low Increase the piezo amplitude. 

Stream focus is not set 
correctly 

Adjust the stream focus to tighten the center stream. 

Drop charging is out of 
phase with drop formation 

1. Turn on test deflection and flash charge. 

2. Adjust the piezo amplitude until the side streams are 
deflected as far as possible with minimum spraying. 

Incorrect sort mode Verify that the precision mode is appropriate for your 
sorting requirements. 

Low sort efficiency 
Possible causes Possible solutions 

Event rate is too high for 
drop drive frequency 

Decrease the event rate. 

Gating conflicts Verify the sorting gate strategy. 

Incorrect sort mode Verify that the sort mode is appropriate for your sorting 
requirements. 

Rare sort populations Enrich the sample for the population of interest before 
sorting. 

Sorted on ADC 
parameters, not on DSP 
parameters 

Create plots with DSP parameters. 

Cannot see excited beads 
in the Accudrop laser Possible causes Possible solutions 

Accudrop filter is not in 
place 

Set the laser knob to Accudrop. 

Event rate is too low  Add more beads to the tube. 

 Increase the event rate. 

 Increase the sample offset. 
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Erratic sort rate 
Possible causes Possible solutions 

Event rate is too high Decrease the event rate. 

Clogged or kinked sample  Filter the sample. 

 Clean or replace the sample line. 

Unexpected sort results 

Index sorting button is 
grayed out or cannot 
start 

Side streams are not 
hitting the target 

Possible causes Possible solutions 

Incorrect drop delay Check the drop delay. 

Incorrect sort mode Verify that the precision mode is appropriate for your 
sorting requirements. 

Breakoff is not stable 
during the sort 

Watch the breakoff during the sort and adjust the 
amplitude if necessary. 

Incorrect logic in sort 
gating 

Verify the sorting gate strategy and check for any yellow 
populations (conflicts). 

Side streams fanning 
during the sort 

See Fanning around center or side streams when 
deflection plates are on (page 367). 

Pressure is too high for cell 
viability 

Use a larger nozzle and lower sheath pressure for fragile 
cells. 

Collection tube or plate is 
not aligned correctly 

Check the tubes and side streams for proper alignment 
before sorting. 

Event rate is too high Decrease the event rate. 

Possible causes Possible solutions 

Cannot perform index sort 
while acquiring data 

Stop acquiring data. 

No available DSP 
parameters 

Manage parameters in the compensation window and 
deselect parameters that you are not using. 

Possible causes Possible solutions 

Deflection rate is too low 
or too high 

 Increase the maximum drop charge. 

 Increase the maximum stream deflection. 

Droplet breakoff is too low Adjust the sort settings. 

Wet or dirty plates Turn off the plates and clean them. 

High speed or large nozzle 
sort 

Modify the sort setup. 
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More information � Acquisition troubleshooting (page 369) 

� Fluidics troubleshooting (page 373) 

� Alignment troubleshooting (page 375) 

� Applications troubleshooting (page 377) 

� Electronics troubleshooting (page 378) 

Acquisition troubleshooting 

Introduction This topic describes acquisition problems and possible solutions. 

No sample events 
Possible causes Possible solutions 

Laser shutter is engaged Open the laser shutter. 

Laser power is off Turn on the laser power supply and turn the key to fire 
the laser. 

Laser safety interlock is 
engaged 

Close the nozzle chamber door and place your finger over 
the optical sensor in the upper right corner to reset the 
safety interlock. 

No sample in the tube Add sample to the tube or install a new sample tube. 

Sample is not mixed 
properly 

Mix the sample thoroughly and re-install the tube on the 
instrument. 

Sample line is clogged Clean or replace the sample line. 

Bubble detector triggered  Press BACKFLUSH to reset the bubble detector. 

 Verify that the sample line is long enough to reach the 
sample. 

Air line sensor was 
triggered 

Contact your BD service representative. 

Tube is not properly 
installed 

1. Install the tube onto the sample station. 

2. Close the sample lever under the tube. 

3. Press SAMPLE to pressurize the tube. 

Laser or stream not 
properly aligned 

Align the stream and lasers. 

Trigger is not set correctly  Set the trigger detector or level according to the needs 
of your sample. 

 Check the PMT voltage and the linear/log setting for 
trigger detector. 
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Possible causes Possible solutions 

Tube is not pressurized  Check the sample stopper for damage and replace it if 
necessary. 

 Check the tube for damage and replace it if necessary. 

PMT power is off Turn on the PMT power and adjust the voltage. 

Sample pressure is too low Adjust the Sample Offset knob to increase the sample 
pressure. 

No fluorescent or scatter 
signal Possible causes Possible solutions 

Wrong optical filter is 
installed or optical filter is 
missing 

Make sure that you have the correct optical filters 
installed for your application. 

Laser delay or trigger delay 
is set incorrectly 

1. Verify that you have the correct event number 
assigned for each channel. 

2. Adjust the laser delay. 

PMT is labeled incorrectly Check your instrument configuration to verify that you 
are looking at the correct channel. 

Sample was not 
appropriately stained 

Verify that the appropriate antibody or dye was added to 
the sample tube. 

Forward scatter detector is 
not aligned 

Align the forward scatter detector. 

Wrong excitation laser 
wavelength 

Use the correct excitation wavelength. 

Excitation laser is in the 
wrong pinhole 

Align the excitation laser to the correct pinhole. 

Wrong trigger channel is 
selected 

Change the trigger detector and trigger level. 
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Sortware not connecting 
to the cytometer 
interface 

Possible causes Possible solutions 

The cytometer interface is 
not turned on 

Turn on the cytometer interface. 

Faulty connection between 
Sortware and the cytometer 
interface 

 Make sure that the network cable is connected 
between the Sortware workstation and the cytometer 
interface. 

 Select Cytometer > Connect to Cytometer. 

 Do the following: 

– Turn off the auxiliary power. 

– Turn off the cytometer interface by pressing and 
holding the power button. 

– Turn on the auxiliary power. 

– Turn on the cytometer interface and wait for two 
beeps. 

– (If needed) Select Cytometer > Connect to 
Cytometer. 

Distorted populations or 
high CVs Possible causes Possible solutions 

Lasers are not properly 
aligned 

Align and focus the lasers. 

Instrument settings were 
adjusted incorrectly 

Optimize the cytometer settings. 

Sample pressure is too high Decrease the sample pressure. 

Debris or bubbles in the 
nozzle 

 Remove the nozzle and sonicate it in DI water or 
detergent to remove the clog. 

 Purge the nozzle using the debubble reservoir and 
clean sheath or ethanol. 

 Verify that the nozzle and O-ring are seated properly 
and tightened. 

Poor sample preparation Repeat sample preparation. 

Excess background light  Turn off the hood light. 

 Close all safety covers on the instrument. 

 Dim the lights in the room. 

Stream is not aligned Align and focus the stream. 

Sample/sheath index of 
refraction mismatch 

Verify that you are using the appropriate sheath fluid and 
resuspension fluid for your sample. 
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Excessive amount of 
debris in plots Possible causes Possible solutions 

Trigger level is set too low Increase the trigger level. 

Dead cells or debris in the 
sample. 

Examine the sample under a microscope and prepare a 
new sample. 

Sheath filter is dirty or 
contaminated 

1. Remove the sheath filter. 

2. Perform a system flush or replace sheath line. 

3. Replace the sheath filter. 

Sample is contaminated Prepare a new sample. 

Carryover from a previous 
sample 

1. Remove the sample line. 

2. Backflush the sample line. 

3. Reset the plot display. 

Noisy FSC or fluorescence 
signal 

Low acquisition efficiency 

Possible causes Possible solutions 

Noise from the drop 
formation 

Adjust the sort settings. 

Misaligned laser Realign the laser. 

Ambient light leak  Close all safety covers on the instrument. 

 Verify that all optical filters are correctly installed and 
the O-rings are in place. 

Backwards or missing 
bandpass filter 

Verify that all optical filters are correctly installed. 

Piezo amplitude is set too 
high 

Lower the piezo amplitude. 

Laser or stream is not 
properly aligned 

Align the stream and lasers. 

Sample pressure is too high Decrease the sample pressure. 

PMT voltage is set too high Decrease the PMT voltage. 

Possible causes Possible solutions 

Drop drive noise Adjust the sort settings. 

High sample event rate Lower the sample offset. 

Clumps or filaments in the 
sample 

Filter the sample. 

Poor laser alignment Align the laser. 
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More information � Sorting troubleshooting (page 364) 

� Fluidics troubleshooting (page 373) 

� Alignment troubleshooting (page 375) 

� Applications troubleshooting (page 377) 

� Electronics troubleshooting (page 378) 

Fluidics troubleshooting 

Introduction This topic describes fluidics problems and suggests possible solutions. 

Cannot pressurize the 
sheath tank Possible causes Possible solutions 

Bad or missing O-ring Replace the O-ring around the tank lid. 

Tank is leaking pressure  Check the fittings for leaks. 

 Tighten the pressure release valve, using a wrench if 
necessary. 

 Make sure that the lid is properly seated. 

No air supply Check the air compressor or house air supply. 

Waste tank has no 
vacuum Possible causes Possible solutions 

Tank is not sealed properly  Connect all fittings. 

 Verify that the O-ring is installed around the lid and 
replace the O-ring if necessary. 

 Make sure that the lid is properly seated. 

 Tighten the lid. 

No vacuum supply Verify that the vacuum pump or supply is turned on. 

Air filter is wet or clogged Replace the air filter on the vacuum line. 

Waste tank is full Empty the waste tank. 

Flush bucket, backflush 
drain, or stream drain 
does not empty 

Possible causes Possible solutions 

No vacuum See Waste tank has no vacuum (page 373). 

Debris is clogging the drain Remove the flush bucket and clean it with detergent. 

Pinched tubing Check the tubing for kinks. 
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Wide sample core 
Possible causes Possible solutions 

Damaged sample line Replace the sample line. 

Bubbles in nozzle  Install the debubble reservoir filled with clean sheath 
or ethanol and purge the nozzle. 

 Verify that the nozzle and O-ring are seated properly 
and tightened. 

Clogged or damaged nozzle Remove the nozzle and sonicate it in DI water or 
detergent to remove the clog. Examine the nozzle under a 
microscope to check for damage. If the nozzle is 
damaged, replace it. 

Sample pressure is too high Decrease the sample pressure. 

Sample concentration is 
too low 

Concentrate the sample. 

Sample/sheath index of 
refraction mismatch 

Verify that you are using the appropriate sheath fluid and 
resuspension fluid for your sample. 

Sheath tank is empty or 
low 

Fill the sheath tank. 

Incorrect laser or stream 
alignment 

Realign the stream and laser. 

Sample tube makes 
popping sound when 
removed 

Possible causes Possible solutions 

Sample lever was opened 
too quickly 

Open the sample lever slowly, especially when running at 
high pressures. 

The filter on the sample 
tube air line is wet 

Replace the air filter. 

The sensor on the sample 
lever is not responding 

Contact your BD service representative. 

More information � Sorting troubleshooting (page 364) 

� Acquisition troubleshooting (page 369) 

� Alignment troubleshooting (page 375) 

� Applications troubleshooting (page 377) 

� Electronics troubleshooting (page 378) 
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Alignment troubleshooting 

Introduction This topic describes alignment problems and possible solutions. 

Laser is not visible on the 
pinhole monitor Possible causes Possible solutions 

Laser shutter is closed Open the laser shutter. 

Laser turned is off Turn on the laser power supply and turn the key to fire 
the laser. 

Laser safety interlock is 
engaged 

Close the nozzle chamber door and place your finger over 
the optical sensor in the upper right corner to reset the 
safety interlock. 

Stream is not aligned Align the stream before aligning the lasers. 

Laser is not aligned Align the lasers. 

Laser is not emitting visible 
light 

When aligning a UV laser, run beads that are excited by 
UV wavelengths. 

Bad pinhole monitor 
settings 

Adjust the brightness and contrast on the pinhole 
monitor. 

Core stream not visible 
on pinhole monitor when 
running alignment beads 

Possible causes Possible solutions 

Laser shutter is closed Open the laser shutter. 

Laser turned is off Turn on the laser power supply and turn the key to fire 
the laser. 

Laser safety interlock is 
engaged 

Close the nozzle chamber door and place your finger over 
the optical sensor in the upper right corner to reset the 
safety interlock. 

Nozzle is too low Raise the nozzle above the pinhole. 

Stream is not aligned Align the stream before aligning the lasers. 

Laser is not aligned Align the lasers. 

Laser is not emitting visible 
light 

When aligning a UV laser, run beads that are excited by 
UV wavelengths. 

Bad pinhole monitor 
settings 

Adjust the brightness and contrast on the pinhole 
monitor. 

Sample pressure is too low Increase the sample pressure. 

Bubbles in the nozzle  Install the debubble reservoir filled with clean sheath 
or ethanol and purge the nozzle. 

 Verify that the nozzle and O-ring are seated properly 
and tightened. 

Beads are not excited by 
laser 

Use the appropriate alignment beads. 
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Poor signal, hockey stick 
shape Possible causes Possible solutions 

Dichoric filter is 
misaligned, backwards, or 
missing 

Verify that all optical filters are properly installed. 

Sample pressure is too high Decrease the sample pressure. 

Sample carryover of bright 
particles 

1. Rinse the sample line with detergent. 

2. Backflush the sample line. 

Stream or laser is not 
aligned 

Align the stream or laser. 

More information � Sorting troubleshooting (page 364) 

� Acquisition troubleshooting (page 369) 

� Fluidics troubleshooting (page 373) 

� Applications troubleshooting (page 377) 

� Electronics troubleshooting (page 378) 
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Applications troubleshooting 

Introduction This topic describes application problems and possible solutions. 

Incorrect compensation 
Possible causes Possible solutions 

Error with staining Manually adjust the spillover values. 

Unable to perform 
autocompensation Possible causes Possible solutions 

Too few positive or 
negative events 

Collect more events. 

Unable to sort on 
compensation Possible causes Possible solutions 

ADC parameters are being Recreate plots using DSP parameters. 
used instead of DSP 
parameters 

More information � Sorting troubleshooting (page 364) 

� Acquisition troubleshooting (page 369) 

� Fluidics troubleshooting (page 373) 

� Alignment troubleshooting (page 375) 

� Electronics troubleshooting (page 378) 



 

 

 
 

 
 

 

  

 

 
 

  

  

 

378 BD Influx User’s Guide 

Electronics troubleshooting 

Introduction This topic describes electronic problems and suggests possible solutions. 

Cytometer error when 
opening the Sortware 
software 

Possible causes Possible solutions 

Sortware controller is not 1. From the Cytometer menu, click Connect to 
connected to the Cytometer. 
instrument 

2. Turn off the Sortware controller by holding the 
power button. 

3. Turn off the auxiliary power, then turn it back on. 

4. Turn on the Sortware controller. When you hear two 
beeps, the controller is fully turned on. 

Hear three continuous 
beeps from the Sortware 
controller 

Possible causes Possible solutions 

Sortware controller is not 1. Turn off the Sortware controller by holding the 
connected to the power button. 
instrument 

2. Turn off the auxiliary power and then turn it back on. 

3. Turn on the Sortware controller. When you hear two 
beeps, the controller is fully turned on. 

More information � Sorting troubleshooting (page 364) 

� Acquisition troubleshooting (page 369) 

� Fluidics troubleshooting (page 373) 

� Alignment troubleshooting (page 375) 

� Applications troubleshooting (page 377) 
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